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Service Contract Quarterly Performance Report
Fourth Quarter: 1st January to 31st March 2024




1.0 Introduction
This fourth quarter Service Contract Quality Performance Report (SCQPR) covers the period 1 January – 31 March 2024 and provides an overview of St Cuthbert’s Hospice performance against the key local quality requirements (LQRs) and performance indicators (KPI’s) as outlined in our 2023 -2024 NHS Contract.
Key service issues over the last quarter

In Patient Unit, (IPU). Cumulative deaths totalled since 1 April 2023 is 169 of which 167 achieved their preferred place of death, (PPD). We were able to discuss preferred place of death with 169 patients. 2 people did not achieve their preferred place of death, which was home. IPU bed occupancy in this quarter was 80.88%. 

Following the departure of our Medical Director/Consultant (June 2023) and approval of an additional Consultant (June 2022), we have been unable to recruit to either post. Since 2 October Consultant support has been provided virtually by Supportive UK. CDDFT seconded a Specialist Dr for 10 sessions. This Dr works alongside our existing Hospice Drs, (6 sessions) and an Advanced Nurse Practitioner (5 sessions). It is anticipated these arrangements will remain in place while we continue to work with stakeholders on a sustainable medical model for the healthcare local system. 

We are using hours freed up by a reduction in hours to number of nursing posts and have recruited a rehabilitation assistant who commenced employment in quarter 4. 

Day Services, Within the Living Well Centre, services are provided Monday to Friday. We continue to develop our programme and therapy groups including cognitive stimulation therapy, sporting memories activity group, health and wellbeing group, creative writing, physio led strength and balance group and one to one complementary therapy sessions. We continue to offer Day Hospice services for interventions such as blood transfusion. We have recruited to the Nursing Associate (band 4) vacancy in March and await a start date in Q1.  Refurbishment of LWC was completed in quarter 4.  

We continue to provide Bereavement Support Services, with counselling sessions for adults, children and young people provided Monday - Friday. We are seeing a decrease in our waiting list since the review of staff skill mix and increase to counselling capacity.  We have inducted a new CYP counsellor (0.6WTE) and look forward to a second counsellor (0.4WTE) joining us in Q1.  Delivery of bereavement support groups has been transferred to our Community Outreach Project.  

Community Services – The Admiral Nurse provides clinical leadership to the Dementia and Community Outreach Team. Working collaboratively, we are continuing to increase community support for people living with dementia and their carers in County Durham offering one-one clinic appointments, dementia support groups and Namaste care. We are also developing our dementia educational offer and have provided education sessions to carers, facilitators of community Memory Cafes, other nursing professionals and educational establishments.
 
We have worked with the ICB to agree a way for hospices to collaborate to meet the requirements of the new Patient Safety Incident Reporting Framework (PSIRF). Three workshops were delivered in Q4.

We have completed the VOICES Survey for County Durham on behalf of the Palliative and End of Life Care Steering Group for the County. Over 380 responses were received. Findings will be published in Q1.

The Care Quality Commission (CQC) carried out an unannounced inspection in October 2023. This generated a range of activities including: the purchase of a new air conditioning unit for our cold room; the introduction of new standard operating procedures including management and care of nasogastric tubes, management of anaphylaxis, safeguarding of adults and safeguarding of children, cold room cleaning procedure; Percutaneous Endoscopic Gastrostomy (PEG) tubes policy and procedure; the introduction of a new set of admissions criteria; training for staff on management of NG tubes. Further work to meet the requirements set out following the visit was undertaken in Q4 and will continue in 204/25.

The recommendations from the ICB Quality Assurance visit in August 2023 have been implemented,





















2.0 Summary of what we have achieved in quarter four
Achievements to end of the fourth quarter:

Service Activity:

· In-Patient Unit:
· 58 new admissions into the in-patient unit during this reporting period.
· 42 deaths 
· 42 patients achieved preferred place of death. 
· Living Well Centre:
·  978 Face to face appointments.
· Bereavement Support Services – Adults 
· 170 Face to face appointments attended, 13 well-being calls to 60 people.
· Admiral Nurse:
· 41 patient/carers had 93 contacts, attended 2 memory cafes, 23 community/Hospice groups and 6 training sessions.  30 new referrals received.
· Namaste team:
· 58 patients/carers seen at home/Hospice/outreach, had 536 contacts.  11 new referrals received.

Protecting people from avoidable harm:

In Quarter 4 there have been 39 clinical incidents:

· 0 Serious incidents 
· 0 Incident of major, permanent harm; severe disruption
· 2 Incident of actual moderate harm/short term harm/disruption
· 14 Incidents of actual minor/minimal harm/low disruption 
· 19 Incidents of actual no harm
· 4 Incidents of soft Intelligence
· 0 Near Misses






















3.0 Service Activity
In accordance with Integrated Care Board (NENCICB) dataset requirements full data reports are submitted below.  For comparison the preceding full year’s performance (2022 - 2023) data is provided and each full quarter’s performance for 2023 - 2024 and this will be updated in subsequent quarterly reports.  Specific LQR’s and KPI’s measurements summarising performance can be seen in the Table 1 below:

4.0 Local Key Performance Indicators (KPI’s) 

	[bookmark: _Hlk132613762]Table 1 – Hospice activity against KPIs 2023-2024

	
Indicators.
	
Threshold
	
End of Year. 2022-23
	
Met – 
Not met
	2023-2024 quarterly performance.
	End of year
2023-2024
	

	
	
	
	
	Q1
	Q2
	Q3
	Q4
	
	Year 2023-2024 Performance

	In-Patient Unit (IPU)
	COMMENTS.

	Total number of in-patient referrals received
	N/A for monitoring purposes
	340
	-
	90
	98
	91
	86
	365
	N/A for monitoring purposes.


	Average waiting time from referral to admission for inpatients (excluding weekends and planned respite).
	≤ 48 hours
	35.6
	Met
	31.6
	32.7
	35.7
	40
	35
	

	Total number of inpatient admissions.
	N/A for monitoring purposes
	220
	-
	62
	67
	60
	58
	247
	N/A for monitoring purposes. 

	Percentage bed occupancy.	
	≥ 85%
	86.63
	Met
	84.67
	82.05
	78.71
	80.88
	81.50
	Action Plan in place to improve performance against KPI. 

	Percentage bed availability.
	≥ 95%
	99.3
	Met
	100
	99.89
	99.56
	100
	99.86
	 

	Average length of stay for inpatients.
	≤ 15 days
	14.4
	Met
	13.1
	11.3
	11.1
	13.1
	12.2
	

	Number and percentage of inpatients that have been offered an Advance Care Plan.
	90%
	99.2%
	Met
	62
100%
	67
100%
	60
100%
	58
100%
	100%
	

	Number and percentage of patients who died at the hospice and have preferred place of death recorded.
	N/A for monitoring purposes
	128
97.6%
	-
	39
100%
	49
100%
	39
100%
	42
100%
	169
100%
	N/A for monitoring purposes.


	Number and percentage of patients who died at the hospice who stated their preferred place of death and achieved this.
	N/A for monitoring purposes
	123
95.4%
	-
	38
97.4%
	48
98%
	39
100%
	42
100%
	167
98.9%
	N/A for monitoring purposes


	Patient’s risk of falls to be assessed within 6 hours of admission.
	100%
	95.7%
	Not met
	87.1
	94
	98.3
	100
	95
	

	Patient’s written care plan tailored to address falls risk completed within 6 hours of admission.
	100%
	95.7%
	Not met
	87.1
	94
	98.3
	100
	95
	

	Pressure ulcer risk assessment to be completed within 6 hours of admission.  
(Ref - NHS Improvement 2018 Pressure Ulcers: revised definition and measurement).
	95%
	95.7%
	Met
	87.1
	94
	98.3
	100
	95
	

	Patient’s written care plan tailored to address pressure ulcer risk within 6 hours of admission (Ref - NHS Improvement 2018 Pressure Ulcers: revised definition and measurement).
	95%
	95.7%
	Met
	87.1
	94
	98.3
	100
	95
	

	Venous thromboembolism (VTE) risk to be assessed within 24 hours of admission to determine if prophylaxis required.	
	100%
	98.5%
	Not met
	100
	97
	95
	98
	97.5
	1 was missed as on admission patient was immediately sent to hospital.

	Percentage of patients that report a positive experience of care via the Friends and Family Test.
	90%
	100%
	Met
	100
	100
	100
	100
	100
	Q4 - 13 forms returned since HCA champions identified. 

	Number of complaints and compliments received and actions taken
	N/A for monitoring purposes
	-
	-
	-
	-
	-
	-
	-
	N/A for monitoring purposes


Refer to Sect 5.2 in report 

	Number of clinical and non-clinical incidents and actions taken
	N/A for monitoring purposes
	-
	-
	-
	-
	-
	-
	-
	N/A for monitoring purposes

Refer to Sect 5.2 in report.




	Living Well Centre
	COMMENTS

	Total number of patients attending the Living Well Centre

	N/A for monitoring purposes
	249
	-
	138
	135
	141
	133
	302
	N/A for monitoring purposes


	Number and percentage of Living Well Centre patients receiving a care plan
	100%
	100%
	-
	100
	100
	100
	100
	100
	

	Percentage occupancy
	≥ 80%
	31.25%
	Not Met
	51.2
	57
	49
	53
	52.55
	Occupancy changes due to reduction in medical procedure offering.

	Time from referral to Living Well Centre and contact to arrange home visit / assessment.

	90% within 7 days
	100%
	    Met
	100
	100
	100
	100
	100
	

	Time from first referral in LWC to Physiotherapy assessment
	100% within 21 days
	100%
	Met
	100
	100
	100
	100
	100
	

	Time from referral in LWC to Occupational therapy assessment
	100% within 21 days
	100%
	Met
	100
	100
	100
	n/a
	100
	OT left in quarter 4.

	Percentage of patients that report a positive experience of care via the Friends and Family Test
	90%
	100%
	Met
	100
	100
	100
	100
	100
	Q4 – 8 forms returned since HCA champions identified. 

	Bereavement Support Services (Adults)
	COMMENTS

	Total number of clients accessing bereavement support services (adults)

	N/A for monitoring purposes
	103
	-
	46
	55
	54
	60
	108
	N/A for monitoring purposes
 

	Number and percentage of clients contacted within 15 working days of receipt of referral (adults)

	95%
	96.3%
	Met
	100
	100
	100
	100
	100%
	

	Number and percentage of written assessments of needs and action plans agreed with clients (adults)

	100%
	100%
	Met
	100
	100
	100
	100
	100%
	

	Percentage of clients that report a positive experience of care via the Friends and Family Test
	90%
	100
	Met
	100
	100
	100
	100
	100%
	Q4 - 15 forms returned. 

	Number of complaints and compliments received and actions taken
	N/A for monitoring purposes
	-
	-
	-
	-
	-
	-
	-
	N/A for monitoring purposes.
Complaints are recorded on the Incident Log.
Refer to Sect. 5.2 of report. 

	Number of safeguarding incidents and actions taken
	N/A for monitoring purposes
	-
	-
	-
	-
	-
	-
	-
	N/A for monitoring purposes 

Refer to Sect. 5.2 in report 

	Dementia services
	COMMENTS

	Total number of patients attending Dementia Support Service

	N/A for monitoring purposes
	95
	-
	53
	76
	83
	87
	153
	N/A for monitoring purposes. 

	Time from referral to Admiral Nurse for first contact and appointment arranged for assessment. 

	95% within 15 days
	99%
	Met
	100
	100
	100
	100
	100%
	

	Time from referral to Namaste care for first contact and appointment arranged for assessment. 

	95% within 15 days
	100%
	Met
	100
	100
	100
	100
	100%
	

	Percentage of patients who provide feedback and report a positive experience of care

	90%
	100%
	Met
	100
	100
	100
	100
	100%
	Q4 – 12 forms returned. 

	Number of complaints and compliments received and actions taken
	N/A for monitoring purposes
	-
	-
	-
	-
	-
	-
	-
	N/A for monitoring purposes

Refer to Sect 5.2 of report

	Number of clinical and non-clinical incidents and actions taken
	N/A for monitoring purposes
	-
	-
	-
	-
	-
	-
	-
	N/A for monitoring purposes

Refer to Sect 5.2 of report




	Table 2 – Hospice activity against LQRs 2023-2024

	
Indicators.
	
Threshold
	
End of Year 2022-23
	
Met – 
Not met
	2023-2024 quarterly performance.
	End of year
2023-2024
	

	
	
	
	
	Q1
	Q2
	Q3
	Q4
	
	Year 2023-2024 Performance

	
	COMMENTS.

	% of national safety alerts issued via the Central Alert System (CAS) that are fully implemented within the timescales set out within the alert.
	100%
	-
	-
	100%
	100%
	100%
	100%
	100%
	


	% of patients and carers surveyed who are satisfied with the service.
	75%
	-
	-
	100%
	100%
	100%
	100%
	100%
	

	% of patients who felt they were treated with dignity and respect, as part of service user experience.
	100%
	-
	-
	100%
	100%
	100%
	100%
	100%
	

	% of eligible staff who have received safeguarding adults supervision in accordance with caseload supervision arrangements and the organisations clinical supervision policy.	
	100%
	-
	-
	100%
	100%
	100%
	100%
	100%
	Supervision Policy in place.  Staff have access to supervision on a 121 basis, (internal and external supervisors), group topic specific / following safeguarding issues. 

	% of staff that have a safeguarding adult training session within 6 weeks of taking up the post.  
100% of eligible staff, 95% triggers exception reporting, 90% requires remedial action plan. Excludes maternity and sick leave.
	100%
	-
	-
	n/a
	60%
	100%
	100%
	86.7%
	

	% of staff that have completed safeguarding adults training in accordance with the level, duration and frequency set out in the Adult Safeguarding: Roles and Competencies for Health Care Staff, Intercollegiate Document August 2018.
100% of eligible staff, 95% triggers exception reporting, 90% requires remedial action plan. Excludes maternity and sick leave.
	100%
	-
	-
	92
	96
	96
	100
	96%
	Hospice mandatory training target is 90%. 


	The Provider will ensure that all training around the Mental Capacity Act (MCA) and the Deprivation of Liberty Safeguards (DOLS) is provided in accordance with the level, duration and frequency as set out in the Adult Safeguarding: Roles and Competencies for Health Care Staff, Intercollegiate Document August 2018.
	100%
	-
	-
	67.30
	75
	77
	82
	75.33%
	Hospice mandatory training target is 90%
Decision made to do Face to Face rather than e-learning as adds more value.  All staff are booked on the face to face training.

	% of eligible staff who meet the minimum requirements for “Prevent” mandatory training in accordance with the Prevent Training and Competencies Framework.  
	85%
	-
	-
	86
	92
	95
	100
	93.3%
	

	% of eligible staff who have received safeguarding children's supervision in accordance with caseload supervision arrangements and the organisations clinical supervision policy.
	100%
	-
	-
	100%
	100%
	100%
	100%
	100%
	

	% of staff that have a safeguarding children training session within 6 weeks of taking up the post.
100% of eligible staff, 95% triggers exception reporting, 90% requires remedial action plan. Excludes maternity and sick leave.
	100%
	-
	-
	n/a
	60
	100
	100
	86.7%
	

	% of eligible staff that have completed safeguarding children training in accordance with the level, duration and frequency as set out in the Safeguarding Children and Young People: Roles and Competencies for Healthcare Staff, Intercollegiate Document January 2019.  100% of eligible staff, 95% triggers exception reporting, 90% requires remedial action plan.
	100%
	-
	-
	88
	94
	97
	99
	94.5%
	Hospice Target is 90%

	% of frontline staff to be vaccinated against flu during the flu/winter period.
	75%
	-
	-
	n/a
	n/a
	76.3
	n/a
	76.3%
	To monitor uptake during flu season.

	% of staff that have completed all relevant mandatory training such as infection, prevention, moving and handling, information governance and basic life support.
	100%
	-
	-
	83
	93
	95
	93
	91%
	Staffing issues/IT constraints have been a barrier to completing mandatory training. Compliance is improving. 

	% of eligible staff that have DBS checks in accordance with statutory requirements.	
	100%
	-
	-
	94
	100
	100
	100
	98.5%
	

	% of agency staff used within the reporting period
	<5.00% of staffing structure
	-
	-
	1.84
	0.49
	0.54
	1.3
	1.04%
	In quarter 4 we had a number of patients who required 1:1 support

	% of staff sickness within the reporting period
	<7.00% of structure days
	-
	-
	5.30
	5.40
	4.40
	3.00
	4.53%
	 

	% of patients at risk of falls, are assessed within 6 hours of admission.
	98%
	-
	-
	87.1
	94
	98.3
	100
	95%
	Time of recording rather than time of assessment.

	% of patient's with appropriate Falls Care Plan completed within 24 hours or admission
	98%
	-
	-
	100
	100
	100
	100
	100%
	

	% of pressure ulcers reviewed in line with the organisations Patient Safety Incident Response Plan
	100%
	-
	-
	100
	100
	100
	100
	100%
	

	% of patients with an Advance Care Plan (ACP) or offered ACP discussions.
	98%
	-
	-
	100
	100
	100
	100
	100%
	

	% of patients with an Emergency Healthcare Plan (EHCP) or offered discussions (for hospice inpatients or hospice at home care patients).
	98%
	-
	-
	90.5
	12.5
	100
	100
	75.8%
	

	% of patients with a DNACPR or offered discussions (for hospice inpatients or hospice at home care patients).
	98%
	-
	-
	100
	100
	100
	100
	100%
	

	% of patients who are offered discussions regarding preferred place of death (for hospice inpatients or hospice at home care patients).
	98%
	-
	-
	100
	100
	100
	100
	100%
	

	% of patients who state their preferred place of death and achieve it (for deceased hospice inpatients or hospice at home care patients).  
	85%
	-
	-
	97.4
	98
	100
	100
	98.9%
	

	% of discharge summaries to be sent to GP within 24hrs
	95%
	-
	-
	50
	73.3
	88.2
	92.9
	76.1%
	1 missed in Q4



5.0 Protecting people from avoidable harm through prevention falls, suspected deep tissue injuries, pressure ulcers and thromboembolism. 

5.1 Patient Safety
1.1 The review and updating of policies has continued over 2023 - 2024 to ensure our suite of care related policies and procedures reflect local and national guidelines. Within this quarter we updated key policies such as Control of Infection caused by Ectoparasite and Threadworms Policy & Procedure

To fulfil our ‘Duty of Candour’ we report all serious incidents to statutory and regularity bodies, our commissioners and internally in our own clinical governance forums.  See tables 2 and 3 below.  Furthermore, our Clinical Practice Development Nurse also provides in house Duty of Candour training sessions for clinical staff.
Summary of clinical and other untoward incidents

	Table 2 – Clinical and untoward incidents 2023-2024

	
	Code
	2022-23
Totals
	Q1.
	Q2.
	Q3.
	Q4.
	Year end
	Comments 

	Service Falls
	1
	21
	3
	10
	9
	4
	26
	4 Unavoidable 

	Pressure Ulcers/SDTI
	3
	31
	6
	5
	11
	6
	28
	2 PU (2 patients on admission) and 4 SDTI following admission (3 patients)

	Medication Errors
	4
	18
	7
	7
	5
	4
	23
	3 external and 1 internal to Hospice

	Other clinical incidences
	6
	38
	18
	26
	20
	16
	80
	

	Infection Prevention and Control - Health acquired infections
	7
	12
	1
	3
	3
	1
	8
	1 COVID

	Other non-clinical incidences
	8
	4
	0
	0
	0
	0
	0
	

	Information Governance
	9
	16
	6
	3
	3
	2
	14
	

	Subject Access Requests
	10
	0
	1
	1
	0
	1
	3
	

	Safeguarding
	11
	1
	1
	4
	1
	1
	7
	

	MCA/DoLS
	-
	22
	8
	4
	3
	8
	23
	SIRMS completed for all MCA/DoLS



5.2 Serious Incidents and complaints
Quarter Four

	Incident Number
	Incident Date
	Cause Group
	Cause 1
	Cause 2
	Details Of Incident
	Initial impact
	Actual Impact
	Outcome Description

	114018
	02/01/2024
	Safeguarding Adults
	Deprivation Of Liberty
	 
	Patient admitted to hospice, who lacks capacity to consent to care and treatment following capacity assessment.
	5 - Catastrophic//Death/Service Or Sytem Failure
	1 - No Harm
	MCA 1 & 2 completed
Urgent Dols request sent
SIRMS completed 
CQC notification sent
Verbal duty of candour 

	114029
	02/01/2024
	Medication
	Administering Medication
	Medication Other
	Medication given (prednisolone) when had been stopped on Kardex day before

	2 - Low Harm / Minor / Low Disruption
	2 - Low Harm / Minor / Low Disruption
	Reflective practice with nursing staff and medical staff involved.  Patient advised of error and apology made and accepted.  No harm to patient.

	114325
	09/01/2024
	Tissue Viability
	Pressure Ulcer - Grade 2
	 
	Patient admitted with healing grade 2 pressure sore.
	1 - No Harm
	1 - No Harm
	Patient admitted with what appears to be healing grade 2 pressure sore.  Appropriate care plan put in place.

	114335
	09/01/2024
	Clinical Documentation
	Mislabelled / Misfiled Documentation
	Controlled Drug
	Patient required pain relief, Oxynorm oral solution. 

Myself and other staff nurse on duty went to administer the drug. Oxynorm 5mgs /5mls had been received and documented in the controlled drug book as a full bottle of 250mls.

On inspection appeared to be an open bottle, measured 225mls.
	1 - No Harm
	1 - No Harm
	 

	114462
	15/01/2024
	Tissue Viability
	Skin Tear
	Moving And Handling
	Small skin tear when left hand rubbed against bath chair.
	2 - Low Harm / Minor / Low Disruption
	2 - Low Harm / Minor / Low Disruption
	Care plan initiated.

	114463
	16/01/2024
	Tissue Viability
	Skin Tear
	 
	Patient incurred accidental skin tear 4cm by 5cm to form on right forearm. 
	2 - Low Harm / Minor / Low Disruption
	2 - Low Harm / Minor / Low Disruption
	Care plan and dressing regime initiated. 

	114598
	19/01/2024
	Safeguarding Adults
	Deprivation Of Liberty
	 
	Patient admitted to IPU lacks capacity to consent to care and treatment following capacity assessment.
	6 - Soft Intelligence
	1 - No Harm
	MCA 1 & 2 completed
Urgent Dols request sent
SIRMS completed 
CQC notification sent
Verbal duty of candour

	114673
	22/01/2024
	Infection, Prevention And Control
	Other IPC Incident
	COVID-19 Related
	Patient admitted to IPU from hospital, admission LFT test positive for Covid
	6 - Soft Intelligence
	1 - No Harm
	IPC guidance followed.

	114724
	23/01/2024
	Health & Safety
	Other Health And Safety
	Lack Of Clinical Or Risk Assessment
	Volunteer gave patient a custard cream biscuit when on pureed diet.
	1 - No Harm
	1 - No Harm
	Correct procedure in place at time of incident re: Volunteer handover sheet
Verbal duty of candour.
No harm to patient.  Reflective practice/supervision with volunteer given to support.


	114756
	24/01/2024
	Health & Safety
	Slip/Trip/Fall
	Patient Fall From Chair/Wheelchair
	Slip from recliner chair at 
	2 - Low Harm / Minor / Low Disruption
	2 - Low Harm / Minor / Low Disruption
	Unwitnessed unavoidable slip from chair, mitigating actions in place at time of slip.  

	114844
	27/01/2024
	Implementation Of Care
	Inadequate Staffing Levels
	 
	Staff sickness left ward with only 1 x RN for 12hr day shift (3 X HCA staff on morning and 2 on afternoon).
	3 - Moderate Harm / Short Term Disruption
	3 - Moderate Harm, Short Term Disruption
	Due to staff sickness IPU staffed with correct establishment to manage 7 patients but skill mix compromised only 1 x RN on duty.  Unable to obtain bank/agency RN.

IPU service manager made telephone contact throughout the day.  SSMT made aware  HCA staff on duty able to second check CD medication and night staff replenished syringe drivers.  



	114889
	30/01/2024
	Patient Accident
	Patient Fall From Chair/Wheelchair
	 
	Patient had an unwitnessed slip from his recliner chair to the floor. He was found sat on the floor by his chair. After being checked - no injuries noted - he was safely hoisted back in to bed.
	1 - No Harm
	1 - No Harm
	Unavoidable unwitnessed slide from chair, mitigating actions in place at the time of slide from chair.

	114918
	29/01/2024
	Medical Device, Equipment
	Medical Device/Equipment Failure
	 
	Macerator showing F7 error code
	2 - Low Harm / Minor / Low Disruption
	2 - Low Harm / Minor / Low Disruption
	Servicing providers called out, unblocked and sensor changed on unit. working fine again.

	114925
	31/01/2024
	Safeguarding Adults
	Financial / Material Abuse
	 
	Concerns reported by family member relating to safeguarding nature, financial/emotional abuse. Also concerns around a vulnerable adult having contact with a man who has an alleged criminal offence.
	2 - Low Harm / Minor / Low Disruption
	2 - Low Harm / Minor / Low Disruption
	Policy and procedure followed once concerns raised.
Safeguarding referral made 31/1/24
Verbale duty of candour Safeguarding CQC notification sent 1/2/24
Hospice in contact with police and public protection officers.

	114971
	30/01/2024
	Safeguarding Adults
	Deprivation Of Liberty
	 
	Patient admitted to hospice lacks capacity to consent to care and treatment
	6 - Soft Intelligence
	6 - Soft Intelligence
	MCA 1&2 completed
DoLs application made
Verbal duty of candour 
CQC notification
SIRMS

	115026
	02/02/2024
	Medication
	Medication Supply Issue - Hospital Discharge
	Lost/Misplaced Medication
	Patient admitted from UHND hospital from Ward 16. 
On his discharge medication bag, we received one medicine which was not belonging to the patient. It was labelled with different name. Patient has not received any of this medicine.
	1 - No Harm
	1 - No Harm
	 SIRMS sent to transferring ward to report on.

	115047
	04/02/2024
	Patient Accident
	Patient Found On Floor - Not Witnessed
	 
	Patient found on floor outside his room, he said he was trying to 
	1 - No Harm
	1 - No Harm
	Unwitnessed unavoidable fall, all mitigation actions in place at time of fall in line with patients wants and wishes.  New appropriate mitigating actions put in place post fall following discussion with patients.  Reviewed post fall as per policy by Dr and Physio within 24hrs.

	115181
	07/02/2024
	Discharge Issue
	Discharge - Planning Failure
	Discharge Summary Not Received / Missing
	Patient admitted to IPU (St Cuthberts Hospice) without discharge letter or meds list.
	6 - Soft Intelligence
	1 - No Harm
	 SIRMs sent to transferring ward for feedback.

	115234
	07/02/2024
	Health & Safety
	Slip/Trip/Fall
	Patient Found On Floor - Not Witnessed
	Bed sensor alarmed. staff found patient on floor.
	2 - Low Harm / Minor / Low Disruption
	2 - Low Harm / Minor / Low Disruption
	With information received from hospital and presentation of patient on admission fall unwitnessed unavoidable fall as mitigating actions that were available at the time in place.

	115265
	08/02/2024
	Tissue Viability
	Deep Tissue Injury (DTI)
	 
	New SDTI developed – patient at EOL.
	3 - Moderate Harm / Short Term Disruption
	2 - Low Harm / Minor / Low Disruption
	New SDTI during admission to hospice.
SDTI developed approx 26 hours before death.
care plan adjusted as changes to skin and overall condition noted.
Verbal duty of candour
SIRMS
Safeguarding referral made - no neglect noted
CQC notification sent.

	115320
	11/02/2024
	Tissue Viability
	Deep Tissue Injury (DTI)
	 
	Patient noted to have SDTI 
	2 - Low Harm / Minor / Low Disruption
	2 - Low Harm / Minor / Low Disruption
	SDTI.  Documentation issues
Verbal duty of candour.
Leaflet given to family
SIRMS completed
Safeguarding informed - no neglect noted, skin deteriorating due to overall deterioration
Training - IPU service manager continues to find ongoing training as some staff have had TV training, but this was one off and not repeated for hospice staff.

	115527
	12/02/2024
	Information Governance
	InformationLeftUnattended(Printer,EmptyOffice
	 
	RGN found an HCA appraisal document left in nurses office.
	1 - No Harm
	1 - No Harm
	Confidential information left in nurses’ station unintentionally.  Not a recurrent issue.  Apology made to staff member.  Discussed with staff member who had left paperwork.


	115644
	17/02/2024
	Tissue Viability
	Deep Tissue Injury (DTI)
	 
	Patient is approaching end of life. SDTI found to left ear 0.5cm-1cm in size. 
	2 - Low Harm / Minor / Low Disruption
	2 - Low Harm / Minor / Low Disruption
	SDTI most likely due to deteriorating condition. 
Patient's wife is aware, verbal duty of candour.
Care plans adjusted. 
Safeguarding informed - no neglect noted, SDTI due to deteriorating condition
CQC notification completed
SIRMs completed

	115647
	15/02/2024
	Safeguarding Adults
	Deprivation Of Liberty
	 
	Patient admitted to hospice lacks capacity to consent to care and treatment following MCA
	6 - Soft Intelligence
	6 - Soft Intelligence
	MCA 1&2 completed
DoLs application made
Verbal duty of candour 
CQC notification
SIRMS.

	115714
	19/02/2024
	Safeguarding Adults
	Deprivation Of Liberty
	 
	Patient does not have capacity to consent to care and treatment at hospice.
	6 - Soft Intelligence
	6 - Soft Intelligence
	MCA 1&2 completed
DoLs application made
Verbal duty of candour 
CQC notification
SIRMS

	115815
	20/02/2024
	Implementation Of Care
	Correct Care / Treatment Not Provided
	Pressure Ulcer - Grade 2
	Patient admitted to IPU with grade 2 pressure damage to coccyx.
	2 - Low Harm / Minor / Low Disruption
	2 - Low Harm / Minor / Low Disruption
	 SIRMs sent to transferring place of care for feedback.

	115938
	23/02/2024
	Clinical Documentation
	DNAR/EHCP Record Issue
	Controlled Drug
	Patient on admission to St Cuthbert's Hospice issues noted on red Kardex with regards to Oxycodone and dose not given within recommended limits.  
	1 - No Harm
	1 - No Harm
	SIRMs sent to Community Nurse team for review and feedback. 

	115960
	23/02/2024
	Self Harm
	Accidental Self Harm
	 
	Patient scratched own face.
	2 - Low Harm / Minor / Low Disruption
	2 - Low Harm / Minor / Low Disruption
	Patient with Huntington's disease and known to have rapid dyskinetic movements patient accidentally scratched face.
Wife made aware no concerns raised

	115958
	26/02/2024
	Safeguarding Adults
	Deprivation Of Liberty
	 
	Patient admitted to hospice lacks capacity to consent to care and treatment following MCA
	6 - Soft Intelligence
	1 - No Harm
	MCA 1&2 completed
DoLs application made
Verbal duty of candour 
CQC notification
SIRMS

	116014
	27/02/2024
	Safeguarding Adults
	Deprivation Of Liberty
	 
	Patient lacks capacity for care and treatment
	6 - Soft Intelligence
	1 - No Harm
	MCA 1&2 completed
DoLs application made
Verbal duty of candour 
CQC notification
SIRMS

	116089
	27/02/2024
	Health & Safety
	Struck Against Something Fixed/Stationary
	 
	Driver reports during minibus transport, wheelchair tipped momentarily, and patient knocked their head against grab bar in minibus.  Driver reports patient remained secure in wheelchair and wheelchair returned to floor immediately.  No injuries reported.  Seen by RN.
	2 - Low Harm / Minor / Low Disruption
	1 - No Harm
	27.02.24 - Reviewed by RN - no concerns reported.  
Checked out minibus - wheelchair locking system in situ, no apparent concerns. Vehicle maintenance is up to date.
Driver training is up to date.

29.02.24 - Minibus reviewed by garage- wheelchair locking system checked over by mechanic, no concerns reported.  Additional advice provided to driver on position of tie downs to minibus base.

	116405
	01/03/2024
	Discharge Issue
	Discharge Summary Incorrect/Unclear
	Controlled Drug
	Discrepancy between discharge letter/red kardex and contents of CSCI Alfentanil 2000mcg/ midazolam.

CSCI partially confirmed after hospice staff spoke with ward staff- verbally. 

Finally confirmed via copy of email on referral form - CSCI had been adjusted to Alfentanil 2500mcg (increase) Midazolam 15mg (decrease) Levomepromazine 25mg (addition) in part to enable patient to be less sedated but symptoms managed.
	0- Near Miss
	1 - No Harm
	 Awaiting feedback from hospital

	116674
	06/03/2024
	Health & Safety
	Moving And Handling
	 
	Staff injury following appropriate moving and handling of a patient.  

	2 - Low Harm / Minor / Low Disruption
	2 - Low Harm / Minor / Low Disruption
	-Staff member sustained incidental injury to R shoulder following appropriate transfer of a patient. Patient care plan reviewed and updated, reviewed by OT.  Risk assessment created for staff member.  No long term damage.


	116736
	13/03/2024
	Information Governance
	Misdirected Email/Hard Copy Received Containing Confidential Info
	Breach Of Patient Confidentiality
	Referral e-mail sent to general Hospice e-mail address.
	1 - No Harm
	1 - No Harm
	Email to referrer to advise they have used the wrong email address.  Guidance reiterated to use Hospice's NHS.net email account for referrals in future, as per referral from instructions, to avoid this issue.

Response from referrer - apologies, human error and aware to use correct email address in future.

	116929
	07/03/2024
	Health & Safety
	Moving And Handling (Patient)
	 
	Injury sustained to staff members back during appropriate moving and handling episode of care.
	3 - Moderate Harm / Short Term Disruption
	3 - Moderate Harm, Short Term Disruption
	Staff member sustained injury to back following an appropriate/recommended transfer of patient from bed to commode.  
As staff member was unable to work for more than 7 days HSE injury report completed.
Documentation issue - email sent to staff.
Handover lessons - email sent to staff.
Patients falls bundle and assessments up to date and correct at the time of incident.
patient was being 121 nursed to prevent falls as mobility and cognition variable 
Patient reviewed next day post incident by OT and physio on day off.
Risk assessment for staff member implemented with return to work information

	116982
	25/03/2024
	IT
	Telecommunications Failure
	Access To Service Failure (Other)
	A nurse was calling the hospital for a handover and the nurse stated that they had been trying to get through to us but were unable to do so.  

I called the hospice line from my mobile and once it connected, the line was dead.
	1 - No Harm
	2 - Low Harm / Minor / Low Disruption
	Estates and Facilities Manager tested calling the line with the same result. Notified Select who responded to say on testing they had no Issues. 

Estates & Facilities Manager asked select to look into any faults showing. Select are also monitoring the line. 

The Main Line and Automated attendant now working as expected.

	117011
	25/03/2024
	Estates And Facilities
	Facilities Management
	 
	02 CD cylinder in sluice noted to be only half full.
	0- Near Miss
	1 - No Harm
	 Policy and procedure was followed.

	117021
	26/02/2024
	Medical Device, Equipment
	User Error
	Medication Incorrectly Stored/Sealed
	Medicine fridge temperature not recorded by nightshift HCA.
	1 - No Harm
	1 - No Harm
	Reflective practice with staff member re: checking fridges each night and ensuring we write the temperatures down.
No harm

	117044
	25/03/2024
	Safeguarding Adults
	Deprivation Of Liberty
	 
	Patient admitted to hospice does not have capacity to consent to care and treatment at hospice.
	6 - Soft Intelligence
	6 - Soft Intelligence
	MCA 1&2 completed
DoLs application made
Verbal duty of candour - family aware
CQC notification
SIRMS




5.3 Prevention of Falls 2023 - 2024
Although ambitious our aim for the period 1 April 2023 – March 2024 is to reduce the incidence of ‘unavoidable’ patient falls to zero, based upon number of falls recorded (23) during 2021 - 2022.  We recognise that despite assessing each patients’ ‘falls risk’ against a wide range of factors we can identify those patients with an increased risk or likelihood of falls but even after implementing measures to reduce the incidence of falls it is not always possible to avoid some falls see Table 4:

	Table 4 Falls assessment and prevention.

	Assessments 
	Falls prevention measures

	· Follow best practice as outlined in ‘Falls in older people’. Quality standard [QS86] Published March 2015. Last updated January 2017.
· Regular patient checks and encouragement to ask for help.
· Falls risk assessments (FRAT) – redesigned within SystmOne templates – rolled out 2022/23 Q2.
· Bed rail assessment – redesigned within SystmOne templates rolled out in 2022/23.
· Assessment and plan of care for toileting and continence needs.
· Moving & handling assessment and physiotherapy/OT input.
· Assessment and plan of care for postural hypotension
· Assessment of cognition and/or mental capacity and plan of care to support.
· Review of medications – Doctors and Pharmacists.
	· Weekly MDT formal review of falls risk and record action plan. 
· Moving and handling equipment including ultra hi/low bed
· Bed, chair and floor falls and movement sensor alarms and soft-landing crash mats.
· Bed rails assessment and mobility care plans.
· One to one nursing / monitoring with rooms 5, 9 and 14 near to the nurses’ station designated close observation rooms.
· Orientation to the environment and appropriate lighting and flooring
· Comfortable and safe positioning of the patient
· Timely answering of nurse call to attend to patient.
· Appropriate footwear provision if needed.
· Access to the nurse call bell ‘Make the call avoid the fall’ signs in patient rooms.
· Educating the patient and carers on safe moving techniques.
· Falls Prevention Link Practitioner Group – meets quarterly to review measures in place and updates in line with best practice.
· Annual staff training and falls prevention refresher sessions.
· Annual ‘train the trainer’ updates from an external moving/handling provider.
· External audit completed in May 2023 by independent Ergonomic Advisor (Cloud 9 Health & Wellbeing, Middlesbrough.)  No concerns identified.



Not all these measures are routinely used for example, not every patient is nursed one to one, but these are care plan options if required for the patient’s safety. In trying to maintain the patient’s safety we recognise the need for patients to make choices and take risks and we continue to promote their independence if they have capacity and ability to do so. We will continue to classify falls as either avoidable or unavoidable dependent upon the measures put in place to help reduce / minimise the risk of falls. 

                    


5.4	Prevention of Pressure Ulcers and Suspected Deep Tissue Injuries

The findings from several independent studies highlight that preventing pressure ulcer occurrence may be difficult to achieve in patients who are dying and explains why we continue to report unavoidable PU’s. St Cuthbert’s Hospice in-patient unit (IPU) has set an ambitious target to achieve a 0% incidence rate of avoidable pressure ulcer (PU) development or deterioration following admission during 2022 - 2023.  The charts below include pressure ulcers on admission and new following admission.




              
  
                 
             

5.5	Prevention of Thromboembolism

VTE assessments are carried out on all in patients within 24 hours of admission and are recorded in patient SystmOne care plans / medical notes to evidence decisions made with regard anticoagulation therapy. Table 8 below outlines VTE assessments. Incident reports are completed for patients who do not achieve the required standard. 

In 2022 – 2023 98.5% of VTE assessments were completed within 24 hours of admission. In 2023 – 2024 Q4 98% of assessment were completed within 24 hours, 1 patient who was a readmission, but was sent too hospital during clerking in was missed.

6. 	Service Development ActivityPressure Ulcer (Recording and Management).

Catheter Acquired Urine Tract Infection (UTI).



6.1 Strategic Goal 1: To enable people at the very end of life to achieve a good death in the place of their choosing. 

We continue to exploit opportunities for the Hospice to share our specialist knowledge with the wider community, (Aim 3) and work collaboratively in teaching, audit, and research. 

We continue to collaborate with further and higher education institutions and currently host students from:

· Local further education colleges level completing level 2 - 4 qualifications in health and social care/nursing.
· Trainee Nursing Associate Students from Teesside/Northumbria Universities           
· Pre-registration nursing students from Northumbria University

Unfortunately, in Quarter 4, due to uncertainty about Consultant cover, we have been unable to support GP registrars (GPRs) on the GP training scheme, full time for 6 months or Specialist Registrars from Training Programme in Palliative Medicine within the North East. However we hope to reinstate GPRs from summer 2024.

Planned developments include hosting student physiotherapist and occupational therapists.

6.2 Strategic Goal 2: To enable people with life limiting illness who use the Hospice services to live well and make every day count. 

6.2.1 Paracentesis Service

Following the departure of our specialist palliative care consultant and the outcome of our business case we are no longer accepting referrals to Day Hospice for paracentesis. We have continued to support three existing patients and have been working with CDDFT to clarify medical responsibility for these patients. In Quarter 4

· 0 paracentesis were carried out in IPU. 
· 12 ascitic drainages were carried out in LWC on 1 patient (non-cancer).

6.2.2 Blood Transfusions

In Quarter 4
· 0 blood transfusions were carried out in LWC.
· 2 were carried out in IPU.

6.3 Strategic Goal 3: To provide the information and support that carers of people with life limiting illness need to provide the care they want to provide. 

[bookmark: _Hlk156475363]6.3.1 Admiral Nurse
The Admiral Nurse works with families and people affected by dementia, particularly during complex periods of transition. This is achieved through casework, coordination, groups and clinics to:

·    Promote physical, social, and psychological health of family carers and people with dementia.
·    Improve well-being and quality of life for people with dementia and their family carers.
·    Enhance adjustment and coping strategies for people affected by dementia and their families.
 
6.3.2 Namaste

In addition to improving the quality of life for people living with dementia evaluation of Namaste care has identified direct benefits to carers themselves. Carers have reported that having regular contact with a volunteer through Namaste home visits and the link this provides to additional support from the Dementia Team if required makes them feel well supported and more confident in their caring roles. 

Carer attendees to our Namaste groups have reported that they enjoy spending quality time with their loved ones in an environment where they feel safe and supported. Carers have commented on the feelings of connection this time together can provide and the pleasure they have experienced seeing their loved ones engaged in therapeutic activity that is specifically tailored to meet their needs. Carers also highlight greatly appreciating the opportunity to access both peer and professional support when attending the groups.

6.3.3 Carers Support Needs Assessment Tool (CSNAT) 

In this Quarter we have undertaken a review of the use of the CSNAT and following an options appraisal have decided to continue to use the CSNAT in Dementia Services and now use the carers conversation wheel in IPU/LWC.  Consensus is that the CSNAT tool works well for longer term support within Dementia Services. Whereas the carers conversation wheel works well for short episodes of support within IPU/LWC.  

We continue to forge good working partnerships with other carers’ services and develop our partnership with Durham County Carers Support (DCCS) and The Bridge Young Carers Service, (BYCS). Initiatives include:
· Working with DCCS to:
· Deliver the Everything in Place Project to carers.
· Achieve the Carer Friendly Employer Award, to become a more supportive employer to unpaid carers. 
· Working with BYCS to embed a Young Persons Charter.  The Child & Young Persons’ counsellors act as the link workers with BYCS. 

We understand that a short break from caring can make a significant difference and recognise that offering a short course of complementary therapies will help reduce carer stress, help improve carer wellbeing and give emotional support. We have therefore strengthened our offering of complementary therapies to carers.

6.3.4 Carer Satisfaction Outcomes: Q4

	Most commonly occurring needs in quarter:

	· Emotional support – Listening Ear Service remains in demand.
· Info and Guidance on community funding options
· Referrals for home-based community adaptations (Care Connect) 
· Benefit applications

	Intervention provided:

	· Provided advice on CHC funding. 
· Supported with completion of CHC checklist request.
· Provided listening ear and one to one session with carers.
· Escalated emotional support needs with a referral to counselling.
· Referral completed to Social Care Direct to result in increased support for their relative
· Supported with completion of PIP and Attendance Allowance forms. 
· Provided advice on level of support required for their relatives.
· Provided information on care homes that were suitable for their relative
· Provided bereavement support to relatives to ensure appropriate ongoing level of support.
· Provided information on community support options including care home agencies.
· Referral to Admiral nurse for specialist input

	Outcomes met:
	Outcomes not met and why:

	· Emotional wellbeing
· Information/advice/guidance
	· None

	Thank You and Compliments:

	· Friends and Family Test Feedback.

	Feedback and Improvements:

	· Carer support wheel to be used.
· Carer support wheel used on 4 occasions during Q4



6.4 Strategic Goal 4: To support those who have been bereaved as a consequent of a life limiting illness to adjust to life without their loved one. 

We have worked with the Commissioning Support Project Officer, to review our service to children and young people. We have successfully implemented an action plan agreed in response to risks to business continuity and intended to reduce our waiting list for CYP counselling. We continue to embed our Bereavement Pathway and new ways of working, for example development of a Listening Ear Service, a bereavement service offered to those experiencing a need for anticipatory grief and post bereavement support, means our Family Support Team have been able to provide more emotional support to Living Well Centre guests and Inpatients and their families. 

6.5 Strategic Goal 5: To break down the taboos associated with dying, death, loss and grief. 

6.5.1 Community Outreach Project

Our community outreach project is ongoing within Chester le Street. The three years funding secured from Big Lotteries Community Fund has enabled us to recruitment to four posts: Community Outreach Manager, Community Outreach Co-Ordinator, Namaste Co-Ordinator, Namaste Support Worker. These posts are enabling us to deliver a project aimed at increasing our engagement and outreach into the community to support more people affected by life limiting illnesses through a range of volunteer led projects i.e. Everything in Place, Namaste, Carer Support Groups and Bereavement Support Groups. 

In this quarter we have completed an evaluation and have subsequently decided to focus our energy and resources, in year two, on the areas that are working well, Hospice Hub, Bereavement Support and Dementia Care. This will free up capacity to undertake more community engagement and strengthen the Hospice Hub, Everything in Place, Bereavement Support and Dementia Care.

6.5.2 Everything in Place (EiP)

Everything in Place promotes a Public Health approach to encouraging family conversations around death, dying and bereavement. The course is delivered over eight, weekly sessions, covering topics such as Wills, Power of Attorney, Advance Care Planning, funeral planning, making memories etc. The overall aim of the programme is to encourage what can be difficult conversations, support informed decision making and the drafting of legal/informal documents preparing individuals and families for later life/end of life.  

Prior to the Pandemic the Hospice delivered ‘Everything in Place’, in local community venues.  During the pandemic the course was re-written to enable virtual delivery which has proven to be successful. Following an end to the non-recurring funding the departure of the Everything in Place Project Manager and the availability of volunteers the EIP stalled. However, through the Community Outreach Project face to face delivery of the course recommenced in March 2023. In this quarter we have seen demand for Everything in Place increase and we hope to respond to this in Q1.


7. Clinical Governance, Quality Assurance and Quality Improvement

7.1 Clinical Audit 
St Cuthbert’s Hospice was last inspected by the Care Quality Commission (CQC) in 2023 and was rated ‘requires improvement’.   An action plan is in place to meet the requirements as identified in the report.  St Cuthbert’s Hospice is committed to continuous improvement and to support this, we have a well-developed programme of Clinical Audit, adopting wherever possible, recognised or validated audit tools for example those provided by Hospice UK national hospice audit tools group. Data collected, collated and analysed from our audit programme will be subject to internal scrutiny and review by Clinical Governance Group and Sub Committee before being shared in future service quarterly performance reports.  Attached is the annual audit schedule of key clinical audits the findings of which are captured and monitored on an Audit Summary Tracker, also attached. Findings and any areas of concerns highlighted by a specific audit will be subject to a quality improvement plan owned by the relevant Link Practitioner Group. 
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An internal audit tool is being used to support a Caldicott Guardian ‘spot check audit’ of all areas that hold personal identifiable data (PID) this can include patients and services users.  The aim of the audit will be to identify where we reflect best practice in managing and securing PID and where we might be at risk and what steps will be needed to protect sensitive data. This will be completed at least annually.
	
7.2 Link Practitioner Programme (LPP)
The Link Practitioner Programme is an initiative proposed after the formulation of the North East Hospice Collaboration (NEHC 2017). Prior to the pandemic there were nine hospices who came together to share and develop both clinical and non-clinical areas for practice development. Within this community the initiative was viewed as a cost effective and creative approach to learning, which also enables bench marking, innovative thinking and the sharing and dissemination of best practice findings. In 2023 – 2024 the Hospice hopes to reinvigorate this community of practice potentially under the Patient Safety Incident Report Framework (PSIRF). 
Within St Cuthbert’s Hospice senior leaders see the Link Practitioner Programme as key to embedding a quality improvement ethos within the Hospice, and subsequently avoiding complacency, retaining our outstanding rating and realising our vision of becoming a centre of excellence. The board and senior management team recognise that the LPP programme helps overcome barriers to staff involvement and engagement with quality improvement and quality assurance. It strengthens clinical leadership and engagement at all levels of the organisation and helps managers and front-line staff to work together to deliver a shared and aligned mission and vision. The Head of Clinical Services acts as sponsor for the LPP demonstrating visible leadership commitment from the board and senior management team.
Within the Hospice we have the following Link Practitioner Groups:
· Safeguarding
· Falls Prevention
· Tissue Viability
· Infection Prevention
· Blood Transfusions
· Nutrition & Hydration
· Medical Devices
· Complementary Therapies 
· Information Governance 
· Intravenous Lines
· Clinical Competency
· Student Nurses

Achievements in this quarter, deliverables for the following quarter and risks and issues for each Link Practitioner Group are captured in the following attachments:








                         

7.3 Evaluating Practice - Palliative Outcome Measures
In 2015-16 St Cuthbert’s Hospice implemented the suite of validated Palliative Care Outcomes Measures Toolkit (OACC) outlined below in Figure 1 below. 

Figure 1 – Palliative Care Outcome Measures


In 2022/23 we aimed to place a greater emphasis on reporting outcomes. We aimed to embed reports as PDF files and make data subject to internal scrutiny and review by our Clinical Governance Sub-Committee before publication in our Hospice Contract and Quality Monitoring quarterly reports and our Quality Account.  This has however been hampered by a lack of capacity and capability in data analysis, something we hope to resolve with a joint post across Hospice Northeast & North Cumbria.  

Despite the constraints, we have managed to record and analyse, pre and post outcome measures for guests attending LWC, our first attempt since the pandemic. Within the LWC, the Integrated Performance Outcome Score (IPOS) is the preferred outcome measure. The IPOS covers a range of performance domains related to peoples’ quality of life status and include both physical and emotional domains. Our Day Services Referrals and Admission Standard Operating Procedure (SOP) states the IPOS should be completed pre input from the LWC team, at the initial assessment and post input from the LWC team, at the final review. 

Analysis of outcomes has demonstrated that frequently occurring problems were addressed through LWC interventions and that these: -


  
       


23 guests completed IPOS at both the beginning and the end of their care and 5 patients died.


7.4 Evidenced Based Practice

We have met or made substantial progress in meeting all our key aspirations for quality improvement as outlined in our 2022 - 23 Quality Account.  However, we recognise that to maintain and continually improve our care services, we must ensure that the knowledge, skills, and competence of our staff and volunteers and the evidence that underpins our practice is updated in line with current best practice and research. To reflect best practise we have adopted the NICE Guidance or Standards listed in Appendix 1 to inform both policy and enhance our practice.  In addition, the Hospice Clinical Practice Development Nurse supports clinical practice and individual development & training needs.  We are also very pleased to be adding to the evidence base with our Clinical Practice Development Nurse becoming one of the Principal Investigators for CHELsea II which is a Randomised Controlled Clinical Trial, badged by the National Institute for Health Research. This is on hold until Medical Director is in post.
8.0 Patient Experience and Friends and Family Test
8.1 Welcome Pack- Patient, Client and Guest Survey Feedback
We have updated our in-patient service user information pack to reflect changes to the unit. We routinely seek the views of all those who use our services such as in-patients Living Well Centre guests, Family Support service clients and Dementia service clients. We have redesigned the carer’s questionnaire to include the ‘Friends and Family Test’. There are a range of questions that seek views about our services such as the hospice environment, the staff caring for patients and the services delivered. The questionnaire is distributed to all service users or the families of those who have accessed the range of Hospice services, whether their relative has died or been discharged, it also includes those who attended for respite care. See table 13 for summary feedback for each Hospice service.

Service user feedback questionnaire charts and comments
	

	

	

	




8.2 	Suggestion box feedback
There are suggestion boxes situated at communal areas around the hospice, giving everyone the opportunity to make suggestions in a confidential/ anonymous manner. During Q4 there have been 3 suggestions from people using our service.

	Suggestion
	Response

	Employee Recognition Scheme Anyone can nominate a team or individual for good work.  Reviewed on a quarterly basis and shared by quarterly blog. Quarterly winners to be put forward for a yearly award.

	

	Bring back Midnight Walk – bereaved family feel everyone can participate in this. 
	

	Is there any way to limit the sound in the coffee shop – perhaps pads for the bottom of the chairs
	





9.0 Workforce Assurance

9.1 Absence

We are carrying several vacancies:

· Family Support Worker			1.0 WTE
· HCA (24 hours)				0.7 WTE

As part of our on-going review of teams and workforce transformation, we use exit questionnaires as an opportunity to learn and improve and vacancies as an opportunity to review models of care and workforce development needs. 

9.2 Recruitment

We have successfully recruited to several posts: -

· Nursing Associate				0.6 WTE
· Rehabilitation Assistant			0.8 WTE
· Children’s Counsellor				0.4 WTE
· Ward Clerk					0.5 WTE
· Band 6 Senior Staff Nurse			1.0 WTE	
· 2 Band 5 Nurses (1 x FT, 1 x 30 hours)	1.8 WTE	

We continue to actively review and increase the number of RN and HCA bank staff, for the most part from a pool of staff who have previously worked at the Hospice this will assist with staff induction prior to commencing work on the unit. On rare occasions when they are not available at short notice or are already covering bank for another health care provider, we make use of a local agency for bank cover. Staff absence has resulted in increased use of agency staff in this quarter. 

9.3 Staffing Levels

In Patient Unit

To better match our workforce skill mix and numbers of staff to demand; as measured by patient numbers, dependency and acuity we introduced as of Monday 13 July 2016 a new In-Patient Unit (IPU) dependency tool for based upon NHS England (Shelford Group) safer care.  This helps us to establish benchmark acuity data to better model and predict our IPU care workforce needs against fluctuating bed occupancy and changes in patient acuity. Our nurse-to-patient ratio on the In-Patient Unit under usual circumstances is:-

· 8am to 2pm:				3 RNs to 10 patients, 2 HCAs to 10 patients
· 2pm to 8.30pm: 			2 RNs to 10 patients, 2 HCAs to 10 patients
· 8pm to 8.30am: 			2 RN to 10 patients, 1 HCAs to 10 patients

We have still not heard from the ICB or CDDFT regarding whether the funded PA session vacated following the retirement of Dr le Dune will be transferred to the Hospice, however we aim to continue pursuing the transfer of this funding to the Hospice.

9.4 Training & Development

We continue to support training and development. Staff can access a range of modules under the HENE CPD Tier one funding and we continue to support staff attendance at relevant conferences and workshops. All staff receive mandatory training and compliance against our mandatory training target of 90% is currently:
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· Bereavement              	96%                
· Community                             100%
· Dementia                                93%
· Family Support Services        100%
· Guest Services                     	79%
· LWC                                       100%
· IPU                                         97%
· Medical                                   97%

We currently have 5 independent prescribers (1 pharmacists and 4 nurses).  In this quarter 4, a pharmacist secured a place on Independent Prescribing for Pharmacists.

We continue to roll out competency assessments. Examples include: 

· Medicines Management
· Blood transfusion 
· Syringe drivers
· Midlines
· Verification of Expected Adult Death
· Catheterisation

Training and Development sessions are also provided by our Clinical Practice Development Nurse and cover topics such as CQC, Duty of Care, Continence Care, Physical Observations, Intentional Rounding, Hypercalcaemia, Delirium, Metastatic Spinal Cord Compression, Seizures, Haemorrhage, Bowel Obstruction, Neutropenic Sepsis, Sepsis, Record Keeping, Communication in Handover, Nutrition and Verification of Expected Adult Death.  All permanent clinical staff have completed care and management of the expected and unexpected deteriorating patient.  In August/September we have tissue viability training which will include pressure ulcer, moisture associated skin damage and fungating wound education.  Hickman Line and PICC training/competency assessment will take place in Quarter 2.  We support clinical staff to undertake the Foundations and Advances in Palliative Care Course.

Appendix 1 

NICE Guidance or Standards used to inform both policy and enhance our practice.

Improving supportive and palliative care for adults with cancer. NICE Cancer service guideline (CSG4) March 2004.

Palliative care for adults: strong opioids for pain relief. NICE Clinical Guideline (CG140) May 2012. Last updated: Aug 2016.

Nutritional support in adults: oral nutritional support, enteral tube feeding and parenteral nutritional. (NICE) Clinical Guidance 32 (2006). www.nice.org.uk/Guidance/CG32. (Updated 4 Aug 2017).

Pressure ulcers: prevention and management. NICE Clinical Guideline (CG179) April 2014.

End of life care for adults. NICE Clinical Guideline (QS13) 7 March 2017.

Care of dying adults in the last days of life. NICE Clinical Guideline (QS144) 2 March 2017.

Medicines optimisation: the safe and effective use of medicines to enable the best possible outcomes. NICE guideline (NG5) March 2015.

Medicines optimisation NICE Clinical Guideline (QS120) 24 March 2016.
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Phase of Illness AKPS


IPOS
Views on Care


Barthel Index
(In-patients only)


Zarit Carer Interview and Carer measures


Falls

2022/2023	Apr	May	June	July	Aug	Sept	Oct	Nov	Dec	Jan	Feb	Mar	1	3	3	5	3	3	0	2	0	1	0	0	2023/2024	Apr	May	June	July	Aug	Sept	Oct	Nov	Dec	Jan	Feb	Mar	1	0	2	2	2	6	2	5	2	2	2	0	Mean 2023/2024	Apr	May	June	July	Aug	Sept	Oct	Nov	Dec	Jan	Feb	Mar	2.1666666666666665	2.1666666666666665	2.1666666666666665	2.1666666666666665	2.1666666666666665	2.1666666666666665	2.1666666666666665	2.1666666666666665	2.1666666666666665	2.1666666666666665	2.1666666666666665	2.1666666666666665	UCL 2023/2024	Apr	May	June	July	Aug	Sept	Oct	Nov	Dec	Jan	Feb	Mar	7.4150430389797783	7.4150430389797783	7.4150430389797783	7.4150430389797783	7.4150430389797783	7.4150430389797783	7.4150430389797783	7.4150430389797783	7.4150430389797783	7.4150430389797783	7.4150430389797783	7.4150430389797783	



SDTI

2022/2023	Apr	May	June	July	Aug	Sept	Oct	Nov	Dec	Jan	Feb	Mar	1	8	0	0	2	0	1	0	6	3	0	1	2023/2024	Apr	May	June	July	Aug	Sept	Oct	Nov	Dec	Jan	Feb	Mar	1	0	4	2	0	1	2	1	5	0	4	0	Mean 2023/2024	Apr	May	June	July	Aug	Sept	Oct	Nov	Dec	Jan	Feb	Mar	1.6666666666666667	1.6666666666666667	1.6666666666666667	1.6666666666666667	1.6666666666666667	1.6666666666666667	1.6666666666666667	1.6666666666666667	1.6666666666666667	1.6666666666666667	1.6666666666666667	1.6666666666666667	UCL 2023/2024	Apr	May	June	July	Aug	Sept	Oct	Nov	Dec	Jan	Feb	Mar	6.9924188542582337	6.9924188542582337	6.9924188542582337	6.9924188542582337	6.9924188542582337	6.9924188542582337	6.9924188542582337	6.9924188542582337	6.9924188542582337	6.9924188542582337	6.9924188542582337	6.9924188542582337	



PU

2022/2023	Apr	May	June	July	Aug	Sept	Oct	Nov	Dec	Jan	Feb	Mar	0	2	0	2	3	0	1	0	0	0	1	0	2023/2024	Apr	May	June	July	Aug	Sept	Oct	Nov	Dec	Jan	Feb	Mar	1	0	0	0	0	2	2	1	0	1	1	0	Mean 2023/2024	Apr	May	June	July	Aug	Sept	Oct	Nov	Dec	Jan	Feb	Mar	0.66666666666666663	0.66666666666666663	0.66666666666666663	0.66666666666666663	0.66666666666666663	0.66666666666666663	0.66666666666666663	0.66666666666666663	0.66666666666666663	0.66666666666666663	0.66666666666666663	0.66666666666666663	UCL 2023/2024	Apr	May	June	July	Aug	Sept	Oct	Nov	Dec	Jan	Feb	Mar	3.0021634991512354	3.0021634991512354	3.0021634991512354	3.0021634991512354	3.0021634991512354	3.0021634991512354	3.0021634991512354	3.0021634991512354	3.0021634991512354	3.0021634991512354	3.0021634991512354	3.0021634991512354	



IPOS - Physical Functions


Maintained	Improved	Deteriorated	0.84799999999999998	0.13	2.1999999999999999E-2	

IPOS - Emotional Functions


Maintained	Improved	Deteriorated	0.8	0.19	0.01	
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2019

		Audit Schedule

		Reviewed by: Allison Welsh

		Review date: 20 August 2019

		Audit Tool		Frequency				LWC		IPU		CS		FST		2019		JAN		FEB		MAR		APR		MAY		JUN		JUL		AUG		SEPT		OCT		NOV		DEC		Notes

		Patient Carer Experience		Monthly		Service Managers x4		GC		JMcC		LH		AT																												Family & Friends Test

		LWC/Day Hospice Admission		Quarterly		Service Manager LWV		GC																												10/29/19						1/29/20

		In-patient Admission		Quarterly		Service Managers				JMcC																														12/3/19

		Controlled drugs		Monthly		Nurse Consultant		CW		CW						11/1/18

		Medicine Management		Quarterly		Pharmacist		AB		AB																				Audit 27 Jun

		Medicine Compliance		Weekly on same day		Link Practitioner		JOB		JOB																						Audit 22 Aug		Audit 12 Sept

		Nutrition		Quarterly		Link Practitioner		JB		ET						Oct-17

		Infection control		Quarterly		Service Manager		JM		JMcC

		Mattress & Seat Cushions		Monthly		Senior HCA				TA

		Pressure Ulcers		Quarterly		Staff Nurse				MMG						3/10/19						3/10/19												Audit 1 Aug				11/27/19

		Bereavement		Twice year		Link Practitioner				AC				BM

		Falls (To develop)		Quarterly		Physiotherapist		MP																																		Falls Improvement Group to develop an audit tool for falls

		LWC/Day patient pain		Quarterly		Staff Nurse																														10/29/19						1/29/20

		In patient pain		Quarterly		Staff Nurse										3/20/18																								12/3/19



		INFECTION CONTROL AUDITS

		Code of Practice		Twice year		Infection control group																						6/27/19

		Clinical Rooms - IPU		Twice year		Infection control group																						6/27/19

		Clinical Rooms - LWC		Twice year		Infection control group																								7/11/19

		Domestic Rooms 		Twice year		Infection control group																						6/27/19

		Care of deceased		Twice year		Infection control group																						6/27/19

		Hand Hygiene - IPU		Twice year		Infection control group										9/24/18																		9/6/19

		Hand Hygiene - LWC		Twice year		Infection control group																												9/30/19

		Patient areas - IPU		Twice year		Infection control group										10/18/18																		9/6/19

		Patient areas - LWC		Twice year		Infection control group																														10/26/19

		Offices within patient areas - IPU		Twice year		Infection control group										9/24/18																		9/6/19

		Offices within patient areas - LWC		Twice year		Infection control group																														10/19/19

		Sluice/Dirty Utility		Twice year		Infection control group												1/5/19																				11/29/19

		Sharps IPU		Twice year		Infection control group												1/5/19																				11/29/19

		Sharps LWC		Twice year		Infection control group																																				1/28/20

		Toilets for Public Use - IPU		Twice year		Infection control group												1/5/19																				11/29/19

		Toilets for Public Use - LWC		Twice year		Infection control group												1/11/19																								1/28/20

		Kitchen Areas		Twice year		Infection control group																3/11/19

		Public Areas - IPU		Twice year		Infection control group																3/11/19

		Public Areas - LWC		Twice year		Infection control group																		4/11/19

		Patient Toilets - IPU		Twice year		Infection control group																3/11/19

		Patient Toilets - LWC		Twice year		Infection control group																		4/11/19

		Patient bathrooms - IPU		Twice year		Infection control group																3/11/19

		Patient bathrooms - LWC		Twice year		Infection control group																		4/23/19



../In-patient%20Unit%20Audits/2019%20-%202020/Q2%202019%20-%202020/Medicines%20Compliance/20190912%20Weekly%20medication%20administration%20record%20audit%20chart.docx../In-patient%20Unit%20Audits/2019%20-%202020/Q2%202019%20-%202020/Medicines%20Compliance/20190827%20Weekly%20medication%20administration%20record%20audit%20chart.docx../In-patient%20Unit%20Audits/2019%20-%202020/Q1%202019%20-%202020/General%20Medicine/20190806%20Email%20Allison%20CD%20Monthly%20Audit.msg../In-patient%20Unit%20Audits/2019%20-%202020/Q2%202019%20-%202020/Pressure%20Ulcers/tc05-pressure-ulcer---issue-1-apr-16-(final)---protected%20(2).xls

2020

		Audit Schedule								Quarter 1						Quarter 2						Quarter 3						Quarter 4						COMMENTS



		Reviewed by: Allison Welsh



		AUDIT TOOL		Frequency						APR		MAY		JUN		JUL		AUG		SEPT		OCT		NOV		DEC		JAN		FEB		MAR

		Family & Friends Test		Monthly		Service Managers x4		Quarterly

		LWC/Day Hospice Admission		Quarterly		Service Manager LWV		Quarterly

		In-patient Admission		Quarterly		Service Manager IPU		Quarterly

		INFO GOV AUDITS

		IPU		Quarterly		Medical team		Quarterly

		LWC		Quarterly		Medical team		Quarterly

		Dementia		Quarterly		Medical team		Quarterly

		FST		Quarterly		Medical team		Quarterly

		Caldecott		Annually		Medical team		Annually

		TISSUE VIABILITY AUDITS

		Pressure Ulcers		Quarterly		Staff Nurse		Quarterly

		FUNDAMENTAL ASPECTS OF CARE AUDIT

		Nutrition IPU		Quarterly		Snr Staff Nurse		Quarterly

		Nutrition LWC		Quarterly		Snr Staff Nurse		Quarterly

		Bereavement		Twice year		Co-Ordinator		Quarterly

		Falls (KPI)		Quarterly		Physiotherapist		Quarterly

		LWC/Day patient pain		Quarterly		Staff Nurse		Quarterly

		In patient pain		Quarterly		Staff Nurse		Quarterly

		MEDICINES OPTIMISATION AUDITS

		General Medicine Management		Quarterly		Pharmacist		Quarterly

		Medicine Compliance		Weekly at MDT		Pharmacist		Weekly at MDT

		Controlled drugs		Quarterly		Snr Staff Nurse		Biannually

		Accountable Officer Audit		Annually		Head of CS		Annually

		INFECTION CONTROL AUDITS

		Code of Practice		Annually		Infection control group		Annually

		Mattresses 		Monthly		Senior HCA		Weekly

		Clinical Rooms - IPU		Annually		Infection control group		Biannually

		Clinical Rooms - LWC		Annually		Infection control group		Biannually

		Domestic Rooms 		Annually		Infection control group		Biannually

		Care of deceased		Annually		Infection control group		Biannually

		Hand Hygiene - IPU		Twice year		Infection control group		Biannually

		Hand Hygiene - LWC		Twice year		Infection control group		Biannually

		Patient areas - IPU		Annually		Infection control group		Biannually

		Patient areas - LWC		Annually		Infection control group		Biannually

		Offices within patient areas - IPU		Annually		Infection control group		Biannually

		Offices within patient areas - LWC		Annually		Infection control group		Biannually

		Sluice/Dirty Utility		Annually		Infection control group		Biannually

		Sharps IPU		Annually		Infection control group		Biannually

		Sharps LWC		Annually		Infection control group		Biannually

		Toilets for Public Use - IPU		Annually		Infection control group		Biannually

		Toilets for Public Use - LWC		Annually		Infection control group		Biannually

		Kitchen Areas		Annually		Infection control group		Biannually

		Public Areas - IPU		Annually		Infection control group		Biannually

		Public Areas - LWC		Annually		Infection control group		Biannually

		Patient Toilets - IPU		Annually		Infection control group		Biannually

		Patient Toilets - LWC		Annually		Infection control group		Biannually

		Patient bathrooms - IPU		Annually		Infection control group		Biannually

		Patient bathrooms - LWC		Annually		Infection control group		Biannually

		Policies and Protocols		Annually		Infection control group		Biannually

		Protective Equipment		Annually		Infection control group		Biannually





2023

		Audit Schedule						Quarter 1						Quarter 2						Quarter 3						Quarter 4



		Reviewed by: Allison Welsh		Sep-23

		Agreed by CGSC

		AUDIT TOOL		Frequency				APR		MAY		JUN		JUL		AUG		SEPT		OCT		NOV		DEC		JAN		FEB		MAR

		Family & Friends Test		Monthly		Service Managers x4

		LWC/Day Hospice Admission		Quarterly		Service Manager LWC

		In-patient Admission		Quarterly		Service Manager IPU

		Doctor Admission Documentation		Quarterly		Doctor

		Care afte Death Documentation		Quarterly		Doctor/Nurse

		INFO GOV AUDITS

		IPU		Quarterly		Governance Mgr

		LWC		Quarterly		Governance Mgr

		Dementia		Quarterly		Governance Mgr

		FST		Quarterly		Governance Mgr

		Caldecott (clinical & non clinical areas)		Annually		Medical Director

		Medical Audits

		Calcium Audit		Annually		GPR

		EHCP Audit		Annually		Doctor

		Spirituality Audit		Annually		Doctor

		Referrals to the Coroner/Inquests		Quarterly		Doctor

		CSNAT Audit

		CSNAT Audit		Twice year		Admiral Nurse

		TISSUE VIABILITY AUDITS

		Pressure Ulcers		Quarterly		Staff Nurse

		FUNDAMENTAL ASPECTS OF CARE AUDIT

		Nutrition IPU		Quarterly		Snr Staff Nurse

		Nutrition LWC		Quarterly		Snr Staff Nurse

		Bereavement		Twice year		Co-Ordinator

		Falls (KPI)		Daily		Physiotherapist

		Record Keeping (falls bundle)		Weekly		Service Manager

		LWC/Day patient pain		Quarterly		Staff Nurse																		n/a

		Blood Transfusion IPU		Quarterly		Staff Nurse

		Blood Transfusion LWC		Quarterly		CPDN

		In patient pain		Quarterly		Staff Nurse

		Clinical Record Keeping (ROPE)		Quarterly		Service Manager

		MEDICINES OPTIMISATION AUDITS

		General Medicine Management		Quarterly		Pharmacist

		Medicine Compliance		Weekly at MDT		Pharmacist

		Controlled drugs		Quarterly		Snr Staff Nurse

		Accountable Officer Audit		Annually		Head of CS

		INFECTION CONTROL AUDITS

		Code of Practice - Julia		Annually		Infection control group

		Mattresses 		Quarterly		Senior HCA

		Bed fall sensor mat		Quarterly		HCA

		Chair falls sensor mat		Quarterly		HCA

		Clinical Rooms - IPU		Annually		Infection control group

		Clinical Rooms - LWC		Annually		Infection control group

		Domestic Rooms IPU		Annually		Infection control group

		Domestic Rooms LWC		Annually		Infection control group

		Care of deceased		Annually		Infection control group

		Hand Hygiene - IPU		Twice year		Infection control group

		Hand Hygiene - LWC		Twice year		Infection control group

		Patient areas - IPU		Annually		Infection control group

		Patient areas - LWC		Annually		Infection control group

		Offices within patient areas - IPU		Annually		Infection control group

		Offices within patient areas - LWC		Annually		Infection control group

		Sluice/Dirty Utility		Annually		Infection control group

		Sharps IPU		Annually		Infection control group

		Sharps LWC		Annually		Infection control group

		Toilets for Public Use - IPU		Annually		Infection control group																						re audit

		Toilets for Public Use - LWC		Annually		Infection control group

		Kitchen Areas		Annually		Infection control group

		Public Areas - IPU		Annually		Infection control group

		Public Areas - LWC		Annually		Infection control group

		Patient Toilets - IPU		Annually		Infection control group

		Patient Toilets - LWC		Annually		Infection control group

		Patient bathrooms - IPU		Annually		Infection control group

		Patient bathrooms - LWC		Annually		Infection control group

		Policies and Protocols		Annually		Infection control group

		Protective Equipment		Annually		Infection control group

		Patient Safety

		Manchester Patient Safety Tool		Annually



		DOLS/MCA		Quarterly		Service Manager

		Albumin Audit LWC		Quarterly		Nurse

		VIP score -LWC		Quarterly		Nurse						n/a

		IV audit - IPU		Quarterly		IV Link practitioner						n/a

		Catering Audit		Monthly		Guest Services Manager

		Housekeeping Audit (Catering)		Monthly		Guest Services Manager

		National Standards of Cleanliness		Annually		Guest Services Manager

		External Audits

		Infection Control		Annually		ICB IPC Nurse

		Food Hygiene		Annually		Durham County Council

		Safeguarding		Annually		ICB Safeguarding Nurse

		Falls		Annually		Ergonimics Specialist

		To be Developed

		Medical Devices		Quarterly		Link Practitioner
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Q3 carried over…



		Audit

		Date

		Findings

		Actions

		By Who

		By when

		Status



		Raising/ Responding to Concerns Appreciative Enquiry.

		12.12.23

		Next steps – progress made in relation to further understanding of barriers to raising concerns.



Staff training session in development – difficult conversations.

		Staff training session to roll out.



Present findings and complete action plan.

		DM/ ALF

		End of Jan 24

		On-going



		IPU - TVN

		

		· 1.25 & 2.10 - water low score does not ask if patient can comply with pressure area care but this is identified on care plan.



· Patient with a SDTI not referred to TVN as non complex SDTI and patient actively dying would not have been an appropriate referral – appropriate care in place.

		· JM to look at another tool and discuss with Head of clinical services as if keeping took change N to X 

		JM

		End Q4

		Ongoing



		IPU – Nutrition

		Dec 2023

		· The audit showed in sub topic 1 & 2  had 100% compliance; every area was acknowledged which was an improvement on Q2.



· Sub topic 3 education and training – not been completed ?



















· Sub topic 4 - Service evaluation – compliance at 42.9% 

		















· JM spoke with practitioner and requested section be completed and any actions to begin actioning 











· We continue to not meet 4IP1 TO 4IP8 Sue acknowledged this and is planning to organise a questionnaire - I will email Sue 6/12/23 to chase this up.  Current friends and family test covers quality of food and access to food outside of meal times.

· SS has added additional questions onto FF test and spreadsheet.

		JM/SM

		End Q4

		Ongoing



		IPU - Kitchen

		7/12/23

		Compliance 85.7% 



Overall appearance – not clean, lack of consistency with completion of daily tasks 









		· Guest services to speak with kitchen staff re: inconsistency of daily cleaning schedule and advise of importance of completing.

· IPU service manager to email kitchen staff audit and highlight issues.

· Domestic staff will deep clean kitchen on a Friday between 3pm-4pm every week.

· Review of kitchen 11/12 by JM – no improvement – deep clean by JM – email to Guest services manager.

· To re audit end Jan 2024.





		JM

SM

		Immediately

		Ongoing



		IPU – Patient bathrooms

		11/12/23

		· Perspex needed to wooden boxing in bathroom 2. 







· Chips to paint work on wall to ensuite bathroom 3

		· Central support to order materials 11/12/23 and to be fitted W/C 18/12/23.



· Spoke to central support – decorators attending this week will ask to do room 3 as a priority if able to keep empty.

		JM / central support

		End Jan 2024

		Ongoing



		IPU – Toilets 

		11/11/23

		98.8 compliance



Room 3 en suite – wall chipped

		



Central support aware and making room a priority for decorating.



		JM/Central support

		End Jan 2024

		Ongoing 







Q4



		Audit

		Date

		Findings

		Actions

		By Who

		By when

		Status



		IPU - Sluice

		2/2/24

		No issues

		N/A

		

		

		Closed



		IPU – Code of practice

		26/2/24

		All areas now 100% compliant.

		completed

		

		

		Closed



		IPU – Hand hygiene

		8/2/24

		No issues

		N/A

		

		

		Closed



		IPU – Weekly falls bundle 

		25/3/24

		100% falls risk assessment completed.

97% moving and handling completed.

97% bed rails.

100% PEP.

100% Care plan in place.



Overall, very good.  For the most part staff completing all sections appropriately of the weekly falls bundle. 1 x occasions where moving and handling risk assessment not completed and 1 x occasion where bed rail assessment not completed at weekly update but had both been done so the week before and was still correct the next week.

		

		

		Bed rails

		PEP

		Care plan







		

















Ward manager spoke with 2 x individual staff members and reflected 

		JM

		Completed

		Closed



		IPU – Tissue Viability

		25/3/24

		· 1.25 does risk assessment take into account if patient can comply with positional changes.



· 2.10 Does the risk assessment include is the patient able to comply with positional changes water low score does not ask if patient can comply with pressure area care but this is identified on care plan.



		Waterlow score does not include this but is identified in patients care plan.



JM has started looking at Propose-T skin assessment.



As per last audit rather than put ‘no’ as waterlow score does not include this will but X as care plan does include this and all patients will have a pressure ulcer care plan whether it be at risk of pressure damage or identifying they have pressure damage 

		JM





		Q1

		Ongoing



		IPU – Admission falls bundle

		25/3/24

		The audit of the admission falls bundle continues to improve.

In the 44 admissions reviewed, 42 were completed correctly (95%).

 

The same error occurred The staff member had not used the preset options at the end of the bedrails assessment and had only used the free-text box.





		













This has been addressed with the member of staff concerned and subsequent assessments have been completed correctly.

		JC

		

		Closed



		IPU – Blood transfusion

		24/3/24

		1 x issue out of 4 units transfused.  Stop time not documented on pathway

		FN spoke to staff member to advise to complete all sections of pathway

		FN

		

		Closed



		IPU - Pain

		4/3/24

		Main areas for improvement identified is recording spiritual, psychological and social impact of pain, aggravating and relieving factors of pain are not always documented. 







		JM has amended admission template to include sections to specifically identify the areas identified.



Email to all staff highlighting the need to include these factors in the admission assessment and care plan.



Review audit next quarter 



		JM

		

		Closed



		IPU - Admission

		

		Capacity 60%of notes audited captured this.

		Email sent to all staff advising what to complete on S1 on admission to ensure capacity is identified whether capacity is assumed or not.



Discussed with CB and advised next audit rather than generalise with all staff to speak to individual staff to address the issue directly and to offer more support if this is required around this subject area.

93% of staff have completed face to face MCA training 1 x RN left to completed and booked onto session on 11th April.



		CB/JM

		Q1

		Closed



		IPU – Re audit of kitchen as per Q3 audit

		26/2/24

		Full re audit 26th Feb – compliance now 94% from 85%



IPU service manager has been observing the general cleanliness of the IPU kitchen since last audit and with the scheduled deep clean once a week thing have improved.  Domestic staff had been allocated the deep clean once a week and SOP implemented re: how each are of the kitchen was to be cleaned.  



There is also a daily clean rota to be completed daily by the kitchen staff   - this is not consistently signed - 

The weekly deep clean of the IPU kitchen is to go over to the kitchen staff from this weekend as per the National Standards of Healthcare Cleanliness which is being introduced this will happen from w/c 26/2/24.  SOP in place to outline procedure to be followed.

Service manager will re audit April 2024.

		Kitchen staff to take over weekly deep clean of IPU kitchen on a weekend w/c 26/2/24.























Guest services manager aware and to pick up with kitchen staff.  IPU service manager has previously spoke to kitchen staff re: the importance of consistently completing the sign off sheet once they have completed the tasks not doing so does not offer assurance the task has been completed.









Re audit April 2024

		Kitchen Staff.





























SM

		Starts 2nd/3rd March.



























ASAP































30th April 2024

		Ongoing



		IPU - Nutrition

		March 24

		Sub topic 3 - Training.















Sub Topic 4 - Service evaluation – compliance now at 100% from 42.9%.

		Staff have been asked to complete nutrition e learning and are doing so.  To ensure all staff have completed by Q1 2025-2026.





Questions added to friends and family questionnaire to receive feedback and ensure compliance.

		LL/JM/SM

		Q1 2024-2025

		Closed



		IPU – IV 

		March 24

		Evening VIP score not completed consistently.













Audit tool revised to trial for Q1 2024-2025



		VIP template amended to allow staff to input multiple VIP scores for the day.



Staff emailed to remind when to complete.



		JM









LS



		

		Closed



		LWC - Admissions

		25.03.24

		Mental capacity documented in notes, but mandatory S1 template not completed every time by 1 staff member.

		121 with staff member to advise – improvements noted.



Noted that this is a replication of Q3 – staff member aware to address this issue as urgent.

		JOB

		25.03.24

		Closed



		LWC – Pain

		25.03.24

		No outpatients attended for pain management.

		None

		None

		None

		Closed



		LWC – Falls

		25.03.24

		0 falls.

M&H review- no concerns.

Home transport – no concerns.

		None

		None

		None

		Closed



		LWC – Infection Control

		25.03.24

		No concerns

		None

		None

		None

		Closed



		LWC – Nutrition

		25.03.24

		No concerns – 100% completion rate.

		None

		None

		None

		Closed



		LWC – Blood transfusion

		25.03.24

		No transfusions in Q4.

		None

		None

		None

		Closed



		LWC - Albumin

		25.03.24

		No concerns – 100% completion rate.

		None

		None

		None

		Closed



		LWC – VIP audit

		25.03.24

		No concerns – 100% completion rate.

		None

		None

		None

		Closed



		LWC - Day Services Clinical Record Keeping

		08.03.24

		1x set notes had been updated after the event.



1x set notes lacked detail.

		Spoke to staff and reviewed – see action plan.

		DM

		09.03.24

		Closed



		Raising/ Responding to Concerns Appreciative Enquiry.

		30.03.24

		Report completed.

		Staff training session to roll out.



Present findings and complete action plan.

		DM/ ALF

		None

		Closed







JOB 	Joanne O’Brien			MM	Michelle Maguire	JMe Joanne Metcalfe         TA	Tracy Allen	

CB          Colleen Bell 			AR Andrea Ryan		    	ALF – Aislinn Le Fevre	   GS	Gary Scott

JM	Julia McCabe			DM 	David McLoughlin	DC Denise Crawford	    SMc – Susan McAleer

SL	Sarah Lee			JW Judith Weston	               LS Lesley Shaw		    JS	Julie Stainsby						
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Blood transfusion Status Slide Q4.pptx
Quarter 4

Policies and procedures



SLA  - updated and signed (March 2024).



Training

IPU – 97%

LWC – 100%

Medical staff – 60% (2 x Drs aware to do e learning)

Space increased for face to face training sessions.

3 year competency assessment

IPU

Competency assessment at 67% (new staff need to be observed and signed off)

LWC – 100%



Quarterly audit 

IPU – Out of 4 units transfused 1 x documentation error – staff had now completed stop time.  FN discussed with staff.

LWC

No issues

Planned for Quarter 1

Policies

Not needed.



Audits: 

Quarterly audits IPU (FN)

Quarterly Audit LWC (Jo O’Brien)



Training & Development:

On going yearly face to face training.  

Competency assessments to be completed



Risks & Issues

Medical compliance with training.







Mitigating Actions



RAG Rating: Medium 

















Clinical Services: Blood Transfusion Link Practitioner Group 

Quarterly Status Report

Group Members				Governance 	

Julia McCabe, Service Manager/Chair (JM)		Allison Welsh, Head of Clinical Services/Chair of CGG.(AW)

Faye Nesbit, Staff Nurse (FN)		Gillian MacArthur, Trustee/Chair of CGSC

Denise Crawford, Clinical Practice Development Nurse (DC)

		

Group Purpose: To maintain an overview of blood transfusion priorities within the In-patient Unit and Living Well Centre (Day Hospice) and ensure that blood transfusions are appropriately managed. To link this into clinical governance and risk management processes. To provide assurance to the Board that our policy, processes and operational delivery of blood transfusions result in positive patient outcomes.

Clinical Services, Blood Transfusion Link Practitioner Group, Status Slide V3, Service Manager, IPU, Mar 2024



Quarter 2

Jul - Sep



Quarter 3

Oct- Dec



Quarter 4

Jan - Mar



Quarter 1

Apr - Jun





SmartArt custom animation effects: motion path and faded zoom

(Intermediate)





To reproduce the SmartArt effects on this page, do the following:

On the Home tab, in the Slides group, click Layout, and then click Blank. 

On the Insert tab, in the Illustrations group, click SmartArt. In the Choose a SmartArt Graphic dialog box, in the left pane, click Process. In the Process pane, click Basic Chevron Process (third row, first option from the left), and then click OK to insert the graphic into the slide.

To create a fourth chevron shape, select the chevron shape at the right end of the graphic, and then under SmartArt Tools, on the Design tab, in the Create Graphic group, click the arrow next to Add Shape, and select Add Shape After.

Select the graphic, and then click one of the arrows on the left border. In the Type your text here dialog box, enter text.

Select the graphic. Under SmartArt Tools, on the Design tab, in the SmartArt Styles group, do the following:

Click Change Colors, and then under Colorful click Colorful Range – Accent Colors 3 to 4  (third option from the left).

Click More, and then under 3-D, click Inset (first row, second option from the left).





To reproduce the animation effects on this slide, do the following:

On the Animations tab, in the Animations group, click Custom Animation.

On the slide, select the graphic. In the Custom Animation task pane, do the following:

Click Add Effect, point to Entrance, and then click More Effects. In the Add Entrance Effect dialog box, under Subtle, click Faded Zoom. 

Under Modify: Faded Zoom, in the Speed list, select Fast.

Also in the Custom Animation task pane, click Add Effect, point to Motion Paths, and then click Left.

Also in the Custom Animation task pane, select the second animation effect (left motion path), and then under Modify: Left, in the Speed list, select Fast.

On the slide, right-click the motion path, and then click Reverse Path Direction. (Note: The green arrow will move to the left end of the motion path.)

Press and hold CTRL, and then select the first and second animation effects (faded zoom effect and left motion path) in the Custom Animation task pane. Click the arrow to the right of the second animation effect (left motion path), and then click Effect Options. In the Left dialog box, on the SmartArt Animation tab, in the Group graphic list, select One by one.

Also in the Custom Animation task pane, do the following:

Click the double arrow under the first animation effect (faded zoom effect) to expand the contents of the list of effects.

Click the double arrow under the second animation effect (left motion path) to expand the contents of the list of effects.  

Press and hold CTRL, and then in the Custom Animation task pane, select the first, second, third, and fourth animation effects (all four faded zoom effects). Under Modify: Faded Zoom, in the Start list, select After Previous.

Press and hold CTRL, and then in the Custom Animation task pane, select the fifth, sixth, seventh, and eighth animation effects (all four left motion paths). Under Modify: Left, in the Start list, select With Previous.

Also in the Custom Animation task pane, do the following to reorder the list of effects:

Drag the fifth animation effect (first left motion path) until it is second in the list of effects.

Drag the sixth animation effect (second left motion path) until it is fourth in the list of effects.

Drag the seventh animation effect (third left motion path) until it is sixth in the list of effects.





To reproduce the background effects on this slide, do the following:

Right-click the slide background, and then click Format Background. In the Format Background dialog box, click Fill in the left pane, select Gradient fill in the Fill pane, and then do the following:

In the Type list, select Radial.

In the Direction list, click From Center (third option from the left).

Under Gradient stops, click Add or Remove until two stops appear in the drop-down list.

Also under Gradient stops, customize the gradient stops as follows:

Select Stop 1 from the list, and then do the following:

In the Stop position box, enter 0%.

Click the button next to Color, and then under Theme Colors click Black, Text 1, Lighter 50% (second row, second option from the left).

Select Stop 2 from the list, and then do the following: 

In the Stop position box, enter 100%.

Click the button next to Color, and then under Theme Colors click Black, Text 1 (first row, second option from the left).
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Falls Prevention Status Slide Q4 2023 - 2024.pptx
Achieved in Q4



Recruitment to OT post.

Rehab Assistant inducted and supporting Physio.



Training



IPU – 92%

LWC – 95%

Medical – 100%



Safety Alerts – action plans complete – none.



Other:

Dementia-Namaste Team now complete falls bundle for new admissions.

Planned for Q1



On-going falls audit.



New OT induction and M&H training.



Rehab Assistant competency development.



Risks & Issues in Q4



No OT in post

2x M&H incidents involving staff – SIRMS and lessons learnt in place.



Mitigating Actions

1.OT post recruited to.

Rehab Assistant in post



2. Clinical risk assessments in place/ protocols had been followed.



RAG Rating: Low

Clinical Services: Falls Prevention Link Practitioner Group	

Quarterly Status Report

Group Members			Governance 	

Colleen Bell, Snr Staff Nurse			Allison Welsh, Head of Clinical Services/Chair of CGG

Vacancy, Occupational Therapist		Gillian MacArthur, Trustee/Chair of CGSC

David McLoughlin, Service Manager

Gary Scott, Health Care Assistant

Jenny Collins, Physiotherapist



Group Purpose:  To prevent people from receiving unsafe care and treatment and prevent avoidable harm or risk of harm due to falls. (Health & Social Care Act 2008 (Regulated Activities) Regulation 12: Safe Care and Treatment).



Clinical Services, Falls Prevention Link Practitioner Group, Status Slide V3, Service Manager, Day Services,  Mar 2024



Quarter 2

July – Sept



Quarter 4

Jan - Mar



Quarter 1

Apr - June



Quarter 3

Oct - Dec





SmartArt custom animation effects: motion path and faded zoom

(Intermediate)





To reproduce the SmartArt effects on this page, do the following:

On the Home tab, in the Slides group, click Layout, and then click Blank. 

On the Insert tab, in the Illustrations group, click SmartArt. In the Choose a SmartArt Graphic dialog box, in the left pane, click Process. In the Process pane, click Basic Chevron Process (third row, first option from the left), and then click OK to insert the graphic into the slide.

To create a fourth chevron shape, select the chevron shape at the right end of the graphic, and then under SmartArt Tools, on the Design tab, in the Create Graphic group, click the arrow next to Add Shape, and select Add Shape After.

Select the graphic, and then click one of the arrows on the left border. In the Type your text here dialog box, enter text.

Select the graphic. Under SmartArt Tools, on the Design tab, in the SmartArt Styles group, do the following:

Click Change Colors, and then under Colorful click Colorful Range – Accent Colors 3 to 4  (third option from the left).

Click More, and then under 3-D, click Inset (first row, second option from the left).





To reproduce the animation effects on this slide, do the following:

On the Animations tab, in the Animations group, click Custom Animation.

On the slide, select the graphic. In the Custom Animation task pane, do the following:

Click Add Effect, point to Entrance, and then click More Effects. In the Add Entrance Effect dialog box, under Subtle, click Faded Zoom. 

Under Modify: Faded Zoom, in the Speed list, select Fast.

Also in the Custom Animation task pane, click Add Effect, point to Motion Paths, and then click Left.

Also in the Custom Animation task pane, select the second animation effect (left motion path), and then under Modify: Left, in the Speed list, select Fast.

On the slide, right-click the motion path, and then click Reverse Path Direction. (Note: The green arrow will move to the left end of the motion path.)

Press and hold CTRL, and then select the first and second animation effects (faded zoom effect and left motion path) in the Custom Animation task pane. Click the arrow to the right of the second animation effect (left motion path), and then click Effect Options. In the Left dialog box, on the SmartArt Animation tab, in the Group graphic list, select One by one.

Also in the Custom Animation task pane, do the following:

Click the double arrow under the first animation effect (faded zoom effect) to expand the contents of the list of effects.

Click the double arrow under the second animation effect (left motion path) to expand the contents of the list of effects.  

Press and hold CTRL, and then in the Custom Animation task pane, select the first, second, third, and fourth animation effects (all four faded zoom effects). Under Modify: Faded Zoom, in the Start list, select After Previous.

Press and hold CTRL, and then in the Custom Animation task pane, select the fifth, sixth, seventh, and eighth animation effects (all four left motion paths). Under Modify: Left, in the Start list, select With Previous.

Also in the Custom Animation task pane, do the following to reorder the list of effects:

Drag the fifth animation effect (first left motion path) until it is second in the list of effects.

Drag the sixth animation effect (second left motion path) until it is fourth in the list of effects.

Drag the seventh animation effect (third left motion path) until it is sixth in the list of effects.





To reproduce the background effects on this slide, do the following:

Right-click the slide background, and then click Format Background. In the Format Background dialog box, click Fill in the left pane, select Gradient fill in the Fill pane, and then do the following:

In the Type list, select Radial.

In the Direction list, click From Center (third option from the left).

Under Gradient stops, click Add or Remove until two stops appear in the drop-down list.

Also under Gradient stops, customize the gradient stops as follows:

Select Stop 1 from the list, and then do the following:

In the Stop position box, enter 0%.

Click the button next to Color, and then under Theme Colors click Black, Text 1, Lighter 50% (second row, second option from the left).

Select Stop 2 from the list, and then do the following: 

In the Stop position box, enter 100%.

Click the button next to Color, and then under Theme Colors click Black, Text 1 (first row, second option from the left).
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Infection Control Status Slide Q4.pptx
Achieved in Quarter 4

Policies and procedures 

VHF Policy and SOP completed



Training

Infection Control Level 1

IPU – 100%      (2/2)

LWC – 100%    (4/4)

Overall – 100% (6/6)

 Infection Control Level 2

IPU – 100%      (33/33)

LWC – 100%   87/8)

Medical – 100% (5/5)

Overall – 100%  (46/46)

%



Audits

IPU

Code of practice – Now compliant @ 100% 

Hand Hygiene – no issues

Sluice – No issues

Re audit IPU kitchen - ..\..\..\..\AUDITS\In-patient Unit Audits\2023-2024\Q4\Infection control\re audit of kitchen Q4 2023-2024.xls



LWC 

No issues reported



Infection control meeting – Q3 and Q4 (March 2024)



Other

CQC – cold room issues - resolved

Planned for Quarter 1



Review of policies/Leaflets

review of policies and  SOPs as required



Audits: 

Quarterly audits

External audit as Q4 cancelled



Other:

Q1 IPC meeting

















Risks & Issues

Covid -19 Pandemic

Staff Symptomatic testing as per government guidance .

Patients now only to be screened with LFT if symptomatic as per government guidance (Jan 2024)



Mitigating Actions

Ongoing risk assessment & action planning

Escalated through line management & governance arrangements



RAG Rating: Green

Clinical Services: Infection Prevention & Control Link Practitioner Group

Quarterly Status Report

Group Members				Governance 	

Julia McCabe, Service Manager/Chair 		Allison Welsh, Head of Clinical Services/Chair of CGG.

Joanne Metcalf, Snr Staff Nurse	

Dre Ellie Parker				Gillian MacArthur, Trustee/Chair of CGSC

Dr Angela Galloway, Trustee			Administration - Sarah Stanley

David McLoughlin, Service Manager			

Group Purpose: To maintain an overview of infection prevention and control priorities within the Hospice’s clinical areas, and to link this into clinical governance and risk management processes. It will ensure that infection prevention and control issues are appropriately managed within the hospice, to ensure the prevention and control of Health Care Associated Infections and cleanliness across the hospice. The group aims to provide assurance to the Board that policy, processes and operational delivery of infection prevention and control results in positive patient outcomes

Infection Prevention & Control Link Practitioner Group, Status Slide V2, Service Manager, IPU, Mar 2024



Quarter 2

Jul - Sep



Quarter 3

Oct - Dec



Quarter 4

Jan - Mar



Quarter 1

Apr - Jun





SmartArt custom animation effects: motion path and faded zoom

(Intermediate)





To reproduce the SmartArt effects on this page, do the following:

On the Home tab, in the Slides group, click Layout, and then click Blank. 

On the Insert tab, in the Illustrations group, click SmartArt. In the Choose a SmartArt Graphic dialog box, in the left pane, click Process. In the Process pane, click Basic Chevron Process (third row, first option from the left), and then click OK to insert the graphic into the slide.

To create a fourth chevron shape, select the chevron shape at the right end of the graphic, and then under SmartArt Tools, on the Design tab, in the Create Graphic group, click the arrow next to Add Shape, and select Add Shape After.

Select the graphic, and then click one of the arrows on the left border. In the Type your text here dialog box, enter text.

Select the graphic. Under SmartArt Tools, on the Design tab, in the SmartArt Styles group, do the following:

Click Change Colors, and then under Colorful click Colorful Range – Accent Colors 3 to 4  (third option from the left).

Click More, and then under 3-D, click Inset (first row, second option from the left).





To reproduce the animation effects on this slide, do the following:

On the Animations tab, in the Animations group, click Custom Animation.

On the slide, select the graphic. In the Custom Animation task pane, do the following:

Click Add Effect, point to Entrance, and then click More Effects. In the Add Entrance Effect dialog box, under Subtle, click Faded Zoom. 

Under Modify: Faded Zoom, in the Speed list, select Fast.

Also in the Custom Animation task pane, click Add Effect, point to Motion Paths, and then click Left.

Also in the Custom Animation task pane, select the second animation effect (left motion path), and then under Modify: Left, in the Speed list, select Fast.

On the slide, right-click the motion path, and then click Reverse Path Direction. (Note: The green arrow will move to the left end of the motion path.)

Press and hold CTRL, and then select the first and second animation effects (faded zoom effect and left motion path) in the Custom Animation task pane. Click the arrow to the right of the second animation effect (left motion path), and then click Effect Options. In the Left dialog box, on the SmartArt Animation tab, in the Group graphic list, select One by one.

Also in the Custom Animation task pane, do the following:

Click the double arrow under the first animation effect (faded zoom effect) to expand the contents of the list of effects.

Click the double arrow under the second animation effect (left motion path) to expand the contents of the list of effects.  

Press and hold CTRL, and then in the Custom Animation task pane, select the first, second, third, and fourth animation effects (all four faded zoom effects). Under Modify: Faded Zoom, in the Start list, select After Previous.

Press and hold CTRL, and then in the Custom Animation task pane, select the fifth, sixth, seventh, and eighth animation effects (all four left motion paths). Under Modify: Left, in the Start list, select With Previous.

Also in the Custom Animation task pane, do the following to reorder the list of effects:

Drag the fifth animation effect (first left motion path) until it is second in the list of effects.

Drag the sixth animation effect (second left motion path) until it is fourth in the list of effects.

Drag the seventh animation effect (third left motion path) until it is sixth in the list of effects.





To reproduce the background effects on this slide, do the following:

Right-click the slide background, and then click Format Background. In the Format Background dialog box, click Fill in the left pane, select Gradient fill in the Fill pane, and then do the following:

In the Type list, select Radial.

In the Direction list, click From Center (third option from the left).

Under Gradient stops, click Add or Remove until two stops appear in the drop-down list.

Also under Gradient stops, customize the gradient stops as follows:

Select Stop 1 from the list, and then do the following:

In the Stop position box, enter 0%.

Click the button next to Color, and then under Theme Colors click Black, Text 1, Lighter 50% (second row, second option from the left).

Select Stop 2 from the list, and then do the following: 

In the Stop position box, enter 100%.

Click the button next to Color, and then under Theme Colors click Black, Text 1 (first row, second option from the left).
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Information Governance Status Slide Q4.pptx
Achieved in Q3

Information Governance Meeting Cancelled – awaiting new date.



Link Practitioner Group meeting cancelled due to sickness/A/L



Have now gained access to Governance related SIRMS.





Planned for Q4

 Next Information Governance meeting booked for 23/04/24 @ 13:00-14.30pm



AR introduction to the IG Audit & Documentation



Information Governance Audit completed by DC & AR



Book next IG Link Practitioner Group Meeting for Q1. 2024/5

Risks & Issues

Organisational Risk – Breach of Confidentiality Incidents (Service Users, Volunteers, Staff & Supporters) S Drive/SystmOne

Mitigating Actions

CPDN (ANP) now in post

Link Practitioner Group for IG 

Reflection/Learning from Incidents

Revision of Policy – Shared Information

Attendance to Information Governance Meeting

RAG Rating: Low



Clinical Services: Information Governance Link Practitioner Group	

Quarterly Status Report



Group Members			Governance 	

Denise Crawford, Advanced Nurse Practitioner	Allison Welsh, Head of Clinical Services/Chair of CGG

Joanne O’Brien, Senior Staff Nurse 	

Joanne Metcalfe, Staff Nurse			Anne Rae, Governance & Compliance Manager

Andrea Ryan, Bereavement Support Team Leader

Aislinn Le Fevre - Social Worker 



Purpose of the Group: To maintain an overview of Information Governance priorities within the clinical areas of the hospice in line with the legislative framework and Hospice Policy/Procedures.  This will link into Clinical Governance and Risk Management processes relating to things such as Confidentiality, Data Protection, Information Recording, Sharing Confidential Information, Subject Access Requests and Freedom of Information Requests.

Clinical Services, Information Governance Link Practitioner Group, Status Slide V2, 

CPD Nurse, Mar 2024



Quarter 4

Jan - Mar



Quarter 3

Oct - Dec



Quarter 1

Apr – Jun



Quarter 2

Jul - Sep





SmartArt custom animation effects: motion path and faded zoom

(Intermediate)





To reproduce the SmartArt effects on this page, do the following:

On the Home tab, in the Slides group, click Layout, and then click Blank. 

On the Insert tab, in the Illustrations group, click SmartArt. In the Choose a SmartArt Graphic dialog box, in the left pane, click Process. In the Process pane, click Basic Chevron Process (third row, first option from the left), and then click OK to insert the graphic into the slide.

To create a fourth chevron shape, select the chevron shape at the right end of the graphic, and then under SmartArt Tools, on the Design tab, in the Create Graphic group, click the arrow next to Add Shape, and select Add Shape After.

Select the graphic, and then click one of the arrows on the left border. In the Type your text here dialog box, enter text.

Select the graphic. Under SmartArt Tools, on the Design tab, in the SmartArt Styles group, do the following:

Click Change Colors, and then under Colorful click Colorful Range – Accent Colors 3 to 4  (third option from the left).

Click More, and then under 3-D, click Inset (first row, second option from the left).





To reproduce the animation effects on this slide, do the following:

On the Animations tab, in the Animations group, click Custom Animation.

On the slide, select the graphic. In the Custom Animation task pane, do the following:

Click Add Effect, point to Entrance, and then click More Effects. In the Add Entrance Effect dialog box, under Subtle, click Faded Zoom. 

Under Modify: Faded Zoom, in the Speed list, select Fast.

Also in the Custom Animation task pane, click Add Effect, point to Motion Paths, and then click Left.

Also in the Custom Animation task pane, select the second animation effect (left motion path), and then under Modify: Left, in the Speed list, select Fast.

On the slide, right-click the motion path, and then click Reverse Path Direction. (Note: The green arrow will move to the left end of the motion path.)

Press and hold CTRL, and then select the first and second animation effects (faded zoom effect and left motion path) in the Custom Animation task pane. Click the arrow to the right of the second animation effect (left motion path), and then click Effect Options. In the Left dialog box, on the SmartArt Animation tab, in the Group graphic list, select One by one.

Also in the Custom Animation task pane, do the following:

Click the double arrow under the first animation effect (faded zoom effect) to expand the contents of the list of effects.

Click the double arrow under the second animation effect (left motion path) to expand the contents of the list of effects.  

Press and hold CTRL, and then in the Custom Animation task pane, select the first, second, third, and fourth animation effects (all four faded zoom effects). Under Modify: Faded Zoom, in the Start list, select After Previous.

Press and hold CTRL, and then in the Custom Animation task pane, select the fifth, sixth, seventh, and eighth animation effects (all four left motion paths). Under Modify: Left, in the Start list, select With Previous.

Also in the Custom Animation task pane, do the following to reorder the list of effects:

Drag the fifth animation effect (first left motion path) until it is second in the list of effects.

Drag the sixth animation effect (second left motion path) until it is fourth in the list of effects.

Drag the seventh animation effect (third left motion path) until it is sixth in the list of effects.





To reproduce the background effects on this slide, do the following:

Right-click the slide background, and then click Format Background. In the Format Background dialog box, click Fill in the left pane, select Gradient fill in the Fill pane, and then do the following:

In the Type list, select Radial.

In the Direction list, click From Center (third option from the left).

Under Gradient stops, click Add or Remove until two stops appear in the drop-down list.

Also under Gradient stops, customize the gradient stops as follows:

Select Stop 1 from the list, and then do the following:

In the Stop position box, enter 0%.

Click the button next to Color, and then under Theme Colors click Black, Text 1, Lighter 50% (second row, second option from the left).

Select Stop 2 from the list, and then do the following: 

In the Stop position box, enter 100%.

Click the button next to Color, and then under Theme Colors click Black, Text 1 (first row, second option from the left).
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Nutrition  Status Slide Q4 2023 - 2024.pptx
Achieved in Q4



Quarterly audit

Completed by new practitioner.

Friends and Family questionnaire revised to include feedback around meals etc



Policy and procedure



Training

E Learning implemented and staff in process of completing aim to have completed by Q1 2024-2025here has been a near miss on IPU which has led to a SIRMS report and action has been taken accordingly, it was regarding food allergies.

Planned for Q1

Training

Staff to have completed nutrition training

To explore more relevant training



Audit 

Continue

Risks & Issues

Training needs

Compliance with Hospice UK audit



Mitigating Actions

On going audit & action planning

Complete E-learning 

In the nutritional audit an “Allergen sheet IPU” has been added,  this is to take a snapshot of one whole week, it is to make sure the patient’s FULL name has been recorded on both the menu and beverages chart





RAG Rating: Green



Clinical Services: Nutrition Link Practitioner Group	

Quarterly Status Report

Group Members				Governance 	

Emma Thompson, Senior Staff Nurse (ET)		 Allison Welsh, Head of Clinical Services/Chair of CGG

Julie Brown, Staff Nurse (JB)			 Gillian MacArthur, Trustee/Chair of CGSC

Susan McAleer, Guest Services Manager (SM)	



Group Purpose:

To ensure that people have nutritional needs assessed;  have enough to eat and drink to meet their nutrition and hydration needs; receive the support they need to do so; people's preferences, religious and cultural backgrounds are taken into account when providing food and drink.

Clinical Services, Nutrition Link Practitioner Group, Status Slide

 V0.03, Link Practitioner, IPU, March 2024 2024



Quarter 2

Jul - Sept



Quarter 1

Apr - Jun



Quarter 3

Oct- Dec



Quarter 4

Jan - Mar





SmartArt custom animation effects: motion path and faded zoom

(Intermediate)





To reproduce the SmartArt effects on this page, do the following:

On the Home tab, in the Slides group, click Layout, and then click Blank. 

On the Insert tab, in the Illustrations group, click SmartArt. In the Choose a SmartArt Graphic dialog box, in the left pane, click Process. In the Process pane, click Basic Chevron Process (third row, first option from the left), and then click OK to insert the graphic into the slide.

To create a fourth chevron shape, select the chevron shape at the right end of the graphic, and then under SmartArt Tools, on the Design tab, in the Create Graphic group, click the arrow next to Add Shape, and select Add Shape After.

Select the graphic, and then click one of the arrows on the left border. In the Type your text here dialog box, enter text.

Select the graphic. Under SmartArt Tools, on the Design tab, in the SmartArt Styles group, do the following:

Click Change Colors, and then under Colorful click Colorful Range – Accent Colors 3 to 4  (third option from the left).

Click More, and then under 3-D, click Inset (first row, second option from the left).





To reproduce the animation effects on this slide, do the following:

On the Animations tab, in the Animations group, click Custom Animation.

On the slide, select the graphic. In the Custom Animation task pane, do the following:

Click Add Effect, point to Entrance, and then click More Effects. In the Add Entrance Effect dialog box, under Subtle, click Faded Zoom. 

Under Modify: Faded Zoom, in the Speed list, select Fast.

Also in the Custom Animation task pane, click Add Effect, point to Motion Paths, and then click Left.

Also in the Custom Animation task pane, select the second animation effect (left motion path), and then under Modify: Left, in the Speed list, select Fast.

On the slide, right-click the motion path, and then click Reverse Path Direction. (Note: The green arrow will move to the left end of the motion path.)

Press and hold CTRL, and then select the first and second animation effects (faded zoom effect and left motion path) in the Custom Animation task pane. Click the arrow to the right of the second animation effect (left motion path), and then click Effect Options. In the Left dialog box, on the SmartArt Animation tab, in the Group graphic list, select One by one.

Also in the Custom Animation task pane, do the following:

Click the double arrow under the first animation effect (faded zoom effect) to expand the contents of the list of effects.

Click the double arrow under the second animation effect (left motion path) to expand the contents of the list of effects.  

Press and hold CTRL, and then in the Custom Animation task pane, select the first, second, third, and fourth animation effects (all four faded zoom effects). Under Modify: Faded Zoom, in the Start list, select After Previous.

Press and hold CTRL, and then in the Custom Animation task pane, select the fifth, sixth, seventh, and eighth animation effects (all four left motion paths). Under Modify: Left, in the Start list, select With Previous.

Also in the Custom Animation task pane, do the following to reorder the list of effects:

Drag the fifth animation effect (first left motion path) until it is second in the list of effects.

Drag the sixth animation effect (second left motion path) until it is fourth in the list of effects.

Drag the seventh animation effect (third left motion path) until it is sixth in the list of effects.





To reproduce the background effects on this slide, do the following:

Right-click the slide background, and then click Format Background. In the Format Background dialog box, click Fill in the left pane, select Gradient fill in the Fill pane, and then do the following:

In the Type list, select Radial.

In the Direction list, click From Center (third option from the left).

Under Gradient stops, click Add or Remove until two stops appear in the drop-down list.

Also under Gradient stops, customize the gradient stops as follows:

Select Stop 1 from the list, and then do the following:

In the Stop position box, enter 0%.

Click the button next to Color, and then under Theme Colors click Black, Text 1, Lighter 50% (second row, second option from the left).

Select Stop 2 from the list, and then do the following: 

In the Stop position box, enter 100%.

Click the button next to Color, and then under Theme Colors click Black, Text 1 (first row, second option from the left).
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Safeguarding Status Slide Q4 2023 - 2024.pptx
Achieved in Q4

Training

MCA

IPU 93% (2 x staff members to complete and are booked onto face-to-face training)

Medical staff 60%

LWC 62% (3 x remaining staff members to complete 5th May 2024)

Audit

MCA/DoLs audit – no concerns



Other:

Raising Concerns Action Plan – completed.



Updates to Adult and Child S/G policies.



Developed Adult and Child S/G SOPs – including training actions.



Planned for Q1

Audit

Audit of DOLS/Safeguarding (JMc)



Other:

Set up regular Safeguarding Link Practitioner meetings (ALF)



Deliver S/G training session as part of induction (ALF)



Continue to report grade 3 and above pressure ulcers to safeguarding (JMC/ET)

Risks & Issues 

Volunteers completing Safeguarding training 

Board Level Training



Mitigating Actions



Chair of Clinical Governance Subcommittee to do Level 4.  Proposed Board do Level 2 Developing a patient safety culture



RAG Rating: Low





Clinical Services: Safeguarding Link Practitioner Group	

Quarterly Status Report



Group Members		Governance 	Allison Welsh, Head of Clinical Services/Chair of CGG

Allison Welsh, Head of Clinical Services 		Gillian McArthur, Trustee/Chair of CGSC 

Aislinn Le Fevre, Social Worker				

Julia McCabe, Service Manager IPU	                         

David McLoughlin, Service Manager, Day Services

Jenna Cannon, Admiral Nurse

Group Purpose:

To ensure people who use our services are protected from suffering any form of abuse or improper treatment while receiving care and treatment. Improper treatment includes discrimination or unlawful restraint, which includes inappropriate deprivation of liberty under the terms of the Mental Capacity Act (2005). 

Clinical Services, Safeguarding Link Practitioner Group, Status Slide, Mar 2024



Quarter 1

Apr – Jun



Quarter 2

Jul - Sept



Quarter 4

Jan - Mar



Quarter 3

Oct - Dec





SmartArt custom animation effects: motion path and faded zoom

(Intermediate)





To reproduce the SmartArt effects on this page, do the following:

On the Home tab, in the Slides group, click Layout, and then click Blank. 

On the Insert tab, in the Illustrations group, click SmartArt. In the Choose a SmartArt Graphic dialog box, in the left pane, click Process. In the Process pane, click Basic Chevron Process (third row, first option from the left), and then click OK to insert the graphic into the slide.

To create a fourth chevron shape, select the chevron shape at the right end of the graphic, and then under SmartArt Tools, on the Design tab, in the Create Graphic group, click the arrow next to Add Shape, and select Add Shape After.

Select the graphic, and then click one of the arrows on the left border. In the Type your text here dialog box, enter text.

Select the graphic. Under SmartArt Tools, on the Design tab, in the SmartArt Styles group, do the following:

Click Change Colors, and then under Colorful click Colorful Range – Accent Colors 3 to 4  (third option from the left).

Click More, and then under 3-D, click Inset (first row, second option from the left).





To reproduce the animation effects on this slide, do the following:

On the Animations tab, in the Animations group, click Custom Animation.

On the slide, select the graphic. In the Custom Animation task pane, do the following:

Click Add Effect, point to Entrance, and then click More Effects. In the Add Entrance Effect dialog box, under Subtle, click Faded Zoom. 

Under Modify: Faded Zoom, in the Speed list, select Fast.

Also in the Custom Animation task pane, click Add Effect, point to Motion Paths, and then click Left.

Also in the Custom Animation task pane, select the second animation effect (left motion path), and then under Modify: Left, in the Speed list, select Fast.

On the slide, right-click the motion path, and then click Reverse Path Direction. (Note: The green arrow will move to the left end of the motion path.)

Press and hold CTRL, and then select the first and second animation effects (faded zoom effect and left motion path) in the Custom Animation task pane. Click the arrow to the right of the second animation effect (left motion path), and then click Effect Options. In the Left dialog box, on the SmartArt Animation tab, in the Group graphic list, select One by one.

Also in the Custom Animation task pane, do the following:

Click the double arrow under the first animation effect (faded zoom effect) to expand the contents of the list of effects.

Click the double arrow under the second animation effect (left motion path) to expand the contents of the list of effects.  

Press and hold CTRL, and then in the Custom Animation task pane, select the first, second, third, and fourth animation effects (all four faded zoom effects). Under Modify: Faded Zoom, in the Start list, select After Previous.

Press and hold CTRL, and then in the Custom Animation task pane, select the fifth, sixth, seventh, and eighth animation effects (all four left motion paths). Under Modify: Left, in the Start list, select With Previous.

Also in the Custom Animation task pane, do the following to reorder the list of effects:

Drag the fifth animation effect (first left motion path) until it is second in the list of effects.

Drag the sixth animation effect (second left motion path) until it is fourth in the list of effects.

Drag the seventh animation effect (third left motion path) until it is sixth in the list of effects.





To reproduce the background effects on this slide, do the following:

Right-click the slide background, and then click Format Background. In the Format Background dialog box, click Fill in the left pane, select Gradient fill in the Fill pane, and then do the following:

In the Type list, select Radial.

In the Direction list, click From Center (third option from the left).

Under Gradient stops, click Add or Remove until two stops appear in the drop-down list.

Also under Gradient stops, customize the gradient stops as follows:

Select Stop 1 from the list, and then do the following:

In the Stop position box, enter 0%.

Click the button next to Color, and then under Theme Colors click Black, Text 1, Lighter 50% (second row, second option from the left).

Select Stop 2 from the list, and then do the following: 

In the Stop position box, enter 100%.

Click the button next to Color, and then under Theme Colors click Black, Text 1 (first row, second option from the left).
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Tissue Viability Status Slide Q4 2023 - 2024.pptx
Achieved in Q4



Policies and Procedures

N/A



Risk assessments

JM has started to look at Purpose-T risk assessment rather than waterlow score



Audits 

Completed.  ..\..\..\..\AUDITS\In-patient Unit Audits\2023-2024\Q4\Tissue Viablility



Training

Trying to obtain more TV training.

Planned for Q1

Audit 

Quarterly audit



Other

Devise moisture lesion policy and SOP

To look at alternative to water low score



Training

Community TVN to provide training on pressure ulcers, MASD and fungating wounds Aug and Sept 2024 all staff booked onto sessions





Risks & Issues

Complacency

Training – Protected time for RGN Training

Availability of specialised equipment 



Mitigating Actions

On going audit & action planning



RAG Rating: Low









Clinical Services: Tissue Viability Link Practitioner Group	

Quarterly Status Report

Group Members			Governance 	

Julia McCabe, Service Manager (JM)		Allison Welsh, Head of Clinical Services/Chair of CGG

Michelle Maguire, Staff Nurse (MM)		Gillian MacArthur, Trustee/Chair of CGSC

		



Group Purpose:

To maintain an overview of Tissue Viability within the hospice clinical areas, and to link this into Clinical Governance and risk management processes. It will ensure that Tissue Viability issues are appropriately managed within the hospice. The group aims to provide assurance to the Board that policy, processes and operational delivery of Tissue Viability results in positive patient outcomes

Clinical Services, Tissue Viability Link Practitioner Group, Status Slide V0.1

 Service Manager, IPU, Mar 2024



Quarter 3

Oct - Dec



Quarter 1

Apr - Jun



Quarter 4

Jan - Mar



Quarter 2

Jul - Sept





SmartArt custom animation effects: motion path and faded zoom

(Intermediate)





To reproduce the SmartArt effects on this page, do the following:

On the Home tab, in the Slides group, click Layout, and then click Blank. 

On the Insert tab, in the Illustrations group, click SmartArt. In the Choose a SmartArt Graphic dialog box, in the left pane, click Process. In the Process pane, click Basic Chevron Process (third row, first option from the left), and then click OK to insert the graphic into the slide.

To create a fourth chevron shape, select the chevron shape at the right end of the graphic, and then under SmartArt Tools, on the Design tab, in the Create Graphic group, click the arrow next to Add Shape, and select Add Shape After.

Select the graphic, and then click one of the arrows on the left border. In the Type your text here dialog box, enter text.

Select the graphic. Under SmartArt Tools, on the Design tab, in the SmartArt Styles group, do the following:

Click Change Colors, and then under Colorful click Colorful Range – Accent Colors 3 to 4  (third option from the left).

Click More, and then under 3-D, click Inset (first row, second option from the left).





To reproduce the animation effects on this slide, do the following:

On the Animations tab, in the Animations group, click Custom Animation.

On the slide, select the graphic. In the Custom Animation task pane, do the following:

Click Add Effect, point to Entrance, and then click More Effects. In the Add Entrance Effect dialog box, under Subtle, click Faded Zoom. 

Under Modify: Faded Zoom, in the Speed list, select Fast.

Also in the Custom Animation task pane, click Add Effect, point to Motion Paths, and then click Left.

Also in the Custom Animation task pane, select the second animation effect (left motion path), and then under Modify: Left, in the Speed list, select Fast.

On the slide, right-click the motion path, and then click Reverse Path Direction. (Note: The green arrow will move to the left end of the motion path.)

Press and hold CTRL, and then select the first and second animation effects (faded zoom effect and left motion path) in the Custom Animation task pane. Click the arrow to the right of the second animation effect (left motion path), and then click Effect Options. In the Left dialog box, on the SmartArt Animation tab, in the Group graphic list, select One by one.

Also in the Custom Animation task pane, do the following:

Click the double arrow under the first animation effect (faded zoom effect) to expand the contents of the list of effects.

Click the double arrow under the second animation effect (left motion path) to expand the contents of the list of effects.  

Press and hold CTRL, and then in the Custom Animation task pane, select the first, second, third, and fourth animation effects (all four faded zoom effects). Under Modify: Faded Zoom, in the Start list, select After Previous.

Press and hold CTRL, and then in the Custom Animation task pane, select the fifth, sixth, seventh, and eighth animation effects (all four left motion paths). Under Modify: Left, in the Start list, select With Previous.

Also in the Custom Animation task pane, do the following to reorder the list of effects:

Drag the fifth animation effect (first left motion path) until it is second in the list of effects.

Drag the sixth animation effect (second left motion path) until it is fourth in the list of effects.

Drag the seventh animation effect (third left motion path) until it is sixth in the list of effects.





To reproduce the background effects on this slide, do the following:

Right-click the slide background, and then click Format Background. In the Format Background dialog box, click Fill in the left pane, select Gradient fill in the Fill pane, and then do the following:

In the Type list, select Radial.

In the Direction list, click From Center (third option from the left).

Under Gradient stops, click Add or Remove until two stops appear in the drop-down list.

Also under Gradient stops, customize the gradient stops as follows:

Select Stop 1 from the list, and then do the following:

In the Stop position box, enter 0%.

Click the button next to Color, and then under Theme Colors click Black, Text 1, Lighter 50% (second row, second option from the left).

Select Stop 2 from the list, and then do the following: 

In the Stop position box, enter 100%.

Click the button next to Color, and then under Theme Colors click Black, Text 1 (first row, second option from the left).
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Venepuncture and IV status slide Q4.pptx
Achieved in Quarter 4

Policies and procedures



Audits IPU

Complete



LWC

VIP audit 100%



Training

Nursing staff have completed WASP and are deemed competent.



Other

Risk assessment in place for admissions of patients with Hickman/PICC lines

Planned for Quarter 1

Leaflets – n/a



Review of policies

JM to commence Hickman line policy/SOP



Training

Hickman line and PICC train the trainer training obtained and to take place Q1 with WASP competency framework (10th June 2024)



Disseminate Hickman line and PICC training and WASP framework to RGN’s



Audits: 

Continue to review audit tool



Risks & Issues



Staff competence re: midlines, PICC, Hickman line care



Mitigating Actions

Action plan in place re: education and competency assessment 



RAG Rating: Amber



















Clinical Services: Intra Venous Line Link Practitioner Group

Quarterly Status Report

Group Members				Governance 	

Julia McCabe, Service Manager/Chair 		Allison Welsh, Head of Clinical Services/Chair of CGG.

Lesley Shaw, Staff Nurse			Gillian MacArthur, Trustee/Chair of CGSC

Denise Crawford, Clinical Practice Development Nurse		

		

Group Purpose: To maintain an overview of Intra Venous Line within the Hospice’s clinical areas, and to link this into clinical governance and risk management processes. It will ensure that Intra Venous lines are appropriately managed within the hospice, to ensure the safety of patients and staff across the hospice. The group aims to provide assurance to the Board that policy, processes and operational delivery of infection prevention and control results in positive patient outcomes

Clinical Services, Intravenous Line Link Practitioner Group Status Slide V2, Service Manager, IPU, Mar 2024



Quarter 2

Jul - Sep



Quarter 3

Oct- Dec



Quarter 4

Jan - Mar



Quarter 1

Apr - Jun





SmartArt custom animation effects: motion path and faded zoom

(Intermediate)





To reproduce the SmartArt effects on this page, do the following:

On the Home tab, in the Slides group, click Layout, and then click Blank. 

On the Insert tab, in the Illustrations group, click SmartArt. In the Choose a SmartArt Graphic dialog box, in the left pane, click Process. In the Process pane, click Basic Chevron Process (third row, first option from the left), and then click OK to insert the graphic into the slide.

To create a fourth chevron shape, select the chevron shape at the right end of the graphic, and then under SmartArt Tools, on the Design tab, in the Create Graphic group, click the arrow next to Add Shape, and select Add Shape After.

Select the graphic, and then click one of the arrows on the left border. In the Type your text here dialog box, enter text.

Select the graphic. Under SmartArt Tools, on the Design tab, in the SmartArt Styles group, do the following:

Click Change Colors, and then under Colorful click Colorful Range – Accent Colors 3 to 4  (third option from the left).

Click More, and then under 3-D, click Inset (first row, second option from the left).





To reproduce the animation effects on this slide, do the following:

On the Animations tab, in the Animations group, click Custom Animation.

On the slide, select the graphic. In the Custom Animation task pane, do the following:

Click Add Effect, point to Entrance, and then click More Effects. In the Add Entrance Effect dialog box, under Subtle, click Faded Zoom. 

Under Modify: Faded Zoom, in the Speed list, select Fast.

Also in the Custom Animation task pane, click Add Effect, point to Motion Paths, and then click Left.

Also in the Custom Animation task pane, select the second animation effect (left motion path), and then under Modify: Left, in the Speed list, select Fast.

On the slide, right-click the motion path, and then click Reverse Path Direction. (Note: The green arrow will move to the left end of the motion path.)

Press and hold CTRL, and then select the first and second animation effects (faded zoom effect and left motion path) in the Custom Animation task pane. Click the arrow to the right of the second animation effect (left motion path), and then click Effect Options. In the Left dialog box, on the SmartArt Animation tab, in the Group graphic list, select One by one.

Also in the Custom Animation task pane, do the following:

Click the double arrow under the first animation effect (faded zoom effect) to expand the contents of the list of effects.

Click the double arrow under the second animation effect (left motion path) to expand the contents of the list of effects.  

Press and hold CTRL, and then in the Custom Animation task pane, select the first, second, third, and fourth animation effects (all four faded zoom effects). Under Modify: Faded Zoom, in the Start list, select After Previous.

Press and hold CTRL, and then in the Custom Animation task pane, select the fifth, sixth, seventh, and eighth animation effects (all four left motion paths). Under Modify: Left, in the Start list, select With Previous.

Also in the Custom Animation task pane, do the following to reorder the list of effects:

Drag the fifth animation effect (first left motion path) until it is second in the list of effects.

Drag the sixth animation effect (second left motion path) until it is fourth in the list of effects.

Drag the seventh animation effect (third left motion path) until it is sixth in the list of effects.





To reproduce the background effects on this slide, do the following:

Right-click the slide background, and then click Format Background. In the Format Background dialog box, click Fill in the left pane, select Gradient fill in the Fill pane, and then do the following:

In the Type list, select Radial.

In the Direction list, click From Center (third option from the left).

Under Gradient stops, click Add or Remove until two stops appear in the drop-down list.

Also under Gradient stops, customize the gradient stops as follows:

Select Stop 1 from the list, and then do the following:

In the Stop position box, enter 0%.

Click the button next to Color, and then under Theme Colors click Black, Text 1, Lighter 50% (second row, second option from the left).

Select Stop 2 from the list, and then do the following: 

In the Stop position box, enter 100%.

Click the button next to Color, and then under Theme Colors click Black, Text 1 (first row, second option from the left).
















image16.emf
IPU Friends and  Family Test- 2023 2024 new to use.xlsx


IPU Friends and Family Test- 2023 2024 new to use.xlsx
Question 1





		1. Are you



				2023/2024

				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Male		5		56		5		50		4		36		5		250

		Female		4		44		5		50		7		64		8		400

		Total		9		100		10		100		11		100		2		650



Comments: 
Please write the comment and the date that the comment was received. 

1. Are you 



Apr - Jun	Male	Female	55.555555555555557	44.444444444444443	Jul - Sept	Male	Female	50	50	Oct - Dec	Male	Female	36.363636363636367	63.63636363636364	Jan - Mar	Male	Female	250	400	

%











Question 2

		Q2. What age are you? 



				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		0-15				0				0				0				0

		16-24				0				0				0				0

		25-34				0				0				0				0

		35-44				0				0		1		14				0

		45-54		1		11				0				0		1		8

		55-64		3		33		2		20		1		14		3		23

		65-74		3		33		2		20		4		57		1		8

		75-84		2		22		5		50				0		7		54

		85+				0		1		10		1		14		1		8

		Total		9		100		10		100		7		100		13		100



		Comments:





Q2. What age are you?  



Apr - Jun	0-15	16-24	25-34	35-44	45-54	55-64	65-74	75-84	85+	0	0	0	0	11.111111111111111	33.333333333333329	33.333333333333329	22.222222222222221	0	Jul - Sept	0-15	16-24	25-34	35-44	45-54	55-64	65-74	75-84	85+	0	0	0	0	0	20	20	50	10	Oct - Dec	0-15	16-24	25-34	35-44	45-54	55-64	65-74	75-84	85+	0	0	0	14.285714285714286	0	14.285714285714286	57.142857142857146	0	14.285714285714286	Jan - Mar	0-15	16-24	25-34	35-44	45-54	55-64	65-74	75-84	85+	0	0	0	0	7.6923076923076925	23.076923076923077	7.6923076923076925	53.846153846153847	7.6923076923076925	

%











Question 3a

		Q3. Do you consider yourself to have a disability? 



				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Yes		5		56		5		50		3		43		2		15

		No		2		22		5		50		4		57		9		69

		No Answer		2		22				0				0		2		15

		Total		9		100		10		100		7		100		13		100

		Comments:

		21/07/23 - mobility issues due to myeloma damage to spine and pelvis 

		24/07/23 - diabetic 

		14/9/23 Chronic Myloid Leukaemia, bone marrow necrosis

		14/9/23 - Lung cancer

		11/12/23 - Associated cancers

		31/12/23 - arthritis in back and hips 

		22/1/24  - Damaged heart gallbladder cancer

		07/03/2024 - Multiple Sclerosis



 Q3. Do you consider yourself to have a disability?



Apr - Jun	Yes	No	No Answer	55.555555555555557	22.222222222222221	22.222222222222221	Jul - Sept	Yes	No	No Answer	50	50	0	Oct - Dec	Yes	No	No Answer	42.857142857142861	57.142857142857146	0	Jan - Mar	Yes	No	No Answer	15.384615384615385	69.230769230769226	15.384615384615385	

%











Question 3b

		Q3b. Which of the following best describes your ethnic background? 

				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		British		9		100		10		100		7		100		11		85

		Irish				0				0				0				0

		Other - white background				0				0				0		1		8

		Caribbean				0				0				0				0

		African								0				0				0

		Other black background								ERROR:#DIV/0!				0		1		8

		Indian								ERROR:#DIV/0!				0				0

		Pakistani								ERROR:#DIV/0!				0				0

		Bangladeshi								ERROR:#DIV/0!				0				0

		Chinese								ERROR:#DIV/0!				0				0

		Other Asian background								ERROR:#DIV/0!				0				0

		White and Black Caribbean								ERROR:#DIV/0!				0				0

		White and Black African								ERROR:#DIV/0!				0				0

		White and Asian								ERROR:#DIV/0!				0				0

		Other Mixed Background								ERROR:#DIV/0!				0				0

		Anything else								ERROR:#DIV/0!				0				0

		I would rather not say								ERROR:#DIV/0!				0				0

		Total		9		100		10		100		7		100		13		100





Q3b. Which of the following best describes your ethnic background?



Apr - Jun	British	Irish	Other - white background	Caribbean	African	Other black background	Indian	Pakistani	Bangladeshi	Chinese	Other Asian background	White and Black Caribbean	White and Black African	White and Asian	Other Mixed Background	Anything else	I would rather not say	100	0	0	0	Jul - Sept	British	Irish	Other - white background	Caribbean	African	Other black background	Indian	Pakistani	Bangladeshi	Chinese	Other Asian background	White and Black Caribbean	White and Black African	White and Asian	Other Mixed Background	Anything else	I would rather not say	100	0	0	0	0	0	0	0	0	0	0	0	0	0	0	0	0	Oct - Dec	British	Irish	Other - white background	Caribbean	African	Other black background	Indian	Pakistani	Bangladeshi	Chinese	Other Asian background	White and Black Caribbean	White and Black African	White and Asian	Other Mixed Background	Anything else	I would rather not say	100	0	0	0	0	0	0	0	0	0	0	0	0	0	0	0	0	Jan - Mar	British	Irish	Other - white background	Caribbean	African	Other black background	Indian	Pakistani	Bangladeshi	Chinese	Other Asian background	White and Black Caribbean	White and Black African	White and Asian	Other Mixed Background	Anything else	I would rather not say	84.615384615384613	0	7.6923076923076925	0	0	7.6923076923076925	0	0	0	0	0	0	0	0	0	0	0	

%











Question 3c

		Q3c. Are you?

				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		The patient		2		22		5		50		4		57		3		23

		A relative or carer		1		11		2		20		1		14		1		8

		the patient and relative or carer				0		2		20				0				0

		No Answer		6		67		1		10		2		29		9		69

		Total		9		100		10		100		7		100		13		100







Q3c. Are you? 



Apr - Jun	The patient	A relative or carer	the patient and relative or carer	No Answer	22.222222222222221	11.111111111111111	0	66.666666666666657	Jul - Sept	The patient	A relative or carer	the patient and relative or carer	No Answer	50	20	20	10	Oct - Dec	The patient	A relative or carer	the patient and relative or carer	No Answer	57.142857142857146	14.285714285714286	0	28.571428571428573	Jan - Mar	The patient	A relative or carer	the patient and relative or carer	No Answer	23.076923076923077	7.6923076923076925	0	69.230769230769226	

%











Question 3d

		4. Please indicate which hospice service was accessed? 



				2022/2023

				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Inpatient Unit		9		75		9		90		7		100		13		100

		Living Well Centre		2		17				0				0				0

		Complementary Therapy		2		17				0				0				0

		Family Support Team		1		8				0				0				0

		Outpatients		1		8		1		10				0				0

		Other (Please specify) 				0				0				0				0

		No answer								0				0				0

		Total		12		125		10		100		7		100		13		100



4. Please indicate which hospice service was accessed? 



Apr - Jun	Inpatient Unit	Living Well Centre	Complementary Therapy	Family Support Team	Outpatients	Other (Please specify) 	No answer	75	16.666666666666668	16.666666666666668	8.3333333333333339	8.3333333333333339	0	Jul - sept	Inpatient Unit	Living Well Centre	Complementary Therapy	Family Support Team	Outpatients	Other (Please specify) 	No answer	90	0	0	0	10	0	0	Oct - Dec	Inpatient Unit	Living Well Centre	Complementary Therapy	Family Support Team	Outpatients	Other (Please specify) 	No answer	100	0	0	0	0	0	0	Jan - Mar	Inpatient Unit	Living Well Centre	Complementary Therapy	Family Support Team	Outpatients	Other (Please specify) 	No answer	100	0	0	0	0	0	0	

%











Question 4

		Q4 We would like you to think about your recent experience of our service.  How likely are you to recommend the care received at St Cuthbert's Hospice to friends and family if they needed similar care or treatment?  

				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Extremely likely		9		82		8		100		6		86		10		77

		Likely		1		9				0				0		3		23

		Neither likely or unlikely				0				0				0				0

		Unlikely				0				0				0				0

		Extremely Unlikely				0				0								0

		Don't Know				0				0

		No answer		1		9.0909090909				0		1

		Total		11		100		8		100		7		86		13		100





		COMMENTS		17/05/23 - Facilities are immaculate, perfect with the stunning views and gardens. The staff are outstanding, efficient, caring, friendly, and approachable. The relaxed atmosphere and flexibility around the patients needs i.e.: visiting pets and the quality of the food and care make this the best possible place to be at an extremely difficult time. The support and attention to detail make the unbearable bearable

				17/05/23 - Most caring, first class, generous, none complaining 24/7 round the clock excellent care. Staff are amazing, friendly, will help you all they can. 

				18/05/23 - excellent staff and services

				18/05/23 - it is a caring, happy environment

				18/05/23 - care is exceptional. All staff empathetic and dedicated. Facilities are superb. Food varied and delicious.

				21/07/23- caring and friendly staff. Go above and beyond in all aspects of care - nothing is too much trouble.

				21/07/23 - I feel safe and well cared for

				21/07/23 - the medical care and support are second to one. 

				21/07/23 - excellent acre for my wife 

				24/07/23- care taken

				24/07/23 - good acre of my husband

				14/9/23 - The service I received from the staff at St Cuthberts has been excellent in every way.  They have dealt with my ongoing pain problem and understoos how I was feeling, everyone there works in a very professional manner and are a credit to the hospice.

				14/9/23 - The care from the Doctors and Nurses

				11/12/23 - From the moment we arrived everyone has ben so kind, caring and supportive. The care my wife has received has been incredible and she is always treated with the utmost respect, her dignity is 

				always preserved. Everyone has helped to make this heartbreaking time in our lives just that little more bearable.

				31/12/23 care is outstanding

				31/12/23 - staff absolutley brilliant, nothing is a bother

				Fabulous staff and care is second to none.

				18/01/2024 - Amazing staff and surroundings: will go out of their way to do anything.

				18/01/2024 - Impossible to express how grateful I am for the care my mum is receiving.  Every member of staff and volunteer has shown genuine empathy, and all have gone above and beyond to treat her with kindness and repect.  Understanding and support is always extended to family members.  I fell like my mum has been provided with comfort and dignity as her cancer progresses.  Thank you.

				22/01/2024 - It has a very homely feel to it, is set with beautiful gardens and all the staff are friendly and caring.

				02/02/2024 - The hospice has a very calm and caring atmosphere and I feel that is the atmosphere that someone should spend their final days.

				07/03/2024 - The patient care is always the top priority and carers, nurses everyone trys to help and care to the highest standard.

				07/03/2024 - Professional service in beautiful surrounding area 

				07/03/2024 - My husband, myself and our family have been treated with dignity and respect throughout, care is exceptional.

				07/03/2024 - Immediate trust and confidence in the nurses / doctors and all the other staff.  Everything is first class care.

				07/03/2024 - The hospice has a very calm and caring atmosphere and I feel that is the atmosphere that someone should spend their final days in.



Q4 We would like you to think about your recent experience of our service.  How likely are you to recommend the care received at St Cuthbert's Hospice to friends and family if they needed similar care or treatment?  



Apr - Jun	Extremely likely	Likely	Neither likely or unlikely	Unlikely	Extremely Unlikely	Don't Know	81.818181818181827	9.0909090909090917	0	0	0	0	Jul - Sept	Extremely likely	Likely	Neither likely or unlikely	Unlikely	Extremely Unlikely	Don't Know	100	0	0	0	0	0	Oct - Dec	Extremely likely	Likely	Neither likely or unlikely	Unlikely	Extremely Unlikely	Don't Know	85.714285714285722	0	0	0	Jan - Mar	Extremely likely	Likely	Neither likely or unlikely	Unlikely	Extremely Unlikely	Don't Know	76.92307692307692	23.076923076923077	0	0	0	

%











Question 5

		Q5. During your time in our care did you receive an information pack/leaflet? 



				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Yes		4		44		7		64		4		57		5		38

		No		0		0		1		9		1		14		2		15

		Can't Remember		3		33		2		18		2		29		5		38

		No Answer		2		22		1		9				0		1		8

		Total		9		100		11		100		7		100		13		100









Q5. During your time in our care did you receive an information pack/leaflet?



Apr - Jun	Yes	No	Can't Remember	No Answer	44.444444444444443	0	33.333333333333329	22.222222222222221	Jul - Sept	Yes	No	Can't Remember	No Answer	63.63636363636364	9.0909090909090917	18.181818181818183	9.0909090909090917	Oct - Dec	Yes	No	Can't Remember	No Answer	57.142857142857146	14.285714285714286	28.571428571428573	0	Jan - Mar	Yes	No	Can't Remember	No Answer	38.46153846153846	15.384615384615385	38.46153846153846	7.6923076923076925	

%











Question 6

		Q6. If you received an information/leaflet was it easy to understand? (if you ticked No please indicate why)? 



				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Yes		4		44		7		70		4		100		4		40

		No 				0				0				0		0		0

		Can't remember		1		11.1111111111		2		20				2		1		10

		No answer		4		44.4444444444		1		10				0		5		50

		Total		9		100		10		100		4		102		10		100





Q6. If you received an information/leaflet was it easy to understand? (if you ticked No please indicate why)?  



Apr - Jun	Yes	No 	Can't remember	No answer	44.444444444444443	0	11.111111111111111	44.444444444444443	Jul - Sept	Yes	No 	Can't remember	No answer	70	0	20	10	Oct - Dec	Yes	No 	Can't remember	No answer	100	0	2	0	Jan - Mar	Yes	No 	Can't remember	No answer	40	0	10	50	

%











Question 7a

		Q7. Was the information pack / leaflet helpful? (If you ticked No please indicate why) 



				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Yes		5		45		7		70		4		100		5		71

		No				0				0				0				0

		Can't remember		2		18		1		10				2		1		14

		No answer		4		36		2		20				0		1		14

		Total		11		100		10		100		4		102		7		100









Q7. Was the information pack / leaflet helpful? (If you ticked No please indicate why)



Apr - Jun	Yes	No	Can't remember	No answer	45.45454545454546	0	18.181818181818183	36.363636363636367	Jul - Sept	Yes	No	Can't remember	No answer	70	0	10	20	Oct - Dec	Yes	No	Can't remember	No answer	100	0	2	0	Jan - Mar	Yes	No	Can't remember	No answer	71.428571428571431	0	14.285714285714286	14.285714285714286	

%











Question 8

		Q8. Was there anything in the information pack/leaflet that you found to be incorrect? (If you ticked Yes please indicate why)

				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Yes				0				0				0				0

		No		3		33		7		70		3		50		4		40

		Can't Remember		2		22		1		10		3		50		1		10

		No Answer		4		44		2		20				0		5		50

		Total		9		100		10		100		6		100		10		100





Q8. Was there anything in the information pack/leaflet that you found to be incorrect? (If you ticked Yes please indicate why) 



Apr - Jun	Yes	No	Can't Remember	No Answer	0	33.333333333333329	22.222222222222221	44.444444444444443	Jul - Sept	Yes	No	Can't Remember	No Answer	0	70	10	20	Oct - Dec	Yes	No	Can't Remember	No Answer	0	50	50	0	Jan - Mar	Yes	No	Can't Remember	No Answer	0	40	10	50	

%











Question 9

		Q9. When you accessed our services did the staff introduce themselves to you/your loved one?  

				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Always		9		100		7		70		6		86		10		77

		Most of the time		0		0		3		30		1		14		3		23

		Some of the time				0				0				0				0

		Never				0				0				0				0

		No Answer				0				0				0				0

		Total		9		100		10		100		7		100		13		100









Q9. When you accessed our services did the staff introduce themselves to you/your loved one?



Apr - Jun	Always	Most of the time	Some of the time	Never	No Answer	100	0	0	0	0	Jul - Sept	Always	Most of the time	Some of the time	Never	No Answer	70	30	0	0	0	Oct - Dec	Always	Most of the time	Some of the time	Never	No Answer	85.714285714285722	14.285714285714286	0	0	0	Jan - Mar	Always	Most of the time	Some of the time	Never	No Answer	76.92307692307692	23.076923076923077	0	0	0	

%











Question 10

		Q10. Did you have confidence in and trust the staff who were caring for you/your loved one? 



				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Always		9		100		10		91		7		100		10		77

		Most of the time		0		0		1		9				0		3		23

		Some of the time				0				0				0				0

		Never				0				0				0				0

		No answer				0				0				0

		Total		9		100		11		100		7		100		13		100

		Comments:





Q10. Did you have confidence in and trust the staff who were caring for you/your loved one? 



Apr - Jun	Always	Most of the time	Some of the time	Never	100	0	0	0	Jul - Sept	Always	Most of the time	Some of the time	Never	90.909090909090921	9.0909090909090917	0	0	Oct - Dec	Always	Most of the time	Some of the time	Never	100	0	0	0	Jan - Mar	Always	Most of the time	Some of the time	Never	76.92307692307692	23.076923076923077	0	0	

%











Question 11

		Q11. Did you have the opportunity to ask questions when you / your loved one wanted to? 

				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Always		9		100		9		90		6		86		11		92

		Most of the time		0		0		1		10		1		14		1		8

		Some of the time				0				0				0				0

		Never				0				0				0				0

		No answer				0				0				0		1

		Total		9		100		10		100		7		100		12		100

		Comments:



Q11. Did you have the opportunity to ask questions when you / your loved one wanted to?  



Apr - Jun	Always	Most of the time	Some of the time	Never	100	0	0	0	Jul - Sept	Always	Most of the time	Some of the time	Never	90	10	0	0	Oct - Dec	Always	Most of the time	Some of the time	Never	85.714285714285722	14.285714285714286	0	0	Jan - Mar	Always	Most of the time	Some of the time	Never	91.666666666666671	8.3333333333333339	0	0	

%











Question 12

		Q12. Did our staff treat you/your loved one with respect and dignity? 

				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Always		9		100		9		90		7		100		12		92

		Most of the time		0		0		1		10				0		1		8

		Some of the time				0				0				0				0

		Never				0				0				0				0

		No answer				0				0				0				0

		Total		9		100		10		100		7		100		13		100





Q12. Did our staff treat you/your loved one with respect and dignity?  



Apr - Jun	Always	Most of the time	Some of the time	Never	No answer	100	0	0	0	0	Jul - Sept	Always	Most of the time	Some of the time	Never	No answer	90	10	0	0	0	Oct - Dec	Always	Most of the time	Some of the time	Never	No answer	100	0	0	0	0	Jan - Mar	Always	Most of the time	Some of the time	Never	No answer	92.307692307692307	7.6923076923076925	0	0	0	

%











Question 13

		Q13. Were you/your loved one treated with respect and courtesy? 

				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Always		9		100		9		90		7		100		11		85

		Most of the time		0		0		1		10				0		2		15

		Some of the time				0				0				0				0

		Never				0				0				0				0

		No answer				0				0				0				0

		Total		9		100		10		100		7		100		13		100



Q13. Were you/your loved one treated with respect and courtesy? 



Apr - Jun	Always	Most of the time	Some of the time	Never	No answer	100	0	0	0	0	Jul - Sept	Always	Most of the time	Some of the time	Never	No answer	90	10	0	0	0	Oct - Dec	Always	Most of the time	Some of the time	Never	No answer	100	0	0	0	0	Jan - Mar	Always	Most of the time	Some of the time	Never	No answer	84.615384615384613	15.384615384615385	0	0	0	

%











Question 14a

		Q14. Was you/ your loved ones privacy respected during discussions with our staff? 



				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Always		9		100		9		90		7		100		12		92

		Most of the time		0		0		1		10				0		1		8

		Some of the time				0				0				0				0

		Never				0				0				0				0

		No answer				0				0				0				0

		Total		9		100		10		100		7		100		13		100









		Do you have any further comments you would like to make?

		17/05/23 - could not be treated better 

		17/05123 - dignity was respected at all times

		18/05/23 - all excellent 

		18/05/23 - the staff were very careful to respect my privacy at all times, were friendly and empathetic and attentive 

		21/07/23 - I felt very apprehensive about comin into the hpsoice but felt relxed within half an hour of arriving. 

		21/07/23 - all staff were supportive and caring in every way 

		14/9/23 - Everyone was ver approachable.  Making sure we knew their names and they explained fully about the treatment I was receieving 

		11/12/23 - We have always felt that we have be listened to and any questions we have had have been answered honestly and sensitively.

		31/12/23 - Little piece of heaven on earth

		02/02/2024 - Everyone has been very kind to me.

		07/03/2024 - Exceptional care throughout our stay.

		07/03/2024 - I have every trust in your staff and have found them all to be very kind even in challenging circumstances

		07/03/2024 - Everyone has been very kind to me



Q14. Was you/ your loved ones privacy respected during discussions with our staff? 



Apr - Jun	Always	Most of the time	Some of the time	Never	No answer	100	0	0	0	0	Jul - Sept	Always	Most of the time	Some of the time	Never	No answer	90	10	0	0	0	Oct - Dec	Always	Most of the time	Some of the time	Never	No answer	100	0	0	0	0	Jan - Mar	Always	Most of the time	Some of the time	Never	No answer	92.307692307692307	7.6923076923076925	0	0	0	

%











Question 14b

		Q14b. Were our staff well informed about you or your loved ones condition or treatment? 



				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Always		9		100		9		90		6		86		8		62

		Most of the time		0		0		1		10				0		3		23

		Some of the time				0				0		1		14				0

		Never				0				0				0				0

		No answer				0				0				0		2		15

		Total 		9		100		10		100		7		100		13		100



Q14b. Were our staff well informed about you or your loved ones condition or treatment? 



Apr - Jun	Always	Most of the time	Some of the time	Never	No answer	100	0	0	0	0	Jul - Sept	Always	Most of the time	Some of the time	Never	No answer	90	10	0	0	0	Oct - Dec	Always	Most of the time	Some of the time	Never	No answer	85.714285714285722	0	14.285714285714286	0	0	Jan - Mar	Always	Most of the time	Some of the time	Never	No answer	61.53846153846154	23.076923076923077	0	0	15.384615384615385	

%











Question 14c

		Q14c. Did our staff respond promptly when you or your loved one needed/called for assistance



				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Always		9		100		9		90		6		86		8		73

		Most of the time				0		1		10		1		14		3		27

		Some of the time				0				0				0				0

		Never				0				0				0				0

		No answer				0				0				0

		Total		9		100		10		100		7		100		11		100

		Comments:



Q14c. Did our staff respond promptly when you or your loved one needed/called for assistance? 



Apr - Jun	Always	Most of the time	Some of the time	Never	100	0	0	0	Jul - Sept	Always	Most of the time	Some of the time	Never	90	10	0	0	Oct - Dec	Always	Most of the time	Some of the time	Never	85.714285714285722	14.285714285714286	0	0	Jan - Mar	Always	Most of the time	Some of the time	Never	72.727272727272734	27.272727272727273	0	0	

%











Question 14d

		Q14d. Did our staff try to meet yours or your loved ones individual needs and preferences?



				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Always		9		100		9		90		5		100		12		100

		Most of the time		0		0		1		10				0				0

		Some of the time				0				0				0				0

		Never				0				0				0				0

		No answer				0				0				0		1

		Total		9		100		10		100		5		100		12		100



Q14d. Did our staff try to meet yours or your loved ones individual needs and preferences? 



Apr - Jun	Always	Most of the time	Some of the time	Never	100	0	0	0	Jul - Sept	Always	Most of the time	Some of the time	Never	90	10	0	0	Oct - Dec	Always	Most of the time	Some of the time	Never	100	0	0	0	Jan - Mar	Always	Most of the time	Some of the time	Never	100	0	0	0	

%











Question 15

		Q15. Did our staff offer explanations about the care and treatment provided to you or your loved one?



				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Always		9		100		9		180.0		7		100		12		100

		Most of the time		0		0		1		20.0				0				0

		Some of the time				0				0				0				0

		Never				0				0				0				0

		No answer				0				0.0						1

		Total		9		100		5		200		7		100		12		100









		Do you have any further comments you would like to make?

		17/05/2023 listen to you and advise you. Looked after me so well. I am hopefully going home soon.

		18/05/23 - lovely place

		18/05/23 - I was often surprised by how well informed the staff were about my condition. I was also impressed by the staffs co-ordination of others involved in my care. 

		21/07/23 - st cuthberts is a lovely calm and peaceful place 

		14/9/23 - The care given at the hospice is first class

		26/01/2024 - Does not know what staff were told about me so therefore cant comment on knowledge		 



Q15. Did our staff offer explanations about the care and treatment provided to you or your loved one? 



Apr - Jun	Always	Most of the time	Some of the time	Never	100	0	0	0	Jul - Sept	Always	Most of the time	Some of the time	Never	180	20	0	0	Oct - Dec	Always	Most of the time	Some of the time	Never	100	0	0	0	Jan - Mar	Always	Most of the time	Some of the time	Never	100	0	0	0	

%











Question 16

		Q16. The cleanliness of our premises? 

				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Poor				0				0				0				0

		Adequate				0				0				0				0

		Good 		1		11.1111111111				0				0		2		14

		Very Good		1		11.1111111111		3		30				0		2		14

		Excellent		7		78		6		60		7		100		10		71

		n/a				0				0				0				0

		No Answer						1		10				0

		Total		9		100		10		100		7		100		14		100

		Comments:







Q16. The cleanliness of our premises?   



Apr - Jun	Poor	Adequate	Good 	Very Good	Excellent	n/a	No Answer	0	0	11.111111111111111	11.111111111111111	77.777777777777771	0	Jul - Sept	Poor	Adequate	Good 	Very Good	Excellent	n/a	No Answer	0	0	0	30	60	0	10	Oct - Dec	Poor	Adequate	Good 	Very Good	Excellent	n/a	No Answer	0	0	0	0	100	0	0	Jan - Mar	Poor	Adequate	Good 	Very Good	Excellent	n/a	No Answer	0	0	14.285714285714286	14.285714285714286	71.428571428571431	0	

%











Question 17

		Q17. The general environment/surroundings? 

				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Poor				0				0				0				0

		Adequate				0				0				0				0

		Good 		1		11.1111111111				0				0		2		15

		Very Good		1		11.1111111111				0				0		2		15

		Excellent		7		78		9		90		7		100		9		69

		n/a				0		1		10				0				0

		Total		9		100		10		100		7		100		13		100

		Comments:





Q17. The general environment/surroundings?  



Apr - Jun	Poor	Adequate	Good 	Very Good	Excellent	n/a	0	0	11.111111111111111	11.111111111111111	77.777777777777771	0	Jul - Sept	Poor	Adequate	Good 	Very Good	Excellent	n/a	0	0	0	0	90	10	Oct - Dec	Poor	Adequate	Good 	Very Good	Excellent	n/a	0	0	0	0	100	0	Jan - Mar	Poor	Adequate	Good 	Very Good	Excellent	n/a	0	0	15.384615384615385	15.384615384615385	69.230769230769226	0	

%











Question 18

		Q18. The facilities in patients rooms to support patient care

				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Poor				0				0				0				0

		Adequate				0				0				0				0

		Good 		1		11.1111111111				0				0				0

		Very Good		3		33.3333333333		1		10				0		6		46

		Excellent		5		56		8		80		6		86		7		54

		n/a				0		1		10		1		14				0

		Total		9		100		10		100		7		100		13		100

		Comments:































Q18. The facilities in patients rooms to support patient care 



Apr - Jun	Poor	Adequate	Good 	Very Good	Excellent	n/a	0	0	11.111111111111111	33.333333333333329	55.555555555555557	0	Jul - Sept	Poor	Adequate	Good 	Very Good	Excellent	n/a	0	0	0	10	80	10	Oct - Dec	Poor	Adequate	Good 	Very Good	Excellent	n/a	0	0	0	0	85.714285714285722	14.285714285714286	Jan - Mar	Poor	Adequate	Good 	Very Good	Excellent	n/a	0	0	0	46.153846153846153	53.846153846153847	0	

%











Question 19

		Q19. The quality of our catering

				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Poor				0				0				0				0

		Adequate				0				0				1				0

		Good 		0		0				0				0		2		15

		Very Good		2		22.2222222222		1		10		3		43		3		23

		Excellent		7		78		8		80		4		57		5		38

		n/a				0		1		10				0		3		23

		Total		9		100		10		100		7		101		13		100













Q19. The quality of our catering  



Apr - Jun	Poor	Adequate	Good 	Very Good	Excellent	n/a	0	0	0	22.222222222222221	77.777777777777771	0	Jul - Sept	Poor	Adequate	Good 	Very Good	Excellent	n/a	0	0	0	10	80	10	Oct - Dec	Poor	Adequate	Good 	Very Good	Excellent	n/a	0	1	0	42.857142857142861	57.142857142857146	0	Jan - Mar	Poor	Adequate	Good 	Very Good	Excellent	n/a	0	0	15.384615384615385	23.076923076923077	38.46153846153846	23.076923076923077	

%











Question 20

		Q20. Access to food and drink outside of set meal times

				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Poor				0				0				0				0

		Adequate				0				0		1		14				0

		Good 		1		11.1111111111		1		0				0		3		25

		Very Good		2		22.2222222222		1		10		3		43				0

		Excellent		6		67		7		70		3		43		4		33

		n/a				0		1		10				0		5		42

		Total		9		100		10		90		7		100		12		100







Q20. Access to food and drink outside of set meal times  



Apr - Jun	Poor	Adequate	Good 	Very Good	Excellent	n/a	0	0	11.111111111111111	22.222222222222221	66.666666666666657	0	Jul - Sept	Poor	Adequate	Good 	Very Good	Excellent	n/a	0	0	0	10	70	10	Oct - Dec	Poor	Adequate	Good 	Very Good	Excellent	n/a	0	14.285714285714286	0	42.857142857142861	42.857142857142861	0	Jan - Mar	Poor	Adequate	Good 	Very Good	Excellent	n/a	0	0	25	0	33.333333333333336	41.666666666666671	

%











Question 21

		Q21. Were our facilities able to support you staying overnight if needed?

				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Poor				0				0				0				0

		Adequate				0				0				0				0

		Good 		1		11.1111111111		1		11				0				0

		Very Good		1		11.1111111111				0		2		29		1		8

		Excellent		4		44		7		78		3		43		5		38

		no answer		3		33		1		11		2		29		7		54

		Total		9		100		9		100		7		100		13		100





		Do you have any further comments you would like to make?

		excellent nothings a trouble

		17/05/23 - lovely and clean great views, wildlife. Chefs very helpful; with individual diet needs.

		18/05/23 - only negative was lack of Wi-Fi. During the time of the patients stay the hospice was undergoing work for new internet, phone and computer services. 

		18/05/23 - st Cuthberts provides a beautiful, tranquil environment for seriously ill patients, thanks are due to the volunteered who keep the gardens so well. To be able to view wildlife from my bedroom is delightful. I was always able to access food and drinks when I wanted it which was great. an individual tv was an extra facility which made life more pleasurable. 

		21/07/23 - I have stayed overnight on a couple of occasions at my request and felt fully supported 

		11/12/23 - You all go above and beyond to ensure that we are able to be here and as sad as it is fo us to

		be on this journey we feel very fortunate to be in such a wonderful place.

		11/12/23 - I cannot see why anyone would want to make a complaint about the hospice. The staff are 

		dedicated to patients and the care they give is beyond belief, staff are underpaid in my opinion.

		Very happy here and with the care provided

		22/01/2024 - Everything was of excellent standard.

		26/01/2024 -Didn't eat very much during stay so difficult to comment		 

		26/01/2024 - I feel people have done what they can for me more that a couple of staff have given 110%

		07/03/2024 - Felt more than welcome and overwhelmed by the care and attention given to me and my family .

		07/03/2024 - Food always well presented and always gave a personal touch.

		07/03/2024 - No experience of food quality etc, but have no doubts that it is excellent



Q21. Were our facilities able to support you staying overnight if needed?



Apr - Jun	Poor	Adequate	Good 	Very Good	Excellent	no answer	0	0	11.111111111111111	11.111111111111111	44.444444444444443	33.333333333333329	Jul - Sept	Poor	Adequate	Good 	Very Good	Excellent	no answer	0	0	11.111111111111111	0	77.777777777777771	11.111111111111111	Oct - Dec	Poor	Adequate	Good 	Very Good	Excellent	no answer	0	0	0	28.571428571428573	42.857142857142861	28.571428571428573	Jan - Mar	Poor	Adequate	Good 	Very Good	Excellent	no answer	0	0	0	7.6923076923076925	38.46153846153846	53.846153846153847	

%











Question 22

		Q22. Is the environment conductive to eating?



				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Yes				ERROR:#DIV/0!				ERROR:#DIV/0!				ERROR:#DIV/0!		10		77

		No				ERROR:#DIV/0!				ERROR:#DIV/0!				ERROR:#DIV/0!				0

		Can't Remember				ERROR:#DIV/0!				ERROR:#DIV/0!				ERROR:#DIV/0!				0

		No Answer				ERROR:#DIV/0!				ERROR:#DIV/0!				ERROR:#DIV/0!		3		23

		Total		0		ERROR:#DIV/0!		0		ERROR:#DIV/0!		0		ERROR:#DIV/0!		13		100









Q22. Is the environment conductive to eating?



Yes	No	Can't Remember	No Answer	0	0	0	0	Yes	No	Can't Remember	No Answer	0	0	0	0	Yes	No	Can't Remember	No Answer	0	0	0	0	Yes	No	Can't Remember	No Answer	76.92307692307692	0	0	23.076923076923077	

%











Question 23

		Q23. If you required assistance with diet/fluid intake, was this offered?



				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Yes				ERROR:#DIV/0!				ERROR:#DIV/0!				ERROR:#DIV/0!		8		67

		No				ERROR:#DIV/0!				ERROR:#DIV/0!				ERROR:#DIV/0!				0

		Can't Remember				ERROR:#DIV/0!				ERROR:#DIV/0!				ERROR:#DIV/0!				0

		No Answer				ERROR:#DIV/0!				ERROR:#DIV/0!				ERROR:#DIV/0!		4		33

		Total		0		ERROR:#DIV/0!		0		ERROR:#DIV/0!		0		ERROR:#DIV/0!		12		100









Q23. If you required assistance with diet/fluid intake, was this offered?



Yes	No	Can't Remember	No Answer	0	0	0	0	Yes	No	Can't Remember	No Answer	0	0	0	0	Yes	No	Can't Remember	No Answer	0	0	0	0	Yes	No	Can't Remember	No Answer	66.666666666666671	0	0	33.333333333333336	

%











Question 24

		Q24: Was there sufficient information regarding access to food and drink?



				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Yes				ERROR:#DIV/0!				ERROR:#DIV/0!				ERROR:#DIV/0!		9		82

		No				ERROR:#DIV/0!				ERROR:#DIV/0!				ERROR:#DIV/0!				0

		Can't Remember				ERROR:#DIV/0!				ERROR:#DIV/0!				ERROR:#DIV/0!				0

		No Answer				ERROR:#DIV/0!				ERROR:#DIV/0!				ERROR:#DIV/0!		2		18

		Total		0		ERROR:#DIV/0!		0		ERROR:#DIV/0!		0		ERROR:#DIV/0!		11		100









Q24: Was there sufficient information regarding access to food and drink?



Yes	No	Can't Remember	No Answer	0	0	0	0	Yes	No	Can't Remember	No Answer	0	0	0	0	Yes	No	Can't Remember	No Answer	0	0	0	0	Yes	No	Can't Remember	No Answer	81.818181818181827	0	0	18.181818181818183	

%











Question 25

		Q25. Were you satisfied that the food and drink provided met your needs and preferences?



				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Yes				ERROR:#DIV/0!				ERROR:#DIV/0!				ERROR:#DIV/0!		8		67

		No				ERROR:#DIV/0!				ERROR:#DIV/0!				ERROR:#DIV/0!				0

		Can't Remember				ERROR:#DIV/0!				ERROR:#DIV/0!				ERROR:#DIV/0!				0

		No Answer				ERROR:#DIV/0!				ERROR:#DIV/0!				ERROR:#DIV/0!		4		33

		Total		0		ERROR:#DIV/0!		0		ERROR:#DIV/0!		0		ERROR:#DIV/0!		12		100









Q25. Were you satisfied that the food and drink provided met your needs and preferences?



Yes	No	Can't Remember	No Answer	0	0	0	0	Yes	No	Can't Remember	No Answer	0	0	0	0	Yes	No	Can't Remember	No Answer	0	0	0	0	Yes	No	Can't Remember	No Answer	66.666666666666671	0	0	33.333333333333336	

%











Question 26

		Q26. Was the food presented in an appealing way?



				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Yes				ERROR:#DIV/0!				ERROR:#DIV/0!				ERROR:#DIV/0!		9		75

		No				ERROR:#DIV/0!				ERROR:#DIV/0!				ERROR:#DIV/0!				0

		Can't Remember				ERROR:#DIV/0!				ERROR:#DIV/0!				ERROR:#DIV/0!				0

		No Answer				ERROR:#DIV/0!				ERROR:#DIV/0!				ERROR:#DIV/0!		3		25

		Total		0		ERROR:#DIV/0!		0		ERROR:#DIV/0!		0		ERROR:#DIV/0!		12		100









Q26. Was the food presented in an appealing way?



Yes	No	Can't Remember	No Answer	0	0	0	0	Yes	No	Can't Remember	No Answer	0	0	0	0	Yes	No	Can't Remember	No Answer	0	0	0	0	Yes	No	Can't Remember	No Answer	75	0	0	25	

%











Question 27

		Q27. Are you aware of what to do if you wanted to make a complaint?



				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Yes		6		67		8		80		5		71		7		54

		No		1		11				0		2		29		3		23

		No answer		2		22		2		20				0		3		23

		Total		9		78		10		100		7		100		13		100





Q27. Are you aware of what to do if you wanted to make a complaint?



Apr - Jun	Yes	No	No answer	66.666666666666657	11.111111111111111	22.222222222222221	Jul - Sept	Yes	No	No answer	80	0	20	Oct - Dec	Yes	No	No answer	71.428571428571431	28.571428571428573	0	Jan - Mar	Yes	No	No answer	53.846153846153847	23.076923076923077	23.076923076923077	

%
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Question 1





		1. Are you



				2023/2024

				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Male		6		43		3		75		4		50		5		71

		Female		8		57		1		25		4		50		2		29

		Total		14		100		4		100		8		100		7		100

		April - June

		Comments:







		July - Aug

		Comments:

		Oct- Dec

		Comments:

		Jan - March

		Comments:







































1. Are you 



Apr - Jun	Male	Female	42.857142857142861	57.142857142857146	Jul - Sept	Male	Female	75	25	Oct - Dec	Male	Female	50	50	Jan - Mar	Male	Female	71.428571428571431	28.571428571428573	

%











Question 2

		Q2. What age are you? 

				2023/2024

				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		0-15				0				0				0				0

		16-24				0				0				0				0

		25-34				0				0				0				0

		35-44				0				0				0				0

		45-54				0				0				0				0

		55-64		2		14				0				0				0

		65-74		2		14				0		1		13		1		14

		75-84		5		36		3		75		6		75		2		29

		85+		5		36		1		25		1		13		4		57

		Total		14		100		4		100		8		100		7		100

		April - June 

		Comments:







Q2. What age are you?  



Apr - Jun	0-15	16-24	25-34	35-44	45-54	55-64	65-74	75-84	85+	0	0	0	0	0	14.285714285714286	14.285714285714286	35.714285714285715	35.714285714285715	Jul - Sept	0-15	16-24	25-34	35-44	45-54	55-64	65-74	75-84	85+	0	0	0	0	0	0	0	75	25	Oct - Dec	0-15	16-24	25-34	35-44	45-54	55-64	65-74	75-84	85+	0	0	0	0	0	0	12.5	75	12.5	Jan - Mar	0-15	16-24	25-34	35-44	45-54	55-64	65-74	75-84	85+	0	0	0	0	0	0	14.285714285714286	28.571428571428573	57.142857142857146	

%











Question 3a

		Q3. Do you consider yourself to have a disability? 



				2023/2024

				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Yes		8		57		2		50		6		75		5		71

		No		5		36		2		50		2		25		2		29

		No Answer		1		7				0				0				0

		Total		14		100		4		100		8		100		7		100

		Apr - June

		Comments:



		Number 1		No Comment

		Number 2		No Comment

		Number 3		No Comment

		Number 4		Dementia

		Number 5		No Comment

		Number 6		No Comment

		Number 7		No Comment

		Number 8		Alzheimer's.

		Number 9		No Comment

		Number 10		No Comment

		Number 11		No Comment

		Number 12		Neurological Condition

		Number 13		No Comment

		Number 14		Parkinson's



		July - Aug

		Comments:

		Number 1		Alzheimer's, Mobility, Poor Sight

		Number 2		Vascular Dementia 

		Number 3		No Comment

		Number 4		Wheelchair user

		Number 5

		Number 6

		Number 7

		Number 8

		Number 9

		Number 10





		Oct- Dec

		Comments:

		Number 1

		Number 2

		Number 3

		Number 4

		Number 5		Not Really

		Number 6





		Jan - Mar

		Comments:

		Number 1 		No Comment

		Number 2		No Comment

		Number 3		Alzheimers

		Number 4		Mixed Dementia

		Number 5		Asthma

		Number 6		No Comment

		Number 7		MSA

		Number 8		Alzheimers



 Q3. Do you consider yourself to have a disability?



Apr - Jun	Yes	No	No Answer	57.142857142857146	35.714285714285715	7.1428571428571432	Jul - Sept	Yes	No	No Answer	50	50	0	Oct - Dec	Yes	No	No Answer	75	25	0	Jan - Mar	Yes	No	No Answer	71.428571428571431	28.571428571428573	0	

%











Question 3b

		Q3b. Which of the following best describes your ethnic background? 										2023/2024

				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		British		14		100		4		100		7		88		7		88

		Irish				0				0				0				0

		Other - white background				0				0		1		13				0

		Caribbean				0				0				0				0

		African				ERROR:#DIV/0!

		Other black background				ERROR:#DIV/0!

		Indian				ERROR:#DIV/0!										1

		Pakistani				ERROR:#DIV/0!

		Bangladeshi				ERROR:#DIV/0!

		Chinese				ERROR:#DIV/0!

		Other Asian background				ERROR:#DIV/0!

		White and Black Caribbean				ERROR:#DIV/0!

		White and Black African				ERROR:#DIV/0!

		White and Asian				ERROR:#DIV/0!

		Other Mixed Background				ERROR:#DIV/0!

		Anything else				ERROR:#DIV/0!

		I would rather not say				ERROR:#DIV/0!

		Total		14		100		4		100		8		100		8		88





Q3b. Which of the following best describes your ethnic background?



Apr - Jun	British	Irish	Other - white background	Caribbean	African	Other black background	Indian	Pakistani	Bangladeshi	Chinese	Other Asian background	White and Black Caribbean	White and Black African	White and Asian	Other Mixed Background	Anything else	I would rather not say	100	0	0	0	0	0	0	0	0	0	0	0	0	0	0	0	0	Jul - Sept	British	Irish	Other - white background	Caribbean	African	Other black background	Indian	Pakistani	Bangladeshi	Chinese	Other Asian background	White and Black Caribbean	White and Black African	White and Asian	Other Mixed Background	Anything else	I would rather not say	100	0	0	0	Oct - Dec	British	Irish	Other - white background	Caribbean	African	Other black background	Indian	Pakistani	Bangladeshi	Chinese	Other Asian background	White and Black Caribbean	White and Black African	White and Asian	Other Mixed Background	Anything else	I would rather not say	87.5	0	12.5	0	Jan - Mar	British	Irish	Other - white background	Caribbean	African	Other black background	Indian	Pakistani	Bangladeshi	Chinese	Other Asian background	White and Black Caribbean	White and Black African	White and Asian	Other Mixed Background	Anything else	I would rather not say	87.5	0	0	0	

%











Question 3c

		Q3c. Are you?

				2023/2024

				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		The patient		4		29		2		50		3		38		3		38

		A relative or carer		1		7				0		2		25		2		25

		the patient and relative or carer		1		7				0				0				0

		No Answer		8		57		2		50		3		38		3		38

		Total		14		100		4		100		8		100		8		100

		April - June











		July - Sept



		Oct - Dec













		Jan - March







Q3c. Are you? 



Apr - Jun	The patient	A relative or carer	the patient and relative or carer	No Answer	28.571428571428573	7.1428571428571432	7.1428571428571432	57.142857142857146	Jul - Sept	The patient	A relative or carer	the patient and relative or carer	No Answer	50	0	0	50	Oct - Dec	The patient	A relative or carer	the patient and relative or carer	No Answer	37.5	25	0	37.5	Jan - Mar	The patient	A relative or carer	the patient and relative or carer	No Answer	37.5	25	0	37.5	

%











Question 3d

		4. Please indicate which hospice service was accessed? 



				2023/2024

				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Inpatient Unit				0				0				0				0

		Living Well Centre		13		93		3		75		8		100		7		88

		Complementary Therapy		1		7				0				0		1		13

		Family Support Team				0				0				0				0

		Outpatients				0				0				0				0

		Other (Please specify) 				0				0				0				0

		No answer						1		25				0				0

		Total		14		100		4		100		8		100		8		100

		April - June

		Number 8		CST Maintenance

		Number 14		Family Support Service as well as the LWC.



		Jan - March

		No 1		Family Support Service as well as the LWC

		No2		Family Support Service as well as the LWC



4. Please indicate which hospice service was accessed? 



Apr - Jun	Inpatient Unit	Living Well Centre	Complementary Therapy	Family Support Team	Outpatients	Other (Please specify) 	No answer	0	92.857142857142861	7.1428571428571432	0	0	0	Jul - sept	Inpatient Unit	Living Well Centre	Complementary Therapy	Family Support Team	Outpatients	Other (Please specify) 	No answer	0	75	0	0	0	0	25	Oct - Dec	Inpatient Unit	Living Well Centre	Complementary Therapy	Family Support Team	Outpatients	Other (Please specify) 	No answer	0	100	0	0	0	0	0	Jan - Mar	Inpatient Unit	Living Well Centre	Complementary Therapy	Family Support Team	Outpatients	Other (Please specify) 	No answer	0	87.5	12.5	0	0	0	0	

%











Question 4

		Q4 We would like you to think about your recent experience of our service.  How likely are you to recommend the care received at St Cuthbert's Hospice to friends and family if they needed similar care or treatment?  

		2023/2024		April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Extremely likely		11		79		3		75		8		100		8		100

		Likely		3		21				0				0				0

		Neither likely or unlikely				0				0				0				0

		Unlikely				0				0				0				0

		Extremely Unlikely				0				0				ERROR:#DIV/0!				0

		Don't Know				0				0				ERROR:#DIV/0!				ERROR:#DIV/0!

		No answer				0		1		25				ERROR:#DIV/0!				ERROR:#DIV/0!

		Total		14		100		4		100		8		ERROR:#DIV/0!		8		ERROR:#DIV/0!







		Thinking about your response to this question, what is the main reason why you feel this way?

		April to June

		Number 1		Great way to have time for yourself and meet with friends for a few hours.

		Number 2		Social Reasons.

		Number 3		It's a lovely service makes my day better.

		Number 4		The people are lovely, friendly, helpful, and reassuring.

		Number 5		Very Professional and caring environment.  Felt very welcome and put at ease by all members of staff.

		Number 6		Helpful staff, who cared for me.  Really enjoyed the group.

		Number 7		No Comments.

		Number 8		Friendly and helpful staff + Volunteers

		Number 9		No Comments.

		Number 10		No Comments.

		Number 11		Informative Very helpful

		Number 12		I enjoyed meeting people

		Number 13		Pleasant atmosphere

		Number 14		Caring and Supportive.



		July to Sept

		Number 1		No Comments

		Number 2		No Comments

		Number 3		No Comments

		Number 4		No Comments











		Oct - Dec 

		Number 1		Enjoy the company

		Number 2		I found it helpful to be able tot alk to staff

		Number 3		No comment

		Number 4		No comment

		Number 5		No comment

		Number 6		Changed both out Lives

		Number 7 		A good centre to come to.

		Number 8		The care and attenion the staff give to people.

		Jan - March



		1		No Comment

		2		Mixing with Friendly People

		3		No Comment

		4		The lovely, calming friendly atmsphere

		5		Everything done fine.

		6		Staff have been brilliant and I feel more motivated

		7		No Comment

		8		The service has helped me communicate in a social setting with other people who have similar disabilities. You have provided excellect friendly suppor every week.



Q4 We would like you to think about your recent experience of our service.  How likely are you to recommend the care received at St Cuthbert's Hospice to friends and family if they needed similar care or treatment? 



Apr - Jun	Extremely likely	Likely	Neither likely or unlikely	Unlikely	Extremely Unlikely	Don't Know	78.571428571428569	21.428571428571431	0	0	0	0	Jul - Sept	Extremely likely	Likely	Neither likely or unlikely	Unlikely	Extremely Unlikely	Don't Know	75	0	0	0	0	0	Oct - Dec	Extremely likely	Likely	Neither likely or unlikely	Unlikely	Extremely Unlikely	Don't Know	100	0	0	0	0	0	Jan - Mar	Extremely likely	Likely	Neither likely or unlikely	Unlikely	Extremely Unlikely	Don't Know	100	0	0	0	0	0	

%











Question 5

		Q5. During your time in our care did you receive an information pack/leaflet? 

				2023/2024

				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Yes		10		71		2		50		1		13		7		88

		No				0		1		25		2		25				0

		Can't Remember		4		29				ERROR:#DIV/0!		4		50		1		13

		No Answer				0		1		25		1		13				0

		Total		14		100		4		ERROR:#DIV/0!		8		100		8		100

		April - June





		July - Sept















		Oct - Dec 





















Q5. During your time in our care did you receive an information pack/leaflet?



Apr - Jun	Yes	No	Can't Remember	No Answer	71.428571428571431	0	28.571428571428573	0	Jul - Sept	Yes	No	Can't Remember	No Answer	50	25	0	25	Oct - Dec	Yes	No	Can't Remember	No Answer	12.5	25	50	12.5	Jan - Mar	Yes	No	Can't Remember	No Answer	87.5	0	12.5	0	

%











Question 6

		Q6. If you received an information/leaflet was it easy to understand? (if you ticked No please indicate why)? 

				2023/2024

				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Yes		10		63		2		50		1		13		5		63

		No 		1		6		1		25		1		13				0

		Can't remember		4		25				0		1		13		3		38

		No answer		1		ERROR:#DIV/0!		1		25		5		63				0

		Total		16		ERROR:#DIV/0!		4		100		8		100		8		100



		April - June





		July - Sept



		Oct - Dec

























Q6. If you received an information/leaflet was it easy to understand? (if you ticked No please indicate why)?



Apr - Jun	Yes	No 	Can't remember	No answer	62.5	6.25	25	0	Jul - Sept	Yes	No 	Can't remember	No answer	50	25	0	25	Oct - Dec	Yes	No 	Can't remember	No answer	12.5	12.5	12.5	62.5	Jan - Mar	Yes	No 	Can't remember	No answer	62.5	0	37.5	0	

%











Question 7

		Q7. Was the information pack / leaflet helpful? (If you ticked No please indicate why) 

				2023/2024

				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Yes		8		57		3		75		1		13		4		50

		No				0				0		1		13				0

		Can't remember		4		29		1		25		1		13		3		38

		No answer		2		14				0		5		63		1		13

		Total		14		100		4		100		8		100		8		100

		April - June











		July - Sept



		Oct - Dec 

















Q7. Was the information pack / leaflet helpful? (If you ticked No please indicate why)



Apr - Jun	Yes	No	Can't remember	No answer	57.142857142857146	0	28.571428571428573	14.285714285714286	Jul - Sept	Yes	No	Can't remember	No answer	75	0	25	0	Oct - Dec	Yes	No	Can't remember	No answer	12.5	12.5	12.5	62.5	Jan - Mar	Yes	No	Can't remember	No answer	50	0	37.5	12.5	

%











Question 8

		Q8. Was there anything in the information pack/leaflet that you found to be incorrect? (If you ticked Yes please indicate why)

				2023/2024

				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Yes		3		21		1		25				0		2		25

		No		4		29				ERROR:#DIV/0!		2		25		3		38

		Can't Remember		5		36		2		50		1		13		3		38

		No Answer		2		14		1		25		5		63				0

		Total		14		100		4		ERROR:#DIV/0!		8		100		8		100



		Jan - Mar

		1		Everything was correct





























Q8. Was there anything in the information pack/leaflet that you found to be incorrect? (If you ticked Yes please indicate why)



Apr - Jun	Yes	No	Can't Remember	No Answer	21.428571428571431	28.571428571428573	35.714285714285715	14.285714285714286	Jul - Sept	Yes	No	Can't Remember	No Answer	25	0	50	25	Oct - Dec	Yes	No	Can't Remember	No Answer	0	25	12.5	62.5	Jan - Mar	Yes	No	Can't Remember	No Answer	25	37.5	37.5	0	

%











Question 9

		Q9. When you accessed our services did the staff introduce themselves to you/your loved one?  																2023/2024

				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Always		14		100		3		75		7		88		7		88

		Most of the time				0				0		1		13				0

		Some of the time				0				0				0				0

		Never				0				0				0				0

		No Answer				0		1		25				ERROR:#DIV/0!		1		13

		Total		14		100		4		100		8		100		8		100









Q9. When you accessed our services did the staff introduce themselves to you/your loved one?



Apr - Jun	Always	Most of the time	Some of the time	Never	No Answer	100	0	0	0	0	Jul - Sept	Always	Most of the time	Some of the time	Never	No Answer	75	0	0	0	25	Oct - Dec	Always	Most of the time	Some of the time	Never	No Answer	87.5	12.5	0	0	0	Jan - Mar	Always	Most of the time	Some of the time	Never	No Answer	87.5	0	0	0	12.5	

%











Question 10

		Q10. Did you have confidence in and trust the staff who were caring for you/your loved one? 														2023/2024



				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Always		14		100		3		75		8		100		7		100

		Most of the time				0				0				0				0

		Some of the time				0				0				0				0

		Never				0				0				0				0

		No answer				0		1		25				0		1		ERROR:#DIV/0!

		Total		14		100		4		100		8		100		7		100

		Comments:





Q10. Did you have confidence in and trust the staff who were caring for you/your loved one?



Apr - Jun	Always	Most of the time	Some of the time	Never	100	0	0	0	Jul - Sept	Always	Most of the time	Some of the time	Never	75	0	0	0	Oct - Dec	Always	Most of the time	Some of the time	Never	100	0	0	0	Jan - Mar	Always	Most of the time	Some of the time	Never	100	0	0	0	

%











Question 11

		Q11. Did you have the opportunity to ask questions when you / your loved one wanted to? 														2023/2024

				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Always		14		100		3		5		7		88		7		88

		Most of the time				0				0		1		13				0

		Some of the time				0				0				0				0

		Never				0				0				0				0

		No answer				0		1		25				0		1		ERROR:#DIV/0!

		Total		14		100		4		30		8		100		8		88

		Comments:



Q11. Did you have the opportunity to ask questions when you / your loved one wanted to?



Apr - Jun	Always	Most of the time	Some of the time	Never	100	0	0	0	Jul - Sept	Always	Most of the time	Some of the time	Never	5	0	0	0	Oct - Dec	Always	Most of the time	Some of the time	Never	87.5	12.5	0	0	Jan - Mar	Always	Most of the time	Some of the time	Never	87.5	0	0	0	

%











Question 12

		Q12. Did our staff treat you/your loved one with respect and dignity? 

				2023/2024

				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Always		14		100		3		75		8		100		7		88

		Most of the time				0				0				0				0

		Some of the time				0				0				0				0

		Never				0				0				0				0

		No answer				0		1		ERROR:#DIV/0!				0		1		13

		Total		14		100		4		ERROR:#DIV/0!		8		100		8		100





Q12. Did our staff treat you/your loved one with respect and dignity?



Apr - Jun	Always	Most of the time	Some of the time	Never	No answer	100	0	0	0	0	Jul - Sept	Always	Most of the time	Some of the time	Never	No answer	75	0	0	0	0	Oct - Dec	Always	Most of the time	Some of the time	Never	No answer	100	0	0	0	0	Jan - Mar	Always	Most of the time	Some of the time	Never	No answer	87.5	0	0	0	12.5	

%











Question 13

		Q13. Were you/your loved one treated with respect and courtesy? 

				2023/2024

				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Always		14		100		3		75		8		100		7		88

		Most of the time				0				0				0				0

		Some of the time				0				0				0				0

		Never				0				0				0				0

		No answer				0		1		25				0		1		13

		Total		14		100		4		100		8		100		8		100



Q13. Were you/your loved one treated with respect and courtesy?



Apr - Jun	Always	Most of the time	Some of the time	Never	No answer	100	0	0	0	0	Jul - Sept	Always	Most of the time	Some of the time	Never	No answer	75	0	0	0	25	Oct - Dec	Always	Most of the time	Some of the time	Never	No answer	100	0	0	0	0	Jan - Mar	Always	Most of the time	Some of the time	Never	No answer	87.5	0	0	0	12.5	

%











Question 14a

		Q14. Was you/ your loved ones privacy respected during discussions with our staff? 

				2023/2024

				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Always		14		100		3		75		8		100		7		88

		Most of the time				0				0				0				0

		Some of the time				0				0				0				0

		Never				0				0				0				0

		No answer				0		1		25				0		1		13

		Total		14		100		4		100		8		100		8		100









		Do you have any further comments you would like to make?

		April - June

		Number 1		No Comment.

		Number 2		No Comment.

		Number 3		No Comment.

		Number 4		No Comment.

		Number 5		No Comment.

		Number 6		No Comment.

		  Number 7 		No Comment.

		 Number 8 		No Comment.

		Number 9		No Comment.

		  Number 10 		No Comment.

		  Number 11		No Comment.

		  Number 12		No Comment.

		  Number 13		No Comment.

		  Number 14		No Comment.

		July - Sept

		Number 1		No Comment.

		Number 2		The Staff are Friendly, Patient and Understanding 

		Number 3		No Comment.













		Oct - Dec

		Number 1		Staff are very supportive and approachable to the carer

		Number 2		I found my weekly visits helpful





		Jan - Mar

		1		No Comment.

		2		No Comment.

		3		No Comment.

		4		No Comment.

		5		Good Service.

		6		Everyone is always very professional helpful.

		7		No Comment.

		8		No Comment.





Q14. Was you/ your loved ones privacy respected during discussions with our staff? 



Apr - Jun	Always	Most of the time	Some of the time	Never	No answer	100	0	0	0	0	Jul - Sept	Always	Most of the time	Some of the time	Never	No answer	75	0	0	0	25	Oct - Dec	Always	Most of the time	Some of the time	Never	No answer	100	0	0	0	0	Jan - Mar	Always	Most of the time	Some of the time	Never	No answer	87.5	0	0	0	12.5	

%











Question 14b

		Q14b. Were our staff well informed about you or your loved ones condition or treatment? 

				2023/2024

				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Always		9		64		3		75		6		75		6		75

		Most of the time		5		36				0		2		25		1		13

		Some of the time				0				0				0				0

		Never				0				0				0				0

		No answer				0		1		25				0		1		13

		Total 		14		100		4		100		8		100		8		100



Q14b. Were our staff well informed about you or your loved ones condition or treatment?  



Apr - Jun	Always	Most of the time	Some of the time	Never	No answer	64.285714285714292	35.714285714285715	0	0	0	Jul - Sept	Always	Most of the time	Some of the time	Never	No answer	75	0	0	0	25	Oct - Dec	Always	Most of the time	Some of the time	Never	No answer	75	25	0	0	0	Jan - Mar	Always	Most of the time	Some of the time	Never	No answer	75	12.5	0	0	12.5	

%











Question 14c

		Q14c. Did our staff respond promptly when you or your loved one needed/called for assistance

				2023/2024

				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Always		12		86		3		75		7		88		7		100

		Most of the time				0				0				0				0

		Some of the time				0				0				0				0

		Never				0				0				0				0

		No answer		2		14		1		25		1		13		1		ERROR:#DIV/0!

		Total		14		100		4		100		8		100		7		100

		Comments:



Q14c. Did our staff respond promptly when you or your loved one needed/called for assistance? 



Apr - Jun	Always	Most of the time	Some of the time	Never	85.714285714285722	0	0	0	Jul - Sept	Always	Most of the time	Some of the time	Never	75	0	0	0	Oct - Dec	Always	Most of the time	Some of the time	Never	87.5	0	0	0	Jan - Mar	Always	Most of the time	Some of the time	Never	100	0	0	0	

%











Question 14d

		Q14d. Did our staff try to meet yours or your loved ones individual needs and preferences?

				2023/2024

				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Always		14		100		3		75		7		88		7		100

		Most of the time				0				0		1		13				0

		Some of the time				0				0				0				0

		Never				0				0				0				0

		No answer				0		1		25				0		1

		Total		14		100		4		100		8		100		7		100



Q14d. Did our staff try to meet yours or your loved ones individual needs and preferences?



Apr - Jun	Always	Most of the time	Some of the time	Never	100	0	0	0	Jul - Sept	Always	Most of the time	Some of the time	Never	75	0	0	0	Oct - Dec	Always	Most of the time	Some of the time	Never	87.5	12.5	0	0	Jan - Mar	Always	Most of the time	Some of the time	Never	100	0	0	0	

%











Question 15

		Q15. Did our staff offer explanations about the care and treatment provided to you or your loved one?

				2023/2024

				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Always		14		100		1		25.0		6		75		7		88

		Most of the time				0				0.0		1		13				0

		Some of the time				0				0				0				0

		Never				0				0				0				0

		No answer				0		3		75.0		1		13		1		ERROR:#DIV/0!

		Total		14		100		4		100		8		100		8		88









		Do you have any further comments you would like to make?

		April - June



		No 1		No Comment

		No 2		No Comment

		No 3		No Comment

		No 4		No Comment

		No 5		No Comment

		No 6		No Comment

		No 7		No Comment

		No 8		No Comment

		No 9		No Comment

		No 10		No Comment

		No 11		Very trustworthy

		No 12		No Comment

		No 13		No Comment



		July - Sept

		No 1		No Comment

		No 2		No Comment

		No 3		No Comment

		No 4		No Comment



		Oct - Nov

		Number 1		No comment

		Number 2		I am sorry it will be my last session







		Jan - March

		1		No Comment

		2		No Comment

		3		No Comment

		4		No Comment

		5		Everyone very nice

		6		No Comment

		7		No Comment

		8		No Comment







Q15. Did our staff offer explanations about the care and treatment provided to you or your loved one? 



Apr - Jun	Always	Most of the time	Some of the time	Never	100	0	0	0	Jul - Sept	Always	Most of the time	Some of the time	Never	25	0	0	0	Oct - Dec	Always	Most of the time	Some of the time	Never	75	12.5	0	0	Jan - Mar	Always	Most of the time	Some of the time	Never	87.5	0	0	0	

%











Question 16

		Q16. The cleanliness of our premises? 

				2023/2024

				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Poor				0				0				0				0

		Adequate				0				0				0				0

		Good 		3		21.4285714286				0				0		1		13

		Very Good		2		14.2857142857		1		25				0		2		25

		Excellent		9		64		3		75		8		100		5		63

		n/a				0				0				0				0

		No Answer				ERROR:#DIV/0!				0				0				ERROR:#DIV/0!

		Total		14		ERROR:#DIV/0!		4		100		8		100		8		ERROR:#DIV/0!

		Comments:







Q16. The cleanliness of our premises?  



Apr - Jun	Poor	Adequate	Good 	Very Good	Excellent	n/a	No Answer	0	0	21.428571428571431	14.285714285714286	64.285714285714292	0	0	Jul - Sept	Poor	Adequate	Good 	Very Good	Excellent	n/a	No Answer	0	0	0	25	75	0	0	Oct - Dec	Poor	Adequate	Good 	Very Good	Excellent	n/a	No Answer	0	0	0	0	100	0	0	Jan - Mar	Poor	Adequate	Good 	Very Good	Excellent	n/a	No Answer	0	0	12.5	25	62.5	0	0	

%











Question 17

		Q17. The general environment/surroundings? 

				2023/2024

				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Poor				0				0				0				0

		Adequate				0				0				0				0

		Good 		3		21.4285714286				0				0		3		38

		Very Good		2		14.2857142857		2		50				0		3		38

		Excellent		9		64		2		50		8		100		2		25

		n/a				0				0				0				0

		Total		14		100		4		100		8		100		8		100

		Comments:





Q17. The general environment/surroundings?  



Apr - Jun	Poor	Adequate	Good 	Very Good	Excellent	n/a	0	0	21.428571428571431	14.285714285714286	64.285714285714292	0	Jul - Sept	Poor	Adequate	Good 	Very Good	Excellent	n/a	0	0	0	50	50	0	Oct - Dec	Poor	Adequate	Good 	Very Good	Excellent	n/a	0	0	0	0	100	0	Jan - Mar	Poor	Adequate	Good 	Very Good	Excellent	n/a	0	0	37.5	37.5	25	0	

%











Question 18

		Q18. The facilities in patients rooms to support patient care

				2023/2024

				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Poor				0				0				0				0

		Adequate				0				0				0				0

		Good 		3		21.4285714286		1		25				0				0

		Very Good				0		1		25				0		3		38

		Excellent		5		36				0		4		50		3		38

		n/a		6		43		2		50		4		50		2		25

		Total		14		100		4		100		8		100		8		100

		Comments:































Q18. The facilities in patients rooms to support patient care



Apr - Jun	Poor	Adequate	Good 	Very Good	Excellent	n/a	0	0	21.428571428571431	0	35.714285714285715	42.857142857142861	Jul - Sept	Poor	Adequate	Good 	Very Good	Excellent	n/a	0	0	25	25	0	50	Oct - Dec	Poor	Adequate	Good 	Very Good	Excellent	n/a	0	0	0	0	50	50	Jan - Mar	Poor	Adequate	Good 	Very Good	Excellent	n/a	0	0	0	37.5	37.5	25	

%











Question 19

		Q19. The quality of our catering

				2023/2024

				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Poor				0				0				0				0

		Adequate				0				0				0				0

		Good 		1		7.1428571429		1		25				0				0

		Very Good		1		7.1428571429		1		25		1		13		3		38

		Excellent		7		50		1		25		7		88		3		38

		n/a		5		36		1		25				0		2		25

		Total		14		100		4		100		8		100		8		100













Q19. The quality of our catering  



Apr - Jun	Poor	Adequate	Good 	Very Good	Excellent	n/a	0	0	7.1428571428571432	7.1428571428571432	50	35.714285714285715	Jul - Sept	Poor	Adequate	Good 	Very Good	Excellent	n/a	0	0	25	25	25	25	Oct - Dec	Poor	Adequate	Good 	Very Good	Excellent	n/a	0	0	0	12.5	87.5	0	Jan - Mar	Poor	Adequate	Good 	Very Good	Excellent	n/a	0	0	0	37.5	37.5	25	

%











Question 20

		Q20. Access to food and drink outside of set meal times

				2023/2024

				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Poor				0				0				0				0

		Adequate				0				0				0		1		14

		Good 				0				0				0				0

		Very Good				0		1		25				0				0

		Excellent		7		50				0		3		38		4		57

		n/a		7		50		3		75		5		63		2		29

		Total		14		100		4		100		8		100		7		100

		April - June



Q20. Access to food and drink outside of set meal times  



Apr - Jun	Poor	Adequate	Good 	Very Good	Excellent	n/a	0	0	0	0	50	50	Jul - Sept	Poor	Adequate	Good 	Very Good	Excellent	n/a	0	0	0	25	0	75	Oct - Dec	Poor	Adequate	Good 	Very Good	Excellent	n/a	0	0	0	0	37.5	62.5	Jan - Mar	Poor	Adequate	Good 	Very Good	Excellent	n/a	0	14.285714285714286	0	0	57.142857142857146	28.571428571428573	

%











Question 21

		Q21. Were our facilities able to support you staying overnight if needed?

				2023/2024

				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Poor				0				0				0				0

		Adequate				0				0				0				0

		Good 				0				0				0				0

		Very Good				0				0				0				0

		Excellent		6		43				0				0		2		25

		n/a		8		57		4		100		8		100		6		75

		Total		14		100		4		100		8		100		8		100





		Do you have any further comments you would like to make?

		April - June

		No 1		No Comments

		No 2		No Comments

		No 3		No Comments

		No 4		No Comments

		No 5		No Comments

		No 6		Most of the times we could get something to eat at the coffee shop, but not all of the time.

		    No 7		No Comments

		No 8		No Comments

		No 9		No Comments

		No 10		No Comments

		No 11		Excellent Facilities

		No 12		I'm thankful for the support I've had from LWC

		No 13		No Comments

		July - August



		No 1		No Comments

		No 2		A fantastic hospice - we are so lucky in Durham to have this.

		No 3		No Comments

		No 4		I enjoy coming to Living Well Centre, he doesn't feel juged about the whellchair or his speech.















		Oct - Dec

		Number 1		The visits to St Cuthberts have been enjoyable to ****. As his carer I have been very grateful to know that he is in good hands.

		Number 2		No comment

		 Number 3 		No comment

		Number 4		No comment

		Number 5		No comment

		Number 6		No comment

		Number 7		It's Great

		Number 8		No comment

		Jan - Mar

		1		No Comment

		2		No Comment

		3		No Comment

		4		Health carers and Driver are very helpful and always chatty on the patient transport.

		5		Everything Good

		6		No Comment

		7		No Comment

		8		No Comment



Q21. Were our facilities able to support you staying overnight if needed? 



Apr - Jun	Poor	Adequate	Good 	Very Good	Excellent	n/a	0	0	0	0	42.857142857142861	57.142857142857146	Jul - Sept	Poor	Adequate	Good 	Very Good	Excellent	n/a	0	0	0	0	0	100	Oct - Dec	Poor	Adequate	Good 	Very Good	Excellent	n/a	0	0	0	0	0	100	Jan - Mar	Poor	Adequate	Good 	Very Good	Excellent	n/a	0	0	0	0	25	75	

%











Question 22

		Q22. Are you aware of what to do if you wanted to make a complaint?

				2022/2023

				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Yes		12		86		3		75		6		75		6		75

		No				0		1		25				0		1		13

		No answer		2		14				0		2		25		1		13

		Total		14		86		4		100		8		100		8		100



										 



Q22. Are you aware of what to do if you wanted to make a complaint? 



Apr - Jun	Yes	No	No answer	85.714285714285722	0	14.285714285714286	Jul - Sept	Yes	No	No answer	75	25	0	Oct - Dec	Yes	No	No answer	75	0	25	Jan - Mar	Yes	No	No answer	75	12.5	12.5	

%
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Question 1





		1. How would you rate the counsellors understanding of your situation and needs?



				2023/2024

				Apr - June				Jul - Sept				Oct - Dec				Jan - Mar

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Excellent		8		89		12		100		5		83		14		93

		Good		1		11				0		1		17		1		7

		Satisfactory				0				0				0				0

		Poor				0				0				0				0

		No answer				0				0				0				0

		Total		9		100		12		100		6		100		15		100



1. How would you rate the counsellors understanding of your situation and needs? 



Apr - Jun	Excellent	Good	88.888888888888886	11.111111111111111	Jul - Sept	Excellent	Good	100	0	Oct - Dec	Excellent	Good	83.333333333333343	16.666666666666668	Jan - Mar	Excellent	Good	93.333333333333343	6.666666666666667	

%











Question 2

		2. How beneficial did you find the counselling sessions?



				2023/2024

				Apr - June				Jul - Sept				Oct - Dec				Jan - Mar

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Always		7		78		12		100		4		67		14		93

		Often				0				0		2		33		1		7

		Sometimes		2		22				0				0				0

		Not at all				0				0				0				0

		No answer				0				0				0				0

		Total		9		100		12		100		6		100		15		100



		Comments:





Q2. How beneficial did you find the counselling sessions? 



Apr - Jun	Always	Often	Sometimes	Not at all	No answer	77.777777777777771	0	22.222222222222221	0	0	Jul - Sept	Always	Often	Sometimes	Not at all	No answer	100	0	0	0	0	Oct - Dec	Always	Often	Sometimes	Not at all	No answer	66.666666666666671	33.333333333333336	0	0	0	Jan - Mar	Always	Often	Sometimes	Not at all	No answer	93.333333333333343	6.666666666666667	0	0	0	

%











Question 3

		3. What was helpful about the sessions?



		2023/2024

		Comments:

		Q1

		1		Totally understanding, caring and really listened to me.

		2		During the session I found such peace, as I was in such turmoil and feared for my sanity.

		3		Didn't answer.

		4		When I first spoke to **** I wouldn't even say my Sisters name without breaking down.  **** been amazing

		5		Someone to talk to about things you wouldn't say to people you know. A friendly Face.

		6		Discussing the nature of my mental state and identifying why because of traumatic grief, the impact this had on my mental state.

		7		The councillors empathy and readiness to understand my peculiar situation

		8		Just some one to talk to.

		9		**** was able to help me put things into perspective and to understand how to live with grief.



		Q2

		1		Everything.

		2		Being able to talk through my problems without worrying about repercussions.

		3		Help me focus and release tension, ease guilt.

		4		An impartial person to listen and understand hones and trustworthy.  **** has patience and her kind words have helped me on my journey.

		5		Being able to talk about my present and my past.

		6		Yes I could talk about things that I couldn't with family as they were upset too.

		7		**** was always patient and understanding.  She never rushed me. Her help and advice was amazing.  The way she broke things down and explained everything step by step was a real help.  It helped my understanding.

		8		Learned coping Strategies, talking really help.

		9		Talking through things about my bereavement.

		10		They helped me organise my emotion and realise these feelings are justified and normal.  Having someone outside of the situation listen and understand has been vital.  The counsellor gave me coping strategies which I use everyday.

		11		With out exception I alsways left the session feeling more mositive than when I cam in.

		12		Helped me understand my emotions

		Q3

		1		Relaxing atmosphere and beautiful Location

		2		Up front and honest, give and take

		3		A Safe space to explore feelings, validation of what I was experiencing, helpful suggestions for coping

		4		To have some actually listen to me and understand what I have been going through.

		5		Mindfulness Sessions.  Teaching me to relax and how to use as distraction Technique.

		6		Excellent understanding of the reasons and route of my feelings and just beeining able to talk.

		Q4

		1		Consistent, proffesional, consice, empathetic, kind, understanding, supportive couselling.

		2		Being able to understand how I was feeling and understand how to cope better with emotions .

		3		My session helped me by working through the stages of grief and by talking about my thoughts and emotions.

		4		Advice to cope.

		5		Very thought provoking

		6		The sessions were very helpful as when I first came I didn't want to go on, but now I do.

		7		Being able to get things of my chest to some one not of my family.

		8		Helped me work through a lot of things.

		9		Speak to someone with knowledge of grief, speak to someone separately from the family.

		10		**** Heather is such a lovely person, patient and kind she knows what to say and when to listen she helped me understand my grief.

		11		Having someone to talk to who understands **** was easy to talk to and just amazing.

		12		The understanding of the counsellor and the helpful advice.

		13		Understanding how I was feeling.

		14		Opportunity to talk about feelings without worring about response.  Useful advice about bereavement process and how to cope.

		15		**** has been kind, caring and compassonate.  **** was quitly inqusitive when I would articulate what was happing to me.















Question 4

		4.  What was unhelpful about the sessions ?



		2023/2024

		Comments:

		Q1

		1		Nothing.

		2		Nothing was unhelpful.

		3		Extremely difficult to get appointment.

		4		Absolutely Nothing.

		5		Nothing.

		6		Nothing.

		7		Nothing.

		8		When I first asked for help I was told no and found this stressful

		9		Nothing was unhelpful.  Everything was well worked through.



		Q2

		1		Nothing what so ever

		2		No Comment

		3		Nothing 

		4		Always helpful.

		5		Nothing

		6		Nothing

		7		Nothing at all.  All sesions were excellent.  I feel like I made positive progress with every session.

		8		Nothing

		9		There was nothing that was unhelpful

		10		Nothing at all.  

		11		Nothing

		12		Nothing

		Q3

		1		Nothing

		2		Appointments and comumication could have been better - physical appointment card would be helpful

		3		Nothing

		4		Nothing

		5		Talking about my fathers death.  It just made me upset and didn't help with moving forward.  We then started doing minfulness session instead which were really helpful for me and my situation.

		6		They were extremaly helpful by just having someone to talk to who was empathettic who could help me to understand the cause and just to vent my anger and not be judged.  I feel in a different place now with some hope.

		Q4

		1		I can not think of anything that was unhelpful in anyway.

		2		Nothing

		3		There was nothing unhelpful about any of my sessions.

		4		Nothing

		5		Nothing

		6		Therewas nothing unhelpful.

		7		Nothing.

		8		Nothing

		9		Nothing Unhelpful.

		10		Nothing.

		11		Nothing was Unhelpful.  Everthing was helpful every session was useful.

		12		Nothing

		13		Just talking about my feeling and how to cope.

		14		No answer

		15		None











Question 5

		5.  Are there any other comments you would like to make ?

		2023/2024

		Comments:

		Q1

		1		The Counselling Sessions really were a lifeline for me, thank you so much.

		2		I would like to say that my counsellor **** was my light at the end of a long tunnel getting closer to me, giving me hope for the future.

		3		A Bit disorganised which was not helpful.

		4		This Service has literally healed my heart and given me my life back.  It's been invaluable thank you so much.

		5		**** was a lovely helpful Lady.

		6		From stat to finish I was met and treated with professional, courteous, sympathetic, consideration made to feel comfortable in discussing my problems.

		7		I would happily have continued but felt that I had reached the stage where I would be attending just to have the opportunity for conversation at a lonely time.

		8		**** was such a great help.

		9		Thank you so much **** for helping me over the last few months.  From being a complete wreck I am much more confident now.

		Q2

		1		I would just like to say what a wonderful helpful person **** is she is very special and helped me tremendously with my bereavement of my husband.

		2		**** was easy to talk to, she was understanding and caring, she made me feel wanted.

		3		Help me to relax and cope with situations.

		4		The session definitely helped me.  I previously had no experience of this type of grief.  I was never forgot the help I received at St Cuthberts.

		5		I think this a excellent service and suppot for people in my situation.

		6		Just I was very grateful for the support.

		7		**** is an asset to your team.  She is amazing at what she does and I will be forever grateful for all her help, advice and support she gave me.

		8		Highly recommend the sessions

		9		The Breavement officer was very helpful and nice could talk to her about anything.

		10		Just to say a huge THANK YOU!  I don't know how I would have coped without my sessions they really have helped and changed my outlook and allowed me to see a way to cope and carry on after a devastating loss.

		11		I could not understand why I had the feelings I had.  **** explains the different emotion and also the stage of grief.  This helps so much as I know I wasn't alone, lot's of people suffered similar emotions and learning to understandm understad my anger etc was very importat through the hour.  **** kidged my feelings/mood and showed amazing empathy and understanding.  I started to rely on the session carry on with  carry on which I was at my lowest.  I cannot thank you **** 

		12		It was good to talk to someone who understood what I was feeling

		Q3

		1		No Answer

		2		Very friendly and approachable easy to talk to.

		3		Other then its wonderful that it exists

		4		**** was a tremendous support to me.

		5		****  was lovely - Very patient and pleasant.

		6		This is an amazing place and I have been helped along just amazingly by my counsellor.



		Q4

		1		**** is an outstanding therapist, adaptable absluthly proffesional, creative in delivery, astute and very kind.  I do not think that I would have made so much progress without her skills

		2		No just every session was very helpful.

		3		I gained a better understanding to cope with my loss going forward.

		4		Nothing

		5		Nothing

		6		If anyone asks if I know any where I will be recommending you, and telling them why I have done that.

		7		The sessions help't me get throught a bad time in my life.

		8		No answer

		9		No, but thank you for the time you have taken to help me.

		10		**** counselling is holistc and takes into account everything in a persons life, not just the grief.  She has set me on the right path to get back on my feet.  I can't thank you enough ****

		11		Having these sessions has helped me immensley.  They have given me an understanding of what grief is and how better to understand myself. EXCELLENT.

		12		Nothing

		13		I can't thank **** for everything she has done for me, I Know I'm never going to get over the loss of **** and in some strange way I don't want to.  But I will just have to live with it and take one day at time.

		14		No answer

		15		**** was very helpful and tailored her approch to what I needed.









Question 6

		6. How did you hear about our service?

		2023/2024

		Comments:

		Q1

		1		No question on sheet.

		2		From my G.P meadowfield Surgery.

		3		Referred by Doctor.

		4		No question on sheet.

		5		No question on sheet.

		6		Through my GP Service.

		7		No question on sheet.

		8		Doctor

		9		I have been a volunteer at the hospice for over twenty years so I knew about the bereavement service.

		Q2

		1		Through my GP

		2		A list of services from my GP

		3		Through my GP

		4		A telephone call from St Cuthberts

		5		Working and supporting the hospice.

		6		Hospice

		7		GP Referall.  I was also given info about your service when I lost my mam in 2019.  I just didn't access the help and support offered back in 2019, I wasn't ready.

		8		No question on sheet.

		9		From doctors surgery.

		10		No question on sheet.

		11		Referred by GP

		12		Through my GP

		Q3

		1		No question on sheet.

		2		On website - Daughter

		3		Referral via another Hospice

		4		Unsure.

		5		After Care Service from St Cuthberts

		6		Through my GP

		Q4

		1		The carer's social woker suggested that verevement counselling may be best support for mu issues and they were 100% correct.  I am so grateful for the service that St Cuthbert's Hospice Berevement Councilling have given me.  It has made a huge difference to me this year and without the support you have provided and the fantstic skill of  **** I honestly do not know where I would be right now.  2023 was a nightmare which I survived, maily due to claire's support.  Words are not enough to express my gratitude.  Your work remains in my heart thoughts and prayers.

		2		No question on sheet.

		3		I was referred my my GP Surgery.

		4		Dr Surgery.

		5		Doctors/Social Perscriber

		6		The wife came here before she died and we were told that help would be available.

		7		Doctor 

		8		Refered by GP

		9		Through the hospice.

		10		GP Social perscriber .

		11		Doctors

		12		Doctors

		13		McMillan put my name down.

		14		From a different hospice where our daughter died (refferal made)

		15		Via St Cuthberts following the bereavement of a loved one.
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Dementia Services Friends and Family Test- 2023 2024.xlsx
Question 1





		1. Are you



				2023/2024

				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Male				0		7		78				0		4		33

		Female		5		100		2		22		6		100		8		67

		Total		5		100		9		100		6		100		12		100



1. Are you n=15 



Apr - Jun	Male	Female	0	100	Jul - Sept	Male	Female	77.777777777777771	22.222222222222221	Oct - Dec	Male	Female	0	100	Jan - Mar	Male	Female	33.333333333333336	66.666666666666671	

%











Question 2

		Q2. What age are you? 



				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		0-15				0				0				0				0

		16-24				0				0				0				0

		25-34				0				0		1		17				0

		35-44				0				0		1		17				0

		45-54		2		40				0				0				0

		55-64				0		2		22		1		17				0

		65-74		3		60		4		44		2		33		2		17

		75-84				0		2		22		1		17		8		67

		85+				0		1		11				0		2		17

		No answer								0

		Total		5		100		9		100		6		100		12		100



		Comments:





Q2. What age are you? n=15  



Apr - Jun	0-15	16-24	25-34	35-44	45-54	55-64	65-74	75-84	85+	0	0	0	0	40	0	60	0	0	Jul - Sept	0-15	16-24	25-34	35-44	45-54	55-64	65-74	75-84	85+	0	0	0	0	0	22.222222222222221	44.444444444444443	22.222222222222221	11.111111111111111	Oct - Dec	0-15	16-24	25-34	35-44	45-54	55-64	65-74	75-84	85+	0	0	16.666666666666668	16.666666666666668	0	16.666666666666668	33.333333333333336	16.666666666666668	0	Jan - Mar	0-15	16-24	25-34	35-44	45-54	55-64	65-74	75-84	85+	0	0	0	0	0	0	16.666666666666668	66.666666666666671	16.666666666666668	

%











Question 3

		Q3. Do you consider yourself to have a disability? 



				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Yes				0		4		44		2		33		4		33

		No		5		100		5		56		4		67		7		58

		No Answer				0				0				0		1		8

		Total		5		100		9		100		6		100		12		100

		Comments:



Q3. Do you consider yourself to have a disability?  n=15



Apr - Jun	Yes	No	No Answer	0	100	0	Jul - Sept	Yes	No	No Answer	44.444444444444443	55.555555555555557	0	Oct - Dec	Yes	No	No Answer	33.333333333333336	66.666666666666671	0	Jan - Mar	Yes	No	No Answer	33.333333333333336	58.333333333333336	8.3333333333333339	

%











Question 3b

		Q3b. Which of the following best describes your ethnic background? 

				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		British		5		100		9		100		5		83		12		100

		Irish				0				0				0				0

		Other - white background				0				0				0				0

		Caribbean				0				0				0				0

		African												0

		Other black background												0

		Indian										1		17

		Pakistani												ERROR:#DIV/0!

		Bangladeshi												ERROR:#DIV/0!

		Chinese												ERROR:#DIV/0!

		Other Asian background												ERROR:#DIV/0!

		White and Black Caribbean												ERROR:#DIV/0!

		White and Black African												ERROR:#DIV/0!

		White and Asian												ERROR:#DIV/0!

		Other Mixed Background												ERROR:#DIV/0!

		Anything else												ERROR:#DIV/0!

		I would rather not say												ERROR:#DIV/0!

		Total		5		100		9		100		6		100		12		100





Q3b. Which of the following best describes your ethnic background?  n=15



Apr - Jun	British	Irish	Other - white background	Caribbean	African	Other black background	Indian	Pakistani	Bangladeshi	Chinese	Other Asian background	White and Black Caribbean	White and Black African	White and Asian	Other Mixed Background	Anything else	I would rather not say	100	0	0	0	Jul - Sept	British	Irish	Other - white background	Caribbean	African	Other black background	Indian	Pakistani	Bangladeshi	Chinese	Other Asian background	White and Black Caribbean	White and Black African	White and Asian	Other Mixed Background	Anything else	I would rather not say	100	0	0	0	Oct - Dec	British	Irish	Other - white background	Caribbean	African	Other black background	Indian	Pakistani	Bangladeshi	Chinese	Other Asian background	White and Black Caribbean	White and Black African	White and Asian	Other Mixed Background	Anything else	I would rather not say	83.333333333333343	0	0	0	0	0	16.666666666666668	0	0	0	0	0	0	0	0	0	0	Jan - Mar	British	Irish	Other - white background	Caribbean	African	Other black background	Indian	Pakistani	Bangladeshi	Chinese	Other Asian background	White and Black Caribbean	White and Black African	White and Asian	Other Mixed Background	Anything else	I would rather not say	100	0	0	0	

%











Question 3c

		Q3c. Are you?

				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		The patient				0				0				0		3		25

		A relative 				0		4		44		6		100		1		8

		the patient and relative or carer		1		20				0				0				0

		No Answer		4		80		5		56				0		8		67

		Total		5		100		9		100		6		100		12		100



Q3c. Are you? n=15 



Apr - Jun	The patient	A relative 	the patient and relative or carer	No Answer	0	0	20	80	Jul - Sept	The patient	A relative 	the patient and relative or carer	No Answer	0	44.444444444444443	0	55.555555555555557	Oct - Dec	The patient	A relative 	the patient and relative or carer	No Answer	0	100	0	0	Jan - Mar	The patient	A relative 	the patient and relative or carer	No Answer	25	8.3333333333333339	0	66.666666666666671	

%











Question 3d

		4. Please indicate which hospice service was accessed? 





				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Admiral Nurse		5		100		3		33		6		67		9		53

		LWC				0				0				0				0

		Carer Support Group				0				0				0				0

		Namaste Care Service				0		6		67		3		33		8		47

		No answer				0				0				0				0

		Total		5		100		9		100		9		100		17		100

		Comments:



4. Please indicate which hospice service was accessed?  



Apr - Jun	Admiral Nurse	LWC	Carer Support Group	Namaste Care Service	No answer	100	0	0	0	0	Jul - Sept	Admiral Nurse	LWC	Carer Support Group	Namaste Care Service	No answer	33.333333333333329	0	0	66.666666666666657	0	Oct - Dec	Admiral Nurse	LWC	Carer Support Group	Namaste Care Service	No answer	66.666666666666657	0	0	33.333333333333329	0	Jan - Mar	Admiral Nurse	LWC	Carer Support Group	Namaste Care Service	No answer	52.941176470588239	0	0	47.058823529411768	0	

%











Question 4

		Q4 We would like you to think about your recent experience of our service.  How likely are you to recommend the care received at St Cuthbert's Hospice to friends and family if they needed similar care or treatment?  

				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Extremely likely		5		100		8		89		5		83		11		92

		Likely				0		1		11		1		17		1		8

		Neither likely or unlikely				0				0				0				0

		Unlikely				0				0				0				0

		Extremely Unlikely																0

		Don't Know																0

		No answer																0

		Total		5		100		9		100		6		100		12		100









		Thinking about your response to this question, what is the main reason why you feel this way?

		AN1: I'm so grateful for the time and care you gave to our conversation yesterday when I rang to ask for advice about a close relative with dementia.  Your kindness and professional expertise were invaluable.  Access to an admiral nurse is a lifeline for families like mine and your presence at St Cuthbert's makes the world of difference.  Thank you.

		AN2: ***** made me feel so comfortable to talk and open up which I can find really hard to do.

		AN3:  It was very helpful to speak to someone who understands dementia.  I found ***** very knowledgeable on the subject and able to provide good ideas on how to manage difficult situations.  I feel more confident moving on.

		AN4:  Always a friendly, safe environment with lots of stimulation to encourage relaxed participation of games, discussion and activities.

		AN5: No comments

		NC6: Quality service, delivered in a friendly and helpful way.

		NC7: This is a very caring service, which anyone in need could benefit from.

		AN8:Very informative, supporting in all aspects of dementia care.  A caring, empathic environment for client and carer.  A lifeline in times of crisis/need.

		NC9:  The visit of the hospcie volunteer gives me an hour ot myself.

		NC10: Friendly, efficient, caring staff

		NC11: I am not aware of any other sessions like this local to my area and I am sure it will grow as years go by.

		NC12: Admiral is so understanding.  Namaste activities may be too much for my wife but I know she enjoys the company/hand massage/biscuits/venue

		NC13: All staff members at t Cuthbert's are professional and are always ready to lend a sympathetic ear.  Are kind, helpful and show how they understand how a carer feels emotionally when caring for their loved one, as well as the care and support they have shown towards ****.  The service is first class and I would have no hesitation recommending them to anyone needing their support.

		NC14:  All the ladies at St Cuthbert's are all such lovely, caring, friendly people.  They are all lovely with my wife and my wife loves all of them.  We've only known a few months, but hope they won't mind if we look on them all as new friends rather than staff.

		NC15: When I brought mam for our initial assessment it was a comfort to receive such kindness and acknowledgement of the difficiulties we faced.  Our volunteer has 'lifted our spirits'.

		AN16: All staff at St Cuthberts are professional and are always ready to listen. They are kind and understanding of how a carer feels emotionally when caring for their loved one. The service is first class and I would have no hesitation recommending them to anyone in need of support

		AN17: 'As a carer I had no support before I made contact with St Cuthbert's Hospice. The Dementia Support Group is like a lifeline to me and the other carers who attend. I am so grateful to be able to have contact with an Admiral Nurse too. The support I have received over recent months has been invaluable'

		AN18:  '***** was fantastic to talk to. Allowed me time to talk about my experience and offered really helpful advice particularly about the importance of looking after myself as a carer'

		AN19: '***** is so good supporting my Husband in the group. He has frontotemporal dementia and can be quite difficult to involve but she manages well. I always feel that staff in the group truly care about us both which is so important'

		AN20: '***** was very gentle in how she spoke to my Mother who is struggling with caring for my Father which I really appreciated.

		NM21: Warm, friendly, supportive, amazing group of girls.

		NM22: No other services available.

		NM23: Initial visit was lovely.  *** was reluctant about the service at first, but really took to **** and **** subsequent visits have been successful and he now looks forward to a Friday

		AN24: I received support from the Admiral Nurse, that no other party had offered without that support I wouldn't be here.  I cannot praise her highly enough.

		NM25: **** comes out feeling very happy and says he has enjoyed himself.

		NM26: The staff are very caring and responsive to my wife.

		NM27: Because the staff and helpers are excellent and would have no hesitation in recommending them to friends and family.  Everybody that I have met in the hospice are very friendly and my husband agrees the help and service are second to none!

		AN28: My need for help was recognised and taken on board by the Admiral Nurse.  Her knowledge, expertise and lovely caring manner - friendship - has got me through a really difficult time.

		AN29: The admiral nurse is excellent and gave me confidence and support in how to further aid my lovely husband.  I feel lucky and privilaged to have found her.

		AN30:  I received support from the Admiral Nurse that no other party has offered.  Without that support I wouldn't be here.  I couldn't praise her highly enough.

		NM31: Somewhere I feel safe and happy.

		NM32: Vary caring and supportive



Q4 We would like you to think about your recent experience of our service.  How likely are you to recommend the care received at St Cuthbert's Hospice to friends and family if they needed similar care or treatment?  n=15



Apr - Jun	Extremely likely	Likely	Neither likely or unlikely	Unlikely	Extremely Unlikely	Don't Know	100	0	0	0	Jul - Sept	Extremely likely	Likely	Neither likely or unlikely	Unlikely	Extremely Unlikely	Don't Know	88.888888888888886	11.111111111111111	0	0	Oct - Dec	Extremely likely	Likely	Neither likely or unlikely	Unlikely	Extremely Unlikely	Don't Know	83.333333333333343	16.666666666666668	0	0	Jan - Mar	Extremely likely	Likely	Neither likely or unlikely	Unlikely	Extremely Unlikely	Don't Know	91.666666666666671	8.3333333333333339	0	0	0	0	Extremely likely	Likely	Neither likely or unlikely	Unlikely	Extremely Unlikely	Don't Know	0	

%











Question 5

		Q1. Does the person you are caring for live with you?



				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Yes		3		60		8		89		3		50		8		67

		No		2		40		1		11		3		50		3		25

		No Answer				0				0				0		1		8

		Total		5		100		9		100		6		100		12		100









Q1. Does the person you are caring for live with you? n=15



Apr - Jun	Yes	No	No Answer	60	40	0	Jul - Sept	Yes	No	No Answer	88.888888888888886	11.111111111111111	0	Oct - Dec	Yes	No	No Answer	50	50	0	Jan - Mar	Yes	No	No Answer	66.666666666666671	25	8.3333333333333339	

%











Question 6

		Q2: How long have you been a carer? Please indicate



				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		1		1		20		2		22		1		17		1		9

		2				0				0		3		50		4		36

		3		2		40				0		1		17				0

		4				0		1		11				0		2		18

		5				0				0				0		1		9

		6		2		40		1		11				0				0

		7				0		1		11				0				0

		8				0				0				0		1		9

		9				0		1		11				0				0

		10				0				0		1		17		1		9

		11				0				0				0				0

		12				0				0				0				0

		13				0				0				0				0

		14				0				0				0				0

		15				0		1		11				0		1		9

		16				0				0				0				0

		17				0				0				0				0

		Several Yrs				0		2		22				0				0

		Total		5		100		9		100		6		100		11		100





Q2: How long have you been a carer? Please indicate n=15



Apr - Jun	1	2	3	4	5	6	7	8	9	10	11	12	13	14	15	16	17	Several Yrs	20	0	40	0	0	40	0	0	0	0	0	0	0	0	0	0	0	0	Jul - Sept	1	2	3	4	5	6	7	8	9	10	11	12	13	14	15	16	17	Several Yrs	22.222222222222221	0	0	11.111111111111111	0	11.111111111111111	11.111111111111111	0	11.111111111111111	0	0	0	0	0	11.111111111111111	0	0	22.222222222222221	Oct - Dec	1	2	3	4	5	6	7	8	9	10	11	12	13	14	15	16	17	Several Yrs	16.666666666666668	50	16.666666666666668	0	0	0	0	0	0	16.666666666666668	0	0	0	0	0	0	0	0	Jan - Mar	1	2	3	4	5	6	7	8	9	10	11	12	13	14	15	16	17	Several Yrs	9.0909090909090917	36.363636363636367	0	18.181818181818183	9.0909090909090917	0	0	9.0909090909090917	0	9.0909090909090917	0	0	0	0	9.0909090909090917	0	0	0	

%











Question 7a

		Q3. What is your relationship to the person you care for?



				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Mother		2		40				0				0				0

		Father				0				0				0				0

		Daughter				0				0		3		50				0

		Son				0				0				0				0

		Niece				0				0				0				0

		Nephew				0				0				0				0

		Stepmother				0				0				0				0

		Spouse		1		20		8		89		3		50		10		83

		Sister		1		20				0				0				0

		No answer		1		20		1		11				0		2		17

		Total		5		100		9		100		6		100		12		100









Q3. What is your relationship to the person you care for? n=15



Apr - Jun	Mother	Father	Daughter	Son	Niece	Nephew	Stepmother	Spouse	Sister	40	0	0	0	0	0	0	20	20	Jul - Sept	Mother	Father	Daughter	Son	Niece	Nephew	Stepmother	Spouse	Sister	0	0	0	0	0	0	0	88.888888888888886	0	Oct - Dec	Mother	Father	Daughter	Son	Niece	Nephew	Stepmother	Spouse	Sister	0	0	50	0	0	0	0	50	0	Jan - Mar	Mother	Father	Daughter	Son	Niece	Nephew	Stepmother	Spouse	Sister	0	0	0	0	0	0	0	83.333333333333343	0	

%











Question 8

		Q4. How long have you been in contact with an Admiral Nurse/Namaste Care Service?

				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		0 - 3 months		3		60		1		11		2		33		2		17

		3 - 6 months		1		20		1		11		1		17		1		8

		6 - 9 months				0				0		2		33		2		17

		9 - 12 months				0		1		11				0				0

		12 - 15 months				0				0				0				0

		15 - 18 months				0				0				0		2		17

		18 - 21 months				0		1		11				0				0

		21 - 24 months				0		3		33				0		2		17

		No answer		1		20		2		22		1		17		3		25

		Total		5		100		9		100		6		100		12		100





Q4. How long have you been in contact with an Admiral Nurse/Namaste Care Service? n=15





Apr - Jun	0 - 3 months	3 - 6 months	6 - 9 months	9 - 12 months	12 - 15 months	15 - 18 months	18 - 21 months	21 - 24 months	No answer	60	20	0	0	0	0	0	0	20	Jul - Sept	0 - 3 months	3 - 6 months	6 - 9 months	9 - 12 months	12 - 15 months	15 - 18 months	18 - 21 months	21 - 24 months	No answer	11.111111111111111	11.111111111111111	0	11.111111111111111	0	0	11.111111111111111	33.333333333333329	22.222222222222221	Oct - Dec	0 - 3 months	3 - 6 months	6 - 9 months	9 - 12 months	12 - 15 months	15 - 18 months	18 - 21 months	21 - 24 months	No answer	33.333333333333336	16.666666666666668	33.333333333333336	0	0	0	0	0	16.666666666666668	Jan - Mar	0 - 3 months	3 - 6 months	6 - 9 months	9 - 12 months	12 - 15 months	15 - 18 months	18 - 21 months	21 - 24 months	No answer	16.666666666666668	8.3333333333333339	16.666666666666668	0	0	16.666666666666668	0	16.666666666666668	25	

%











Question 9

		Q5. What type of contact did you have with the Admiral Nurse / Namaste Care Service?  

				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Face to Face				0		2		25				0		8		67

		Telephone		1		20				0		1		17				0

		Both		4		80		6		75		5		83		4		33

		No Answer																0

		Total		5		100		8		100		6		100		12		100









Q5. What type of contact did you have with the Admiral Nurse/Namaste Care Service?   n=15





Apr - Jun	Face to Face	Telephone	Both	No Answer	0	20	80	Jul - Sept	Face to Face	Telephone	Both	No Answer	25	0	75	Oct - Dec	Face to Face	Telephone	Both	No Answer	0	16.666666666666668	83.333333333333343	Jan - Mar	Face to Face	Telephone	Both	No Answer	66.666666666666671	0	33.333333333333336	0	

%











Question 10

		Q6. How helpful was the Admiral Nurse /Namaste Care Volunteer in recognising and supporting your physical, social and emotional needs as a carer?



				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Very Helpful		5		100		8		89		5		83		11		92

		Quite Helpful				0				0		1		17				0

		A little helpful				0				0				0				0

		No help				0				0				0				0

		Not sure								0						1		8

		No answer						1		11								0

		Total		5		100		9		100		6		100		12		100

		Comments:





Q6. How helpful was the Admiral Nurse /Namaste Care Volunteer in recognising and supporting your physical, social and emotional needs as a carer? n=15



Apr - Jun	Very Helpful	Quite Helpful	A little helpful	No help	Not sure	No answer	100	0	0	0	Jul - Sept	Very Helpful	Quite Helpful	A little helpful	No help	Not sure	No answer	88.888888888888886	0	0	0	0	11.111111111111111	Oct - Dec	Very Helpful	Quite Helpful	A little helpful	No help	Not sure	No answer	83.333333333333343	16.666666666666668	0	0	Jan - Mar	Very Helpful	Quite Helpful	A little helpful	No help	Not sure	No answer	91.666666666666671	0	0	0	8.3333333333333339	0	Very Helpful	Quite Helpful	A little helpful	No help	Not sure	No answer	0	Very Helpful	Quite Helpful	A little helpful	No help	Not sure	No answer	0	

%











Question 11

		Q7. How helpful was the admiral nurse/namaste care volunteer in recognising and supporting the needs of the person you are caring for?

				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Very Helpful		5		100		8		100		5		83		10		83

		Quite Helpful				0				0		1		17		1		8

		A little helpful				0				0				0				0

		No help				0				0				0				0

		Not sure																0

		No answer						1								1		8

		Total		5		100		8		100		6		100		12		100

		Comments:



Q7. How helpful was the admiral nurse/namaste care volunteer in recognising and supporting the needs of the person you are caring for? n=15



Apr - Jun	Very Helpful	Quite Helpful	A little helpful	No help	Not sure	No answer	100	0	0	0	Jul - Sept	Very Helpful	Quite Helpful	A little helpful	No help	Not sure	No answer	100	0	0	0	Oct - Dec	Very Helpful	Quite Helpful	A little helpful	No help	Not sure	No answer	83.333333333333343	16.666666666666668	0	0	Jan - Mar	Very Helpful	Quite Helpful	A little helpful	No help	Not sure	No answer	83.333333333333343	8.3333333333333339	0	0	0	8.3333333333333339	

%











Question 12

		Q8. How helpful was the admiral nurse/namaste care volunteer in improving your understanding of dementia and the impact on you as a carer?

				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Very Helpful		5		100		7		78		5		83		10		83

		Quite Helpful				0		1		11				0				0

		A little helpful				0				0		1		17				0

		No help				0				0				0				0

		Not sure								0						1		8

		No answer						1		11						1		8

		Total		5		100		9		89		6		100		12		100



Q8. How helpful was the admiral nurse/namaste care volunteer in improving your understanding of dementia and the impact on you as a carer? n=15



Apr - Jun	Very Helpful	Quite Helpful	A little helpful	No help	Not sure	No answer	100	0	0	0	Jul - Sept	Very Helpful	Quite Helpful	A little helpful	No help	Not sure	No answer	77.777777777777771	11.111111111111111	0	0	0	11.111111111111111	Oct - Dec	Very Helpful	Quite Helpful	A little helpful	No help	Not sure	No answer	83.333333333333343	0	16.666666666666668	0	Jan - Mar	Very Helpful	Quite Helpful	A little helpful	No help	Not sure	No answer	83.333333333333343	0	0	0	8.3333333333333339	8.3333333333333339	

%











Question 13

		Q9.  How helpful was the admiral nurse/namaste care volunter in offering advice, guidance and support with caring for someone with dementia?

				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Very Helpful		5		100		6		67		4		67		10		83

		Quite Helpful				0		2		22		2		33				0

		A little helpful				0				0				0				0

		No help				0				0				0				0

		Not sure								0						1		8

		No answer						1		11						1		8

		Total		5		100		9		100		6		100		12		100



Q9.  How helpful was the admiral nurse/namaste care volunter in offering advice, guidance and support with caring for someone with dementia? n=15



Apr - Jun	Very Helpful	Quite Helpful	A little helpful	No help	Not sure	No answer	100	0	0	0	Jul - Sept	Very Helpful	Quite Helpful	A little helpful	No help	Not sure	No answer	66.666666666666657	22.222222222222221	0	0	0	11.111111111111111	Oct - Dec	Very Helpful	Quite Helpful	A little helpful	No help	Not sure	No answer	66.666666666666671	33.333333333333336	0	0	Jan - Mar	Very Helpful	Quite Helpful	A little helpful	No help	Not sure	No answer	83.333333333333343	0	0	0	8.3333333333333339	8.3333333333333339	

%











Question 14a

		Q10. How helpful was the admiral nurse/namaste care volunteer in working with other professionals to provide coordinated care?



				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Very Helpful		5		100		5		56		3		60		10		83

		Quite Helpful				0		1		11		1		20				0

		A little helpful				0				0		1		20				0

		No help				0				0				0				0

		Not sure				0				0						1		8

		No answer				0		3		33		1				1		8

		Total		5		100		9		100		5		100		12		100







Q10. How helpful was the admiral nurse/namaste care volunteer in working with other professionals to provide coordinated care? n=15



Apr - Jun	Very Helpful	Quite Helpful	A little helpful	No help	Not sure	No answer	100	0	0	0	0	0	Jul - Sept	Very Helpful	Quite Helpful	A little helpful	No help	Not sure	No answer	55.555555555555557	11.111111111111111	0	0	0	33.333333333333329	Oct - Dec	Very Helpful	Quite Helpful	A little helpful	No help	Not sure	No answer	60	20	20	0	Jan - Mar	Very Helpful	Quite Helpful	A little helpful	No help	Not sure	No answer	83.333333333333343	0	0	0	8.3333333333333339	8.3333333333333339	

%











Question 14b

		Q11.How effective was the admiral nurse/namaste care volunteer in building trust and establishing a good rapport with you and the person you care for?



				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Very effective		5		100		7		78		5		83		11		92

		Quite effective				0		1		11		1		17				0

		A little effective				0				0				0				0

		Not effective				0				0				0				0

		Not sure								0								0

		No answer						1		100						1		8

		Total		5		100		9		189		6		100		12		100





Q11.How effective was the admiral nurse/namaste care volunteer in building trust and establishing a good rapport with you and the person you care for? n=15



Apr - Jun	Very effective	Quite effective	A little effective	Not effective	Not sure	No answer	100	0	0	0	Jul - Sept	Very effective	Quite effective	A little effective	Not effective	Not sure	No answer	77.777777777777771	11.111111111111111	0	0	0	100	Oct - Dec	Very effective	Quite effective	A little effective	Not effective	Not sure	No answer	83.333333333333343	16.666666666666668	0	0	Jan - Mar	Very effective	Quite effective	A little effective	Not effective	Not sure	No answer	91.666666666666671	0	0	0	0	8.3333333333333339	

%











Question 14c

		Q12.  How effective was the admiral nurse/namaste care volunteer in showing compassion, respect and understanding to you and the person you care for?



				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Very effective		5		100		8		89		5		83		10		83

		Quite effective				0				0		1		17				0

		A little effective				0				0				0				0

		Not effective				0				0				0				0

		Not sure								0								0

		No answer						1		100						2		17

		Total		5		100		9		189		6		100		12		100



Q12.  How effective was the admiral nurse/namaste care volunteer in showing compassion, respect and understanding to you and the person you care for? n=15



Apr - Jun	Very effective	Quite effective	A little effective	Not effective	Not sure	No answer	100	0	0	0	Jul - Sept	Very effective	Quite effective	A little effective	Not effective	Not sure	No answer	88.888888888888886	0	0	0	0	100	Oct - Dec	Very effective	Quite effective	A little effective	Not effective	Not sure	No answer	83.333333333333343	16.666666666666668	0	0	Jan - Mar	Very effective	Quite effective	A little effective	Not effective	Not sure	No answer	83.333333333333343	0	0	0	0	16.666666666666668	

%











Question 14d

		Q13. Please list up to 3 differences the admiral nurse/Namaste care service has made to you as a carer:



				April - June 						July - Sept 						Oct - Dec						Jan- March

				1		2		3		1		2		3		1		2		3		1		2		3

		AN1		Listening and giving time		Information on medication for agitation		Information/advice on liaising with care home staff

		AN2		Talking made me realise my feelings are 'normal' - I'm not going mad!		Telling me that my needs are important too		Knowing I can ring ***** anytime is so helpful

		AN3		I feel better informed about what to expect in the future		I feel more confident		It helps to know support is there if I need it again in the future.

		AN4		Listening to problems and supporting		Assisting with accessing services		Involving other means of solving problems

		AN5		Got my husband a GP appointment when I couldn't		Told me about peoples vision going when they have dementia which helped.

		NC6: 								Provided the opportunity for a break from caring role.		Somebody to talk to about caring issues/general conversation		Provided stimulation to patient (play games/massage/craft work/conversation etc)

		NC7:								I get more rest		I feel more able to cope		I feel more informed

		AN8:								Readily available for advice and support		Offers solutions to immediate needs		Helps me to initiate links with primary care team linked to psychiatrist

		NC9:								An hour to do something different for me.		The hospice volunteer gives a different hour of conversation for ****

		NC10:								No answer

		NC11:								Stimulates the wife she looks forward to Friday sessions.		Give me peace of mind and a break.		Knowing support is at hand if required.

		NC12:								Admiral Nurse has provided reassurance to e when I was struggling caring for my wife.		Nurse supported me as my wife went into a care home.

		NC13:								Understanding		Friendliness		Lending an ear

		NC14:								We can go somewhere together that is a safe place for Dementia sufferers i.e. everyone there either has Dementia or knows aout Dementia so my wife's behaviour is understood and accepted.		I can share experiences with other carrs and the staff about caring for someone with Dementia.		Namaste is a happy place.  My wife is happy there which in turn makes me happy.

		NC15:														Acknowledging difficulties/validations.		Listening/caring		Non judgemental

		AN16:														Understanding		Friendliness		Lending an ear

		AN17:														I feel understood and not judged at all 		It is very helpful having someone to talk to who understands dementia		Having the opportunity to talk to other carers in similar positions

		AN18:														Giving me time to talk, I didn't feel rushed at all 		Advice on my own mental health 		Written information on Young Onset Dementia 

		AN19:														Having the opportunity to talk one- one with ***** about difficulties I face as a carer 		The group providing carers with a bit of a social life		Feeling less alone 

		An20:														Provided information to help us as a family to understand my Father's dementia and how we can best help him 		It was helpful to have written information sent out also particularly information on how best to communicate with someone with dementia		Having the knowledge that we can contact again if we require any more support in the future

		NM22																				Both incredibly supportive and wonderful in every way.

		NM23																				Its so nice to have someone visit who has expereinced being a carer and understands the difficulties encountered by my husband and me as a carer.		**** visits lift his spirits and gives him something to look forward to.

		AN24																				Support when I counldn't see my way forward.		Knowledge and information regarding my wife's dementia.		More understanding of dementia

		NM25																				Support when I counldn't see my way forward.		Both enjoy the group		Friendship/fun

		NM26																				They make everyday count.		Provide a high quality service for my wife.		They provide a very caring support/

		NM27																				Relaxation		Comfort		Stimulating

		AN28:																				Given me a better understanding of my thoughts and feelings.		Improved my understanding of my husbands specific dementia and symptoms.		Was able to explain what and how my husband was expereincing the massive changes happening to his brain.  How different things were for him.

		AN29:																				Her reassurance lifted my spirits.		Has shared an acronym which I frequently now use to aid my husbands moods or triggers PINCH ME.		Her vast expereince of this crul illness made me sit up and listen.  She is an asset to anyone caring for a dementia sufferer.  Thank you.  I've shared your suggestions with care home staff, family and friends.

		AN30:																				Support when I couldn't see my way forward.		Knowledge and information regarding my wife's dementia.		More understanding of dementia

		NM31:																				Listening and support		Explaining and helping with dementia		Friendly and caring





Question 15

		Q14. How could the service be improved?



				April - June 				July - Sept 				Oct - Dec				Jan- March

		AN1		Increase number of admiral nurses

		AN2		No comment

		AN3		No comment

		AN4		No comment

		AN5		More admiral nurses

		NC6:						More sessions like we currently have.		Longer carer breaks (e.g respite breaks for both patient and carer)

		NC7:						By more advertisement of the services

		AN8:						The opportunity when the team is increased in numbers perhaps consider offerring day/respite care because I feel totally safe leaving my husband with the team.

		NC9:						No comment

		NC10:						It's difficult to answer questions because the Namaste volunteer has had prolonged illness.  On occasions when she was able to visit she was helpful, friendly and provdied gentle stimulation through conversation

		NC11:						Make the sessions longer than 3 hours.

		NC12:						Nothing I can think off.  Maybe some leaflets for Alzhimers Society etc.

		NC13:						No comment.

		NC14:						My wife loves singing so more singing would be good.

		NC15:										Its difficult to comment as I haven't been invovled with the service as much as I would have liked, as mam refused to join the weekly group.  It would be easier for me sometimes if I didn't always have to be there when our volunteer comes to see mam.  I think it does help mam to see others on her own to build her trust and confidence.

		AN24														Lots more wonderful people like ****!

		NM26														More money from the Government.

		AN28:														By more available funding from the government to enable more of these wonderful, knowledgable people to be available in every NHS region.





Question 16

		Q15. Are you aware of what to do if you wanted to make a complaint?

				April - June 				July - Sept 				Oct - Dec				Jan- March

				Number		Percentage		Number		Percentage		Number		Percentage		Number		Percentage

		Yes		3		60		7		78		6		100		6		50

		No				0		1		11				0		3		25

		No answer		2		40		1		11				0		3		25

		Total		5		100		9		100		6		100		12		100



		Comments:















Q15. Are you aware of what to do if you wanted to make a complaint? n=15



April - June	Yes	No	No answer	60	0	40	July - Sept	Yes	No	No answer	77.777777777777771	11.111111111111111	11.111111111111111	Oct - Dec	Yes	No	No answer	100	0	0	Jan - Mar	Yes	No	No answer	50	25	25	

%
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) Case Study - Holistic Support Example
2, Living Well Centre (LWC) input to
safeguard an outpatient at the end of life

Background

+ Outpatient was a 50+ year old male, who lived in the county.
+ Lived alone, Imited family contact

« Former plasterer
« Alcohol use issues.

« Cancer diagnoss.
+ Regular non-attendance to GP

Events

Referred to LWC for ascitic drainage on a weekly basis.
Received holistic support at LWC, seen by RNs and Family Support Worker
One to one support/ Listening Ear Service

Weskly attendance at LWC

LWC transport service user - Volunteer Driver support

Non-attendance investigated by Famiy Support Worker.

Weekly team mestings.

Shopping delivery and mobile phone organised by Family Support Worker.
Home visit - Occupational Therapist input

Deterioration and non engagement noted

LWC volunteer driver collected medications when outpatient unwel.

Referred to Safeguarding  allocated to Drug & Alcohol Team

LWC check in at last non-attendance, contacted Durham Police for welfare
check

‘Outpatient unwell and transferred to University Hospital North Durham.

Died at University Hospital North Durham.

Key Learnings

+ The importance of a whole team approach across health and social care
professionals within Living Well Centre, involving nursing and family support

staf.
+ Dally team handovers are essential - due to the regular and in-depth
communication between Hospice staff members the outcomes for the
Q outpatient were improved
 Liaison with Community Services.
LI L L oncurea that ot ena o e, the cutatent receved e ncreased care
and support they required.
- The outpatient attended the Hospice for 1 n a medical procedure
Social and health needs were met though the Hospice . om
Q search L =ed 10472026

David McLoughiin, Day Services Manager. St Cuthbert's Hospice. April 2024
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